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Introduction

Mobile Analytics Kit (MAKit) allows users to graphically view data in different types of charts. The MAKit
Tutorial: iOS Metadata-Driven Development is to help developers quickly understand MAKit concepts,
and expedite application development. MAKit, which lets users graphically view data and modify chart
values to examine “what-if” scenarios, is distributed as a static library on the iPhone/iPad. MAKit can be
used with the Sybase® Unwired Platform Hybrid Web Container.

Prerequisites

Before beginning the tutorials:

e  Verify that you are running Intel-based Mac 10.6 or higher.
e Install Xcode 4.0 with iOS 4.3 SDK.

e  Copy the latest iOS Mobile Analytics Kit (MAKit) build (library and header files) to a local Mac
machine.

e On alocal Mac machine, copy the iOS MAKit build to /Users/<username>/MAKi t, where
<username> is the user currently logged in.

e Download and unzip MAKitTutorialDatabase.zip to a local folder on the Mac. This file contains
the SQLite® database MAKitTutorials.sqlite, which is used in the tutorial.

e (Create a /Users/<username>/MAKitTutorial folder.

Note: All the path information in the tutorial is based on /Users/<username>/MAKitTutorial. If you
create the sample on a different folder, adjust the path according to your local settings.

Lesson 1: Setting Up the i0S Development Environment for MAKit

This lesson describes:

e Creating a new project in Xcode 4.0 IDE
e Adding files to the Xcode project

e Adding MAKit libraries and header files
e Changing the project build settings

Note: This tutorial is developed using Xcode 4.0 and iOS SDK 4.3. If you use a different version of Xcode,
some steps may vary. For more information on Xcode, see the Apple Developer Connection at
http://developer.apple.com/technologies/tools/xcode.html.

1. Start Xcode and select File > New > New Project.
2. Select iOS Application and Window-based Application as the project template, then click Next.

3. Enter MAKitSample as the product name, and iPad as the device family. Select Use Core Data,
unselect Include Unit Tests, then click Next.

4. Save the project in /Users/<username>/MAKitTutorial, then click Create to open it.
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Xcode creates a folder called MAKitSample, which contains a project file called
MAKitSample.xcodeproj and a subfolder called MAKitSample, which contains all the
Xcode-generated files in the /Users/<username>/MAKitTutorial folder.

After finishing this step, the project looks similar to this in Xcode:

dOO
@ (M) | MAKitSample | iPad 4.3 Simu... ;| [ m® |
L.
Run Stop Scheme Breakpoints
T @ A = = B |::::|4 » | | MAKitsample
I — PROJECT
Ll TRy o yL _“ . -
MAKitsampl
| MAKitSample ) MATISAmpTe L]
|h| MAKitSampleAppDelegate.h TARGETS
im| MAKitSampleAppDelegate.m A
4 MainWindow.xib
|| MAKitsample.xcdatamodeld
| 5upporting Files
| Frameworks C

| Products

In the Xcode Project Navigator, right-click MAKitSample and select Add Files to “MAKitSample”.

Navigate to the folder containing the SQLite database, select MAKitTutorials.sqlite, select Copy
items into destination group's folder (if needed), and click Add.

This adds the MAKitTutorials.sqglite database to the project in the Project Navigator.
Right-click the Frameworks folder of the MAKitSample project and select Add Files to
“MAKitSample”. Navigate to /Users/<username>/MAKit/l ibs/Debug-iphonesimulator

folder, select the 1ibMAKit.a library, unselect Copy items into destination group's folder (if
needed), and click Add.

This adds 1ibMAKit.a to the Frameworks folder of the project in the Project Navigator.

Right-click the project root, select New Group, and rename it Resources.

Right-click the Resources folder and select Add Files to “MAKitSample”. Navigate to
/Users/<username>/MAKi t, select the MAKit.bundl e file, select Copy items into destination
group's folder (if needed) and click Add.

This adds the MAKit_bundle file to the Resources folder in the Project Navigator.
Click the project root and in the middle pane, click the MAKitSample target.

a. Inthe right pane, click the Build Settings tab, then scroll down to the Search Paths section.
b. Double-click Library Search Paths.
This populates the Library Search Paths with $SRCRoot/. ./ . ./MAKit/libs/Debug-

iphonesimulator for the libMAKit.a library.
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Search Paths
Always Search User Paths
Framework Search Paths

No

Header Search Paths

Library Search Paths

Rez Search Paths

Sub-Directories to Exclude in Recursiv...
Sub-Directories to Include in Recursive. ..
User Header Search Paths

Unit Testing

Other Test Flags

Test After Build

Test Host

Test Rig

Versioning

No

"fUsers faabdul /MAKIitTut...

*.nib *.|proj *.framework *.g|

No 3

"fUsers faabdul /MAKitTutorial /MAKitSample/../../ MAKit/li...

| Recursive | Path

O S(inherited)

ol

Dane

"S(SRCROOT)/../../MAKit/libs /Debug-iphonesimulator”

c. Replace the text Debug-iphonesimulator with $(BUILD_STYLE)-$(PLATFORM_NAME)

macros and click Done.

Path
L(inherited)

Recursive

off o

"R(SRCROOT)/.. /.. /MAKIE/ libs/ S(BUILD_STYLE)-5(PLATFORM_MNAME)"

Daone

d. Double-click the Header Search Paths property entry, click the + icon, enter the location of
the MAKit header files, such as $(SRCRO0T)/. ./ . ./MAKit/includes, and click Done.

Search Paths
Always Search User Paths No
Framework Search Paths
Header Search Paths
Library Search Paths
Debug
Release
Rez Search Paths

<Multiple values>

"/Users faabdul /MAKitTut
"/Users faabdul /MAKitTut,
Sub-Directories to Exclude in Recursiv... *.nib *.lproj *.framework *.g|
Sub-Directories to Include in Recursive...

User Header Search Paths

Unit Testing

Other Test Flags

Tact Afrar Ruild

11. In the middle pane, click the MAKitSample target.

No 7

| Recursive | Path

+ I s(SRCROOT)/../../MAKit/includes

Done

a. Inthe right pane, select the Build Phases tab, then expand the Link Binary with Libraries

section.

b. Click the + icon below the list, select the following frameworks, and click Add to add them

from the iOS 4.3 SDK to the project:
= MessageUl.framework
= QuartzCore.framework
= libsqlite3.0.dylib

12. Drag the frameworks you added in step 11 to the Frameworks folder in the Project Navigator.

After completing these steps, the Project Navigator looks similar to:
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ao0o0

=
= \Ej

| MAKitSample | iPad 4.3
Run S'Ec:p Scheme

| & 4 = = B8

| MAKitTutorials.sglite
|__|Resources
MAKIt.bundle

| | MAKitSample
| | Frameworks

| libMAKit.a

| libsglite3.0.dylib

= Messagell.framework

ﬁ QuartzCore._framework

-

B= UIKit.framework
= Foundation.framework
= CoreGraphics.framework
= CoreData.framework

| | Products

13. Select Product > Clean, then Product > Build to test the initial setup. If you correctly followed all
the steps, you see a Bui Ild Succeeded message.

Lesson 2: Building Basic MAKit Charts Using Metadata

This lesson describes:

e (Creating the ChartsDatasource class

e Creating an XML metadata file containing charts configuration
e Implementing the MAKit Query module for charts

e Configuring the user interface for the iOS application

e The build and execute procedure

Creating ChartsDatasource Class

Create the ChartsDatasource class to include a method to connect to the tutorial database
MAKitTutorials.sqglite, and methods to retrieve data for the charts configured in the XML metadata
file. The methods implemented in this class are called by the MAKit Query module.

Tip: To create the ChartsDatasource file, copy and paste the code below.
1. Openthe MAKitSample.xcodeproj in the Xcode IDE.
2. Inthe MAKitSample project, select File > New > New File.
3. Select iOS > Cocoa Touch > Objective-C class and click Next.
4. Accept NSObject in the Subclass of field and click Next.

5. Enter ChartsDatasource in the Save As field and click Save.
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This creates ChartsDatasource.h and ChartsDatasource .m files in the Project Navigator.

6. Click ChartsDatasource.h and replace the existing code with:

#import <Foundation/Foundation.h>
#import "sqlite3.h"

@interface ChartsDatasource : NSObject {
sqlite3 *dblnstance;
3

//Database Methods
-(void) OpenDatabase;
-(void) CloseDatabase;

// Basic Charts Datasource Methods
-(NSArray *) NumberOfOrders;
-(NSArray *) SalesPerformance;

@end

7. Click File > Save.

8. Click ChartsDatasource.m and replace the existing code with:
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#import "ChartsDatasource.h"

@implementation ChartsDatasource

//0pen Database connection & assign to pointer dblnstance variable
-(void) OpenDatabase {

otry {

NSArray *path = NSSearchPathForDirectoriesInDomains(NSDocumentDirectory,
NSUserDomainMask, YES);

NSString *documentDir = [path objectAtlndex:0];

NSString *dbPath = [documentDir stringByAppendingPathComponent:
@"MAKitTutorials.sqlite'];

iT (sqglite3_open_v2([dbPath UTF8String], &dblnstance, SQLITE_OPEN_NOMUTEX,
NULL) == SQLITE_OK) {
NSLog(@''Database Open Succeeds™);

else {
sqlite3_close(dblnstance);
3

}
@catch (NSException * e) {

NSLog(@"Failed to open the database. Reason %@",[e reason] );
}

}

//Close Database connection
-(void) CloseDatabase {
sqlite3_close(dblnstance);

3
-(id) init {
if (self == [super init]) {
dblnstance = nil;
[self OpenDatabase];
3
return self;
3

-(void) dealloc {

[selT CloseDatabase];
NSLog(@"Database Closed™);
[super dealloc];

//Sales Order Count by Year
-(NSArray *) NumberOfOrders {

NSMutableArray *returnArray = [[NSMutableArray alloc] init];

const char * SELECTQry = "SELECT strftime("%Y",OrderDate) as OrderYear, Region,
Count(OrderlID) from SalesOrder_Header "
" Group By strftime("%Y",OrderDate),Region *;

sqlite3_stmt *selectStmt = nil;

if (sqlite3 _prepare_v2(dblnstance, SELECTQry, -1, &selectStmt, NULL)==SQLITE_OK) {
NSString *year = @"";
NSString *region = @""';

int ordercount=0;
while (sqlite3_step(selectStmt)==SQLITE_ROW) {
year = [NSString stringWithUTF8String:(char *)
sqlite3_column_text(selectStmt, 0)];
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region = [NSString stringWithUTF8String: (char *)
sqlite3_column_text(selectStmt, 1)];

ordercount = sqlite3_column_int(selectStmt, 2);

NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];
[dict setObject:year forKey:@"Year'];
[dict setObject:region forKey:@"Region'];
[dict setObject:[NSNumber numberWithlnt:ordercount] forKey:@"OrderCount'];
[returnArray addObject:dict];
[dict release];
3

}

else {
NSLog(@"Failed at Prepare Statement in NumberOfOrders.

Reason %s',sqglite3_errmsg(dblnstance));

}

return returnArray;

}

//Sales Performance by Product/Region
-(NSArray *) SalesPerformance {

NSMutableArray *returnArray = [[NSMutableArray alloc] init];

const char * SELECTQry = "SELECT Region,ProductType, sum(UnitPrice * Quantity)
FROM SalesOrder_Header oh, SalesOrder_Details od, Product p "
" WHERE oh.OrderlID = od.OrderID AND od.ProductlD = p.ProductlD **
" GROUP BY Region,ProductType ™

sqlite3_stmt *selectStmt = nil;

if (sqlite3_prepare_v2(dblnstance, SELECTQry, -1, &selectStmt, NULL)==SQLITE_OK) {
NSString *region = @""';
NSString *product = @""';
float salesamount = 0.0;
while (sqlite3_step(selectStmt)==SQLITE_ROW) {
region = [NSString stringWithUTF8String: (char *)
sqlite3_column_text(selectStmt, 0)];
product = [NSString stringWithUTF8String: (char *)
sqlite3_column_text(selectStmt, 1)];
salesamount = sglite3_column_double(selectStmt, 2);

NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];

[dict setObject:region forKey:@"Region'];

[dict setObject:product forKey:@"ProductType'];

[dict setObject:[NSNumber numberWithFloat:salesamount]
forKey:@"SalesAmount™];

[returnArray addObject:dict];

[dict release];

}

else {
NSLog(@"Failed at Prepare Statement in SalesPerformance.
Reason %s',sqlite3_errmsg(dblnstance));
}
return returnArray;

3
@end

9. Click File > Save.

Creating the XML Metadata File
The XML metadata file includes the:
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e  Charts configuration, which includes the chart name, the query for the chart that pumps the data,
and the chart’s category, series, and value axis information. The chart configuration resides in the
<dashboard> .. </dashboard> tag.

e Dashboard screen layout, for both landscape and portrait modes, which is configured in the
<DashboardLayout> .. </DashboardLayout> tag.

1. Inthe MAKitSample project, click File > New > New File.

2. Select iOS > Other > Empty and click Next.

3. Enter SalesMetadata.xml in the Save As field and click Save.
This creates the SalesMetadata.xml file in the Project Navigator.

4. Click SalesMetadata.xml and add this content to the file:

<?xml version="1.0" encoding=""utf-8"?>
<MobileAnalytic MAKitVersion="1.1" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemalLocation="MAKitMetaFile.xsd">

<I-- Dashboard Charts configuration -->
<Dashboard>
<!-- Column Chart configuration for Number of Sales Orders by Year -->

<Chart Name='"'SalesOrderCount™ Title="Number of Sales Orders" ChartType="Column*
Query="0rderCount'>

<Category Format=""" Column="Year" DisplayName="Sales Year" />
<Series Format=""" Column="Region" DisplayName="Region" />
<Values>

<Value Format="Rounded0" Expression=""0rderCount” ValueSequence="1" DisplayName="# of
Order for year'" />
</Values>
</Chart>

<I-- Line Chart configuration for Sales Performance -->
<Chart Name='"SalesPerformance"™ Title="Sales Performance By Region' ChartType="Line"
Query="SalesPerf'>

<Category Format=""" Column="Region" DisplayName=""Reason for Sales" />
<Series Format=""" Column="ProductType'" DisplayName="Product" />
<Values>

<Value Format="Currency" Expression=""SalesAmount' ValueSequence="1" DisplayName="Sales
Amount™ />
</Values>
</Chart>
</Dashboard>

<I-- Dashboard Layout Configuration -->
<DashboardLayout>
<Landscape>
<1-- Dashboard display in Landscape Orientation -->
<!-- Column Chart occupy 60% of the screen height and 100% width -->
<Layout Name="SalesOrderCount” Top="0" Left="0" Width=""100" Height="60" />
<Layout Name="'SalesPerformance' Top='"'61" Left="0" Width="100" Height="40" />
</Landscape>
<Portrait>
<!-- Dashboard display in Portrait Orientation -->
<I-- Column Chart occupy 50% of the screen height and 100% width -->
<Layout Name="'SalesOrderCount” Top="0" Left="0" Width="100" Height="50" />
<Layout Name="SalesPerformance' Top='"51" Left="0" Width="100" Height="50" />
</Portrait>
</DashboardLayout>
</MobileAnalytic>

5. Click File > Save.

Implementing the MAKit Query Module
The MAKit Query module contains two Objective-C protocols: MAQueryDelegate and
MAQueryDataTable.

MAQueryDelegate includes the executeQuery method, which executes the name of the query defined
in the XML metadata configuration of the chart.
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MAQueryDataTable holds the result of the query and is passed to the chart to draw the chart.

Creating the ChartDataTable Class

The ChartDataTable class must conform to MAQueryDataTable protocol and must implement all the
protocol methods defined in MAQueryDataTable. The ChartDataTable holds the result set of the query,
which is passed to the chart to draw the chart.

In the MAKitSample project, select File > New > New File.
Select i0S > Cocoa Touch >Objective-C class and click Next.

Accept NSObject in the Subclass of field and click Next.

e A

Enter ChartDataTable in the Save As field and click Save.
This creates the ChartDataTable.h and ChartDataTable.mfiles in the Project Navigator.

5. Click ChartDataTable.h and replace the existing code with:

#import <Foundation/Foundation.h>
#import “"MAKit.h"

@interface ChartDataTable : NSObject<MAQueryDataTable> {

@property (nonatomic,retain) NSArray *tabularData;

@end

6. Click File > Save.

7. Click ChartDataTable.m and replace the existing code with:
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#import "ChartDataTable.h"
@implementation ChartDataTable
@synthesize tabularData;

#pragma mark -
#pragma mark MAQueryDataTable Delegate methods

-(int)getColumnCount {
if(self.tabularData !'= nil && [self.tabularData count] > 0)

NSDictionary* row = (NSDictionary*)[self.tabularData objectAtindex:0];
return [row count];

}

else

{
}

return O;

-(int)getRows {

ifT (self.tabularData != nil) {
return [self.tabularData count];

else {
return O;
3

-(id)getData: (NSString*)colName atlndex:(int)rowlndex {
if(self.tabularData != nil && [self.tabularData count] > rowlndex)

NSDictionary* row = (NSDictionary*)[self.tabularData objectAtIndex:rowlndex];
return [row objectForKey:colName];

}

else

{
3

return nil;

}

#pragma mark -
-(void) dealloc {

[self.tabularData release];
[super dealloc];

3
@end

8. Click File > Save.

Creating the ChartQuery Class

The ChartQuery class must conform to MAQueryDelegate protocol and must implement the
executeQuery method to execute the query associated with the chart. (The name of the query is
configured in the XML metadata in the Query attribute of the chart tag.)

1. Inthe MAKitSample project, select File > New > New File.
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2. Select iOS > Cocoa Touch >Objective-C class and click Next.

3. Accept NSObject in the Subclass of field and click Next.

4. Enter ChartQuery in the Save As field and click Save.

This creates the ChartQuery.h and ChartQuery.mfiles in the Project Navigator.

5. Click ChartQueryClass.h and replace the existing code with:

#import <Foundation/Foundation.h>
#import "MAKit.h"

@interface ChartQuery : NSObject<MAQueryDelegate> {

3
@end

6. Click File > Save.

7. Click ChartQuery.m and replace the existing code with:

#import "ChartQuery.h"
#import "ChartsDatasource.h™
#import "ChartDataTable.h™
@implementation ChartQuery

#pragma mark -
#pragma mark MAQueryDelegate method

-(id<MAQueryDataTable>)executeQuery: (NSString*)queryName withArgument:
(NSDictionary*)args {

ChartDataTable *dataTable = [[ChartDataTable alloc] init];
iT ([queryName isEqualToString:@"OrderCount™]) {

[[ChartsDatasource alloc] init];
[cds NumberOfOrders];

ChartsDatasource *cds
dataTable.tabularData
[cds release];

¥
else if ([queryName isEqualToString:@"SalesPerf']) {
ChartsDatasource *cds = [[ChartsDatasource alloc] init];

dataTable.tabularData = [cds SalesPerformance];
[cds release];

return dataTable;

3
@end

8. Click File > Save.

Creating the User Interface for the Application

Configuring MAKitSampleAppDelegate Files

The MAKitSampleAppDelegate . h and MAKitSampleAppDelegate.m files are created when you
create the Xcode project, but you must add the view controller property to the header file and create the
view controller instance in the implementation file to display the initial view.
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1. Click MAKitSampleAppDelegate._h and replace the existing code with the code below to add
the view controller property to the application delegate.

#import <UIKit/UIKit_h>

@interface MAKitSampleAppDelegate : NSObject <UlApplicationDelegate> {

}

@property (nonatomic, retain) IBOutlet UlIWindow *window;
@property (nonatomic, retain) IBOutlet UlNavigationController *navController;

@property (nonatomic, retain, readonly) NSManagedObjectContext *managedObjectContext;
@property (nonatomic, retain, readonly) NSManagedObjectModel *managedObjectModel;
@property (nonatomic, retain, readonly) NSPersistentStoreCoordinator
*persistentStoreCoordinator;

- (void)saveContext;
- (NSURL *)applicationDocumentsDirectory;
- (void) copyDatabaselfNeeded;

@end

2. Click File > Save.

3. Click MAKitSampleAppDelegate.m and replace the portions of existing code as indicated
below, to create an instance of view controller property and to copy the database to the device:

#import "MAKitSampleAppDelegate.h™

@implementation MAKitSampleAppDelegate

@synthesize window=_window;

@synthesize navController;

@synthesize managedObjectContext=__managedObjectContext;

@synthesize managedObjectModel=__managedObjectModel ;

@synthesize persistentStoreCoordinator=__persistentStoreCoordinator;

- (BOOL)application: (UlApplication *)application
didFinishLaunchingWithOptions: (NSDictionary *) launchOptions
{

//Copy database to device

[self copyDatabasel fNeeded];

//Create & Add view controller instance
[self.window addSubview:navController.view];
[self.window makeKeyAndVisible];

return YES;
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//Copy MAKitTutorials.sglite database to device

- (void) copyDatabaselfNeeded {
NSFileManager *fileManager = [NSFileManager defaultManager];
NSError *error;

NSArray *paths = NSSearchPathForDirectorieslinDomains(NSDocumentDirectory ,
NSUserDomainMask, YES);

NSString *documentsDir = [paths objectAtIndex:0];

NSString *dbPath = [documentsDir
stringByAppendingPathComponent: @' 'MAKitTutorials.sqlite'"];

BOOL success = [fileManager fileExistsAtPath:dbPath];
if(Isuccess) {

NSString *defaultDBPath = [[[NSBundle mainBundle] resourcePath]
stringByAppendingPathComponent: @' 'MAKitTutorials.sqlite"];

success = [fileManager copyltemAtPath:defaultDBPath toPath:dbPath
error:&error];

if (Isuccess)
NSLog(@"Failed to create writable database file with message "%@".",
[error localizedDescription]);

}

4. Click File > Save.

Adding the MainViewController
Create a MainViewController view controller, which functions as the main screen for the MAKitSample
application.

1. Inthe MAKitSample project, select File > New > New File.

2. Select iOS > Cocoa Touch > UlViewController subclass and click Next.

3. SelectUITableViewController in the Subclass of field, unselect With XIB for user interface,
select Targeted for iPad, then click Next.

4. Enter MainViewController in the Save As field and click Save.

This creates the MainViewController.h and MainViewController.m files in the Project
Navigator.

5. Click MainViewController.h and replace the existing code with:

#import <UIKit/UIKit.h>

@interface MainViewController : UlTableViewController {

}

@property (nonatomic, retain) NSMutableArray *viewControllers;

@end

6. Click File > Save.

7. Click MainViewController.mand replace the existing code with:
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#import "MainViewController.h"
#import "ChartQuery.h"
#import "MAKit_h"

@implementation MainViewController
@synthesize viewControllers;

- (void)dealloc
[super dealloc];

#pragma mark - View lifecycle

- (void)viewDidLoad

{
[super viewDidLoad];
self._viewControllers = [[NSMutableArray alloc] init];
NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];
[dict setObject:@"MAKit Basic Charts" forKey:@"Title"];
[dict setObject:@"SalesMetadata' forKey:@'MetaData'];
[self.viewControllers addObject:dict];
[dict release];

3

- (void)viewDidUnload
[super viewDidUnload];
self.viewControllers = nil;

}

- (BOOL)shouldAutorotateTolnterfaceOrientation: (Ul InterfaceOrientation)
interfaceOrientation

// Return YES for supported orientations
return YES;
by
#pragma mark - Table view data source
- (NSInteger)tableView: (UITableView *)tableView
numberOfRowsInSection: (NSInteger)section

{
3
- (UlTableViewCell *)tableView: (UlTableView *)tableView cellForRowAtIndexPath:

(NSIndexPath *)indexPath
{

return [self.viewControllers count];

static NSString *Cellldentifier = @"Cell";

UlTableViewCell *cell = [tableView
dequeueReusableCellWithldentifier:Cellldentifier];
if (cell == nil) {
cell = [[[UlTableViewCell alloc] initWithStyle:UlTableViewCellStyleDefault
reuseldentifier:Cellldentifier] autorelease];

}

// Configure the cell...

NSMutableDictionary *dict = [self.viewControllers objectAtIndex:indexPath.row];
cell_textLabel .text = [dict objectForKey:@"Title"];

cell _accessoryType = UlTableViewCel lAccessoryDisclosurelndicator;

return cell;
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#pragma mark - Table view delegate
- (void)tableView: (UlTableView *)tableView didSelectRowAtlndexPath: (NSIndexPath
*) indexPath

{

NSMutableDictionary *dict = [self.viewControllers objectAtlndex:indexPath.row];
NSString *metaFile = [dict objectForKey:@"MetaData'];

//Create MAViewController

ChartQuery *query = [[ChartQuery alloc] init];

MAViewController *mv = [[MAViewController alloc] init];

mv.metaDataPath = [[NSBundle mainBundle] pathForResource:metaFile ofType:@"xml'];
mv.theme = [[[MAKitTheme_WelterWeight alloc] init] autorelease];

mv.dataSource = query;

[self.navigationController pushViewController:mv animated:YES];
[query release];
[mv release];

b
@end
8. Click File > Save.

Making Connections
Add the Navigation Controller to the MainWindow.xib file, and connect the navControl ler outlet
defined in MAKitSampleAppDelegate to the Navigation Controller.

1. Click the MainWindow.xib file and, if the Objects Library pane is not already visible, select View >
Utilities > Object Library.

2. Drag and drop the Navigation Controller onto the Objects pane below the MAKit Sample App
Delegate icon.

3. Control-drag from the MAKit Sample AppDelegate icon to the new Navigation Controller icon to
create a navController outlet.

4. Click the expansion arrow on the Navigation Controller icon, select Navigation Controller > View
Controller, and in the identity inspector, select MainViewControl ler in the Class field.

| w4 > | [MAKitSample » [ MAKitSa.. » 8 MainWin... » 8 MainWin... ; & Navigation Controller » () Main View Controller - Root View Controller | D BlBlw = ©

[ Placeholders

File's Owner
) First Responder
¥4 Objects

Window k
Kit Sample App Delegate

&9 Navigation Controller
#< Navigation Bar

The ViewController name in the hierarchy changes to MainViewController,
connection from the AppDelegate to the Navigation Controller is created.

Custom Class

| Class | MainViewController O =
| Identity
|

|

_( Label[cods Specifc Lasel |

Root View Controller

x

Object ID

11
Lock |_Inherited - (Nothing) |5

Notes [_| Show With Selection

v

D {} & =

ADBannerview class provides a view
that displays banner...
Object - Provides a template for

objects and controllers nat directly
available in Interface Builder.

External Object - Provides a
placeholder for an abject that exists
outside of the document.
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5. Click File > Save.

Deploying the Application
Deploy the MAKitSample application to the iPad Simulator for testing.
1. Inthe Xcode MAKitSample project, verify that the Scheme is set to MAKitSample > iPad 4.3
Simulator, and select Product > Clean.
2. Select Product > Build.
If you correctly followed all the steps in the tutorial, you see a Build Succeeded message.
3. Select Product > Run.

The project is rebuilt, and the iPad Simulator starts and loads the application. You see the initial
screen:

9:52 AM

MAKit Tutorial

MAKit Basic Charts >

4. Click MAKit Basic Charts.
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iPad = 11:26 AM

MAKIt Tutorial MAKIit Basic Charts

Number of Sales Orders

2003

Canada: 8 B Central: 29 | [ Eastern: 29 |l South: 12 | Western: 5

el

Sales Performance By Region

Canada

T Baseball Cap: $3,228.00 | [ Shorts: $3,240.00 | [ Sweatshirt: $13,248.00 [ Tee Shirt: 58,544.0(

o @

Canada Central Eastar Waester

5. Click the arrow image to the right to load the chart in full screen.
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Sales Performance By Region

= Baseball Cap: $3,228.00 ts: $3,240.0C tshirt: $13, '

40K -

35K -

20K -
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[=1

Canada Central Eastemn South Wastern

6. Click Done to return to the previous (dashboard) view.
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Lesson 3: Building Semantic Zooming Charts Using Metadata

This lesson creates a sales performance zooming chart. At the highest level, the chart depicts sales
performance in North America and Europe, by year. The chart includes user interface controls that allow
you to zoom into lower levels, for example, to see sales performance by quarter and by month.

This lesson describes:

e  Configuring multiple zooming levels for a chart in metadata
e Writing queries for each zooming level in datasource class

e How semantic zooming works at runtime

Adding Methods to the ChartsDataSource Class

To create a zooming chart that has three levels (year, quarter, and month), create three methods—one
for each level.

1. Inthe Xcode IDE, open MAKitSample.xcodeproj -

2. Inthe Project Navigator, click ChartsDatasource.h file and add these method definitions:

#import <Foundation/Foundation.h>
#import “sqlite3.h"

@interface ChartsDatasource : NSObject {
sqlite3 *dblnstance;

}

//Zooming Charts Datasource methods
-(NSArray *) SalesByYear;

-(NSArray *) SalesByQuarter;
-(NSArray *) SalesByMonth;

3. Click File > Save.

4. Click ChartDatasource.m file and add the method implementation code for the three
methods:
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#import "ChartsDatasource.h"

@implementation ChartsDatasource

//Zooming Charts Datasource methods
//SalesByYear Method
-(NSArray *) SalesByYear {
NSMutableArray *returnArray = [[NSMutableArray alloc] init];

const char * SELECTQry = "SELECT SalesYear, RegionGroup,Sum(SalesAmount) *
" FROM ResellerSales WHERE SalesYear>2001 AND RegionGroup <>"Pacific™"
" GROUP BY SalesYear,RegionGroup *;

sqlite3_stmt *selectStmt = nil;

it (sglite3_prepare_v2(dblnstance, SELECTQry, -1, &selectStmt, NULL)==SQLITE_OK) {
NSString *year = @"";
NSString *region = @"";
float salesamount = 0.0;
while (sglite3_step(selectStmt)==SQLITE_ROW) {
year = [NSString stringWithUTF8String: (char *)
sqlite3_column_text(selectStmt, 0)];
region = [NSString stringWithUTF8String: (char *)
sqlite3_column_text(selectStmt, 1)];
salesamount = sqlite3_column_double(selectStmt, 2);

NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];

[dict setObject:year forKey:@"SalesYear'];

[dict setObject:region forKey:@'"Region'];

[dict setObject:[NSNumber numberWithFloat:salesamount]
forKey:@'"SalesAmount'];

[returnArray addObject:dict];

[dict release];

}

else {
NSLog(@"Failed at Prepare Statement in SalesByYear.
Reason %s',sqlite3_errmsg(dblnstance));
b

return returnArray;

}

//SalesByQuarter Method
-(NSArray *) SalesByQuarter {
NSMutableArray *returnArray = [[NSMutableArray alloc] init];
const char * SELECTQry = "SELECT SalesYear, SalesQuarter, RegionGroup, **
" Sum(SalesAmount) FROM ResellerSales ™
" WHERE SalesYear>2001 AND RegionGroup <>"Pacific™"
" GROUP BY SalesYear,SalesQuarter,RegionGroup ';

sqlite3_stmt *selectStmt = nil;

it (sglite3_prepare_v2(dblnstance, SELECTQry, -1, &selectStmt, NULL)==SQLITE_OK) {
NSString *year = @""';
NSString *qtr = @""';
NSString *region = @""';
float salesamount = 0.0;
while (sglite3_step(selectStmt)==SQLITE_ROW) {
year = [NSString stringWithUTF8String: (char *)
sqlite3_column_text(selectStmt, 0)];

qtr = [NSString stringWithUTF8String: (char *)
sqlite3_column_text(selectStmt, 1)];

region = [NSString stringWithUTF8String: (char *)
sqlite3_column_text(selectStmt, 2)];

salesamount = sqglite3_column_double(selectStmt, 3);
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NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];

[dict setObject:year forKey:@"SalesYear'];

[dict setObject:qtr forKey:@"SalesQuarter™];

[dict setObject:region forKey:@"Region'];

[dict setObject:[NSNumber numberWithFloat:salesamount]
forKey:@"SalesAmount™] ;

[returnArray addObject:dict];

[dict release];

}

else {
NSLog(@"Failed at Prepare Statement in SalesByQuarter.
Reason %s',sqlite3_errmsg(dblnstance));

}

return returnArray;

}

//SalesByMonth Method
-(NSArray *) SalesByMonth{
NSMutableArray *returnArray = [[NSMutableArray alloc] init];

const char * SELECTQry = "SELECT SalesYear, SalesQuarter, SalesMonth, RegionGroup, "
" Sum(SalesAmount) FROM ResellerSales ™
" WHERE SalesYear>2001 AND RegionGroup <>"Pacific™"
" GROUP BY SalesYear,SalesQuarter,SalesMonth,RegionGroup ";

sqlite3_stmt *selectStmt = nil;
if (sqlite3 prepare_ v2(db|nstance SELECTQry, -1, &selectStmt, NULL)==SQLITE_OK) {
NSString *year = @"",
NSString *qtr = @
NSString *mth = @™
NSString *region = @""'
float salesamount = 0.0;
while (sqlite3_step(selectStmt)==SQLITE_ROW) {
year = [NSString stringWithUTF8String:(char *)
sqlite3_column_text(selectStmt, 0)];
qtr = [NSString stringWithUTF8String: (char *)
sqlite3_column_text(selectStmt, 1)];
mth = [NSString stringWithUTF8String:(char *)
sqlite3_column_text(selectStmt, 2)];
region = [NSString stringWithUTF8String: (char *)
sqlite3_column_text(selectStmt, 3)];
salesamount = sqlite3_column_double(selectStmt, 4);

NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];

[dict setObject:year forKey:@"SalesYear'];

[dict setObject:qtr forKey:@"SalesQuarter™];

[dict setObject:mth forKey:@"SalesMonth'];

[dict setObject:region forKey:@"Region'];

[dict setObject:[NSNumber numberWithFloat:salesamount]
forKey:@"SalesAmount™] ;

[returnArray addObject:dict];

[dict release];

}

else {
NSLog(@"Failed at Prepare Statement in SalesByMonth.
Reason %s'",sqlite3_errmsg(dblnstance));

}

return returnArray;

3
@end

5. Click File > Save.
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Creating XML Metadata File with Zooming Levels
Next, create a new XML metadata file with which to configure the zooming chart. Zoom behavior for each

level is configured in the <ZoomingLevels> .. </ZoomingLevels> tagin the metadata.
Configure the first zooming level to display the sales performance by year:
1. Inthe MAKitSample project, click File > New > New File.
2. Select iOS > Other > Empty and click Next.
3. Enter ZoomingChartMetadata.xml in the Save As field and click Save.
This creates the ZoomingChartMetadata.xml file in the Project Navigator.

4. Click ZoomingChartMetadata.xml and add this content to the file:

<?xml version="1.0" encoding="utf-8"?>
<MobileAnalytic MAKitVersion="1.1" xmIns:xsi="http://www._.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemalLocation="MAKitMetaFile.xsd">

<Dashboard>

<!-- Zooming Chart configuration for Sales Performance ByYear/Qtr/Month -->
<Chart Name="ZoomingChart" Title="Sales Performance" ChartType="Column™ >

<Category Format=""" DisplayName="Sales ByYear-Quarter-Month" />
<Series Format=""" Column="Region™ DisplayName=""Sales Region" />
<Values>
<Value Format="Currency" Expression="SalesAmount™ ValueSequence="1" DisplayName=""" />
</Values>
<l-- Zooming Levels Configuration -->
<ZoomingLevels>

<ZoomingLevel Query="SalesByYear'" CategoryColumn="SalesYear" Title="ByYear" />

<ZoomingLevel Query="SalesByQuarter' CategoryColumn="SalesQuarter'™ Title="ByQuarter"™ />

<ZoomingLevel Query="SalesByMonth" CategoryColumn="SalesMonth" Title="ByMonth" />
</ZoomingLevels>

</Chart>

</Dashboard>
<DashboardLayout>
<Landscape>
<!-- Dashboard display in Landscape Orientation -->
<Layout Name="ZoomingChart" Top="0" Left="0" Width="100" Height="80" />
</Landscape>

<Portrait>
<!-- Dashboard display in Portrait Orientation -->
<Layout Name="ZoomingChart" Top="0" Left="0" Width="100" Height="85" />
</Portrait>
</DashboardLayout>
</MobileAnalytic>

5. Click File > Save.
Adding Scripts in ChartQuery and ViewController Classes

Modifying ChartQuery Class
Add code to the ChartQuery class to execute the appropriate datasource query method, depending on
the zooming level.

1. Inthe Project Navigator, click the ChartsQuery.mfile.

2. Append this code to the executeQuery method with the existing script in the method:
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#import "ChartQuery.h"
#import "ChartsDatasource.h"
#import "ChartDataTable.h™

@implementation ChartQuery

#pragma mark -
#pragma mark MAQueryDelegate method

- (id<MAQueryDataTable>)executeQuery: (NSString*)queryName withArgument:

(NSDictionary*)args {

ChartDataTable *dataTable = [[ChartDataTable alloc] init];

else if ([queryName isEqualToString:@"SalesByYear™]) {

ChartsDatasource *cds
dataTable.tabularData
[cds release];

[[ChartsDatasource alloc] init];
[cds SalesByYear];

¥
else if ([queryName isEqualToString:@"SalesByQuarter']) {

ChartsDatasource *cds
dataTable.tabularData
[cds release];

[[ChartsDatasource alloc] init];
[cds SalesByQuarter];

3
else if ([queryName iskEqualToString:@"SalesByMonth™]) {
ChartsDatasource *cds

dataTable.tabularData
[cds release];

[[ChartsDatasource alloc] init];
[cds SalesByMonth];

}

return dataTable;

@end

3. Click File > Save.

Adding Script to MainViewController Class
1. Inthe Project Navigator, click the MainViewController.mfile.

2. Add this code to the ViewDidLoad method with the existing script in the method:

- (void)viewDidLoad

//Zooming Chart

dict = [[NSMutableDictionary alloc] init];

[dict setObject:@"MAKit Zooming Chart'" forKey:@"Title'"];
[dict setObject:@"ZoomingChartMetadata™ forKey:@"MetaData'];
[self.viewControllers addObject:dict];

[dict release];

3. Click File > Save.
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Deploying the Application
Deploy the MAKitSample application to the iPad Simulator for testing.
1. Inthe Xcode MAKitSample project, verify that the Scheme is set to MAKitSample > iPad 4.3

Simulator, and select Product > Clean.

2. Select Product > Build.

If you correctly followed all the steps in the tutorial, you see a Build Succeeded message.

3. Select Product > Run.

The project is rebuilt and iPad Simulator starts and loads the application. The initial screen now
contains additional entry for “Zooming Chart.”

9:52 AM

MAKIt Tutorial

MAKit Basic Charts >

MAKit Zooming Chart >

4. Click MAKit Zooming Chart.
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MAKIt Tutorial MAKit Zooming Chart

Sales Performance

2002

7 Europe: $1,698,881.00 | [ North America: $22,445,548.00

Click the arrow image in the upper-right corner to load the chart in full screen.

The zooming chart loads in full screen with zooming level 1 (Sales ByYear) selected:
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6. Click ByQuarter.
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7. Click ByMonth.
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Lesson 4: Building Drilldown Charts Using Metadata

This lesson describes how to create three levels of drilldown chart on reseller sales data. At the highest
level, the chart shows reseller sales, aggregated by product category. Tapping a particular product
category loads a sales performance for the selected product category grouped by product subcategory in
three regions. Tapping a particular region loads a detailed chart for that region.

This lesson describes:

e Configuring the metadata for a drilldown group with three levels in a drilldown chart
e Creating datasource queries for drilldown charts by passing query parameters

e Userinteractions in drilldown charts

Adding Methods to the ChartsDataSource Class

To create a drilldown chart with three levels of drilldown, create three methods: one to retrieve summary
data, one to retrieve data based on selected product category, and one to retrieve data for a selected
product category and region.

1. Openthe MAKitSample.xcodeproj in the Xcode IDE.

2. Inthe Project Navigator, click the ChartsDatasource.h file and add these method definitions:

#import <Foundation/Foundation.h>
#import "sqlite3.h"

@interface ChartsDatasource : NSObject {
sqlite3 *dblnstance;
}

//Drilldown Charts Datasource methods

- (NSArray *) ResellerSummary;

- (NSArray *) ResellerDataForProduct: (NSString *) product;

- (NSArray *) ResellerDataForProduct: (NSString *) product andRegion: (NSString *) region;

3. Click File > Save.

4. Click ChartDatasource.m file and add the method implementation code for the methods:
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#import "ChartsDatasource.h"

@implementation ChartsDatasource

//Drilldown Charts Datasource methods
//ResellarSummary Data
-(NSArray *) ResellerSummary {

const char* SELECT="SELECT ProductCategory, RegionGroup, round(sum( SalesAmount),2) "
" FROM ResellerSales Group By ProductCategory,RegionGroup **;

NSMutableArray *data = [[NSMutableArray alloc] init];
sqlite3_stmt *selectStmt = nil;
it (sglite3_prepare_v2(dblnstance, SELECT, -1, &selectStmt, NULL)==SQLITE_OK) {
NSString *pc=@"";
NSString *rg=@"";
double amount =0;
while (sqlite3_step(selectStmt)==SQLITE_ROW) {
pc = [NSString stringWithUTF8String:(char *) sqlite3_column_text(selectStmt, 0)];
rg = [NSString stringWithUTF8String: (char *) sqlite3_column_text(selectStmt, 1)];
amount = sqlite3_column_double(selectStmt, 2);

NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];

[dict setObject:pc forKey:@"ProductCategory'];

[dict setObject:rg forKey:@"Region"];

[dict setObject:[NSNumber numberWithDouble:amount] forKey:@"SalesAmount'];
[data addObject:dict];

[dict release];

¥

else {
NSLog(@"Failed at Prepare Statement in ResellerSummary.
Reason %s'",sqglite3_errmsg(dblnstance));
b
return data;

}

//ResellerData for specific product
- (NSArray *) ResellerDataForProduct: (NSString *) product {

const char * SELECT = "SELECT RegionGroup, ProductSubCategory, "
"round(sum(SalesAmount),2) FROM ResellerSales ™
" WHERE ProductCategory = ? GROUP BY RegionGroup, ProductSubCategory";

NSMutableArray *data = [[NSMutableArray alloc] init];
sqlite3_stmt *selectStmt = nil;
if (sglite3d_prepare_v2(dblnstance, SELECT, -1, &selectStmt, NULL)==SQLITE_OK) {

sglite3_bind_text(selectStmt, 1, [product UTF8String], -1, SQLITE_STATIC);

NSString *region=@""";
NSString *psc=0@""";
double amount =0;

while (sqlite3_step(selectStmt)==SQLITE_ROW) {
region = [NSString stringWithUTF8String: (char *)sqlite3_column_text(selectStmt,0)];
psc = [NSString stringWithUTF8String: (char *)sqlite3_column_text(selectStmt, 1)];
amount = sqlite3_column_double(selectStmt, 2);

NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];
[dict setObject:region forKey:@"Region™];
[dict setObject:psc forKey:@"ProductSubCategory'];
[dict setObject:[NSNumber numberWithDouble:amount] forKey:@"SalesAmount'];
[data addObject:dict];
[dict release];

else {
NSLog(@"Failed at Prepare Statement in ResellerProductByRegion. Reason %s',
sqlite3_errmsg(dblnstance));
b

return data;

}

//ResellerData for Selected product & region
- (NSArray *) ResellerDataForProduct: (NSString *) product andRegion: (NSString *) region {
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const char * SELECT = "SELECT Country,ProductSubCategory, round(sum(SalesAmount),2) "
" FROM ResellerSales WHERE ProductCategory = ? AND RegionGroup = ? *
' GROUP BY Country,ProductSubCategory ";

NSMutableArray *data = [[NSMutableArray alloc] init];

sqlite3d_stmt *selectStmt = nil;

if (sqlite3_prepare_v2(dblnstance, SELECT, -1, &selectStmt, NULL)==SQLITE_OK) {
sqlite3 bind_text(selectStmt, 1, [product UTF8String], -1, SQLITE_STATIC);
sqlite3_bind_text(selectStmt, 2, [region UTF8String], -1, SQLITE_STATIC);

NSString *country = @""
NSString *psc=@"";
double amount =0;
while (sqlite3_step(selectStmt)==SQLITE_ROW) {
country = [NSString stringWithUTF8String:(char *) sqlite3_column_text(selectStmt, 0)];

psc = [NSString stringWithUTF8String: (char *) sqglite3_column_text(selectStmt, 1)];
amount = sqlite3_column_double(selectStmt, 2);

NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];
[dict setObject:country forKey:@"Country'];
[dict setObject:psc forKey:@"ProductSubCategory'];
[dict setObject:[NSNumber numberWithDouble:amount] forKey:@"SalesAmount'];
[data addObject:dict];
[dict release];
¥
}

else {

NSLog(@"Failed at Prepare Statement in ResellerProductByRegion. Reason %s',
sqlite3_errmsg( dblnstance));

return data;

b
@end

5. Click File > Save.

Creating XML Metadata File Configured with DrillDownGroup

Create a new XML metadata file to configure drilldown charts within the DrillDownGroup. Configure all
the charts in the drilldown in the <Dri I IDownGroup> .. </DrillDownGroup> tag in the metadata.

Individual drilldown levels are identified by ChartSequence attribute in the chart configuration.

1. Inthe MAKitSample project, click File > New > New File.

2. SelectiOS > Other > Empty and click Next.

3. Enter DrilldownChartMetadata.xml in the Save As field and click Save.
This creates the Dri I ldownChartMetadata.xml file in the Project Navigator.

4, Click DrilldownChartMetadata.xml and add this content to the file:
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<?xml version="1.0" encoding=""utf-8"?>
<MobileAnalytic MAKitVersion="1.1" xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemalLocation="MAKitMetaFile.xsd">

<Dashboard>
<!-- Drilldown Chart configuration -->
<DrilIDownGroup Name="DrilldownChart" Title="Drilldown By ProductCategory to Zooming Chart'>
<I-- Chart Sequence 1 -->

<Chart Name="SalesSummary' Title=""Reseller Sales Summary For All Regions"
ChartType="Column' ChartSequence="1" Query="ResellerSummary' ByCategory=""1" >
<Category Format=""" Column="ProductCategory" DisplayName="ProductCategory" />

<Series Format=""" Column=""Region" DisplayName=""" />
<Values>
<Value Format="Currency' Expression="SalesAmount" ValueSequence="1" DisplayName=""" />
</Values>
</Chart>
<I-- Chart Sequence 2 -->

<Chart Name="SalesByRegion" Title="Reseller Sales By Region" ChartType="Column"
ChartSequence="2" Query="ResaleByRegion">
<Category Format= Column="Region" DisplayName="RegionGroup" />
<Series Format=""" Column=""ProductSubCategory" DisplayName=""" />

<Values>
<Value Format="Currency'" Expression="SalesAmount" ValueSequence="1" DisplayName=""" />
</Values>
</Chart>
<I-- Chart Sequence 3 -->

<Chart Name="SalesByCountry' Title="Reseller Sales By Country' ChartType="Column®
ChartSequence="3" Query="ResaleByCountry'>
<Category Format=""" Column="Country" DisplayName="Country" />
<Series Format=""" Column="ProductSubCategory" DisplayName=""" />
<Values>
<Value Format="Currency' Expression="SalesAmount" ValueSequence="1" DisplayName=""" />
</Values>
</Chart>

</DrillDownGroup>
</Dashboard>

<DashboardLayout>
<Landscape>
<!-- Dashboard display in Landscape Orientation -->
<Layout Name="DrilldownChart"” Top="0" Left="0" Width="100" Height="80" />
</Landscape>
<Portrait>
<!-- Dashboard display in Portrait Orientation -->
<Layout Name="DrilldownChart™ Top="0" Left="0" Width="100" Height='"85" />
</Portrait>
</DashboardLayout>

</MobileAnalytic>

5. Click File > Save.
Adding Scripts in ChartQuery and ViewController Classes

Modifying ChartQuery Class
Add the code in ChartQuery class to execute the appropriate datasource query method depending on
the drilldown level.

1. Inthe Project Navigator, click the ChartsQuery .mfile.

2. Append this code to the executeQuery method with the existing script.
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#import "ChartQuery.h"
#import "ChartsDatasource.h"
#import "ChartDataTable.h™

@implementation ChartQuery

#pragma mark -
#pragma mark MAQueryDelegate method

- (id<MAQueryDataTable>)executeQuery: (NSString*)queryName withArgument:
(NSDictionary*)args {

ChartDataTable *dataTable = [[ChartDataTable alloc] init];

else if ([queryName isEqualToString:@" ResellerSummary*]) {
ChartsDatasource *cds = [[ChartsDatasource alloc] init];
dataTable.tabularData = [cds ResellerSummary];
[cds release];

}

else if ([queryName isEqualToString:@"ResaleByRegion]) {
ChartsDatasource *cds = [[ChartsDatasource alloc] init];
NSString *product = (NSString *)[args objectForKey:@"ProductCategory'];
dataTable.tabularData = [cds ResellerDataForProduct:product];
[cds release];

}

else if ([queryName isEqualToString:@"ResaleByCountry']) {
ChartsDatasource *cds = [[ChartsDatasource alloc] init];
NSString *product = (NSString *) [args objectForKey:@"ProductCategory'];
NSString *region = (NSString *)[args objectForKey:@"Region'];

dataTable.tabularData = [cds ResellerDataForProduct:product andRegion:

region];
[cds release];
} return dataTable;
3
@end

3. Click File > Save.

Adding Script to MainViewController Class
1. Inthe Project Navigator, click the MainViewController.mfile.

2. Add this code to the ViewDidLoad method with the existing script in the method:

- (void)viewDidLoad

{

//DrillDown Chart

dict = [[NSMutableDictionary alloc] init];

[dict setObject:@"MAKit DrillDown Chart" forKey:@"Title"];
[dict setObject:@"DrilldownChartMetadata'" forKey:@'"MetaData'];
[self.viewControllers addObject:dict];

[dict release];

3. Click File > Save.
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Deploying the Application
Deploy the MAKitSample application to the iPad Simulator for testing.
1. Inthe Xcode MAKitSample project, verify that the Scheme is set to MAKitSample > iPad 4.3
Simulator, and select Product > Clean.
2. Select Product > Build.

If you correctly followed all the steps in the tutorial, you see a Build Succeeded message.

3. Select Product > Run.

The project is rebuilt and iPad Simulator starts and load the application. The initial screen now
contains a “MAKit Drilldown Chart” row.

12:25 PM
MAKIt Tutorial
MAKIit Basic Charts >
MAKit Zooming Chart >
MAK:it Drilldown Chart >

4. Click MAKit Drilldown Chart.
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iPad 12:33 PM

MAKIt Tutorial MAKIit Drilldown Chart

Reseller Sales Summary For All Regions
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5. Click the arrow image in the upper-right corner to load the chart in full screen.
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5 PM

Reseller Sales Summary For All Regions

Accessories

Europe: $125,707.82 | North America: $5421,64258 | Pacific: $23,947.53
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Accessories Bikes Clothing Components

6. Double-tap Bikes.
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ProductCategory

"' Europe

Mountain Bikes: $2,440,510.03 | Road Bikes: $2,856,305.01 | Touring Bikes: $3,212,613.46

30M - 7

Europe MNorth America Pacific

7. Double-tap North America.
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RegionGroup

Bikes > North America

" Canada

Mountain Bikes: $4,722,796.81 |l Road Bikes: $5,714,211.14 | Touring Bikes: $1,199,372.64

25M - W

Canada United States
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Lesson 5: Adding Dynamic Analytics to Charts

Dynamic analytics is a powerful feature of MAKit that provides on-device analytic capability to give end
users instant insight into dynamic data for effective decision making, and allow them to explore
alternative scenarios and outcomes.

The core components of dynamic analytics include:

e Variable declaration
e  Chart value-expression using the declared variables
e The DA Panel

This lesson describes:

e Declaring variables in metadata
e Creating expressions for chart value axis by using variables
e Creating the DA Panel and its layout

e  Runtime behavior

Creating Dynamic Analytic XML Metadata Configuration
This lesson reuses the ChartDatasource method NumberOfOrders and the OrderCount query.

e Declare these two variables: $globalpromotion of type boolean and $regionalsalesdrive
of type enum.

e Write a chart value expression as if $globalpromotion is true, double the OrderCount value
(multiply it by 2)

e If$globalpromotion is false, determine which region currently has sales promotion (by
checking the $regionalsalesdrive value) and apply the expression as OrderCount * 6 for
that region only.

1. Inthe MAKitSample project, click File > New > New File.

2. Select iOS > Other > Empty and click Next.

3. Enter DAPanelMetadata.xml in the Save As field and click Save.
This creates the DAPane IMetadata.xml file in the Project Navigator.

4. Click DAPanelMetadata.xml and add this content to the file:
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<?xml version="1.0" encoding=""utf-8"?>
<MobileAnalytic MAKitVersion="1.1" xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemalLocation="MAKitMetaFile.xsd">

<Dashboard>

<!-- Variable Declaration -->
<Variables>
<Variable Name="$globalpromotion™ DisplayName="1s Global Sales Promotion On?"
VariableType="boolean" Value="0" />
<Variable Name="$regionalsalesdrive™ DisplayName=""Sales Drive in
VariableType="enum"™ Selection="0">

<Choices>
<Choice Display="Eastern" Value="Eastern" />
<Choice Display="Western" Value="Western" />
<Choice Display="Central" Value="Central" />
<Choice Display="South" Value='"South" />
<Choice Display="Canada" Value="Canada" />

</Choices>
</Variable>
</Variables>
<l-- Configure Chart Value Axis with Expression using Variables declared -->
<Chart Name="DAChart" Title="Number Of Sales Orders" ChartType="Column™ Query="OrderCount'>
<Category Format=""" Column="Year" DisplayName="Sales Year'" />
<Series Format=""" Column="Region" DisplayName="Region" />
<I-- Expression. IF Global Sales Promotion is ON, THEN #of Orders is doubled.

ELSE #of Orders is 6 times more in Regional Sales Drive END IF -->

<Values>
<Value Format="Rounded0"
Expression="if($globalpromotion==1,0rderCount * 2,
if(Region==$regionalsalesdrive, OrderCount * 6,0rderCount))"
</Values>
</Chart>

<1-- DAPanel Configuration -->
<DAPanel Name='"SalesDAPanel’ Title="Sales Dynamic Analytic Panel'>
<VariableName Name='"$globalpromotion”™ Sequence="1" />
<VariableName Name=""$regionalsalesdrive” Sequence="2" />
</DAPanel>

</Dashboard>

<DashboardLayout>
<Landscape>
<!-- Dashboard display in Landscape Orientation -->
<Layout Name=" DAChart " Top="0" Left="0" Width="100" Height="70" />
<Layout Name="SalesDAPanel™ Top="71" Left=""0" Width="100" Height="30" />
</Landscape>
<Portrait>
<1-- Dashboard display in Portrait Orientation -->
<Layout Name=" DAChart " Top="0" Left="0" Width="100" Height="70" />
<Layout Name="SalesDAPanel" Top="71" Left=""0" Width="100" Height="30" />
</Portrait>
</DashboardLayout>

</MobileAnalytic>

5. Click File > Save.
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Adding Scripts in ChartQuery and ViewController Classes

Modifying ChartQuery Class

No script is needed in ChartQuery class; we are reusing the OrderCount query.

Adding Script to the MainViewController Class

1.
2.

3.

In the Project Navigator, click the MainViewController.mfile.

Add this code to the ViewDidLoad method with the existing script in the method:

- (void)viewDidLoad
{

//Dynamic Analytic Chart

dict = [[NSMutableDictionary alloc] init];

[dict setObject:@"MAKit Dynamic Analytic Chart" forKey:@"Title"];
[dict setObject:@"DAPanelMetadata' forKey:@'"MetaData'];
[self.viewControllers addObject:dict];

[dict release];

Click File > Save.

Deploying the Application
Deploy the MAKitSample application to the iPad Simulator for testing.

1.

In the Xcode MAKitSample project, verify that the Scheme is set to MAKitSample > iPad 4.3
Simulator, and select Product > Clean.

Select Product > Build.
If you correctly followed all the steps in the tutorial, you see a Build Succeeded message.
Select Product > Run.

The project is rebuilt and iPad Simulator starts and load the application. The initial screen now
contains an “MAKit Dynamic Analytic Chart” row.

4:20 PM

MAK:Iit Tutorial

MAKit Basic Charts >

MAKit Zooming Chart >

MAKit Drilldown Chart >

MAKit Dynamic Analytic Chart >
4. Click MAKit Dynamic Analytic Chart.
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5. Set the Global Sales Promotion switch to ON.

The OrderCount across all regions in all categories is doubled, and the chart redrawn.
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MAKit Tutorial MAKIit Dynamic Analytic Chart
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Lesson 6: Adding What-If Analysis to Charts

What-if analysis is similar to dynamic analytics (DA). Both allow the user to change data behind the chart
and immediately see the chart updated; both map the data to Ul controls on the screen. However,
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dynamic analytics changes the variables defined in expressions, while what-if analysis changes data
retrieved from the datasource.

This lesson describes:

e  Configuring what-if columns in XML metadata
e  How what-if columns are mapped to Ul controls

e  Runtime behavior of what-if analysis

Adding Methods to ChartsDataSource Class
To illustrate what-if analysis, create a new datasource method in ChartsDatasource class and use some
of the datasource columns to configure what-if columns in the metadata.

1. Openthe MAKitSample.xcodeproj in the Xcode IDE if it is not already open.

2. Inthe Project Navigator, click the ChartsDatasource.h file and add these method definitions:

#import <Foundation/Foundation.h>
#import “sqlite3.h"

@interface ChartsDatasource : NSObject {
sqlite3 *dblnstance;

}

//What-1f Chart Datasource methods
- (NSArray *) ProductSales;

3. Click File > Save.

4. Click the ChartDatasource.m file and add the method implementation code:
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#import "ChartsDatasource.h"

@implementation ChartsDatasource

//Whatlf Chart Datasource method
- (NSArray *) ProductSales {

const char * SELECT = "SELECT Region,ProductType]|"-"||ProductName, UnitPrice,sum(sd.Quantity) "
" FROM SalesOrder_Header s, SalesOrder_Details sd, Product p ™
" WHERE s.OrderID = sd.OrderID AND sd.ProductlD = p.ProductiD AND ™
" p.ProductlD < 500 GROUP BY Region,ProductType,UnitPrice";

NSMutableArray *data = [[NSMutableArray alloc] init];
sqlite3_stmt *selectStmt = nil;
if (sqlite3_prepare_v2(dblnstance, SELECT, -1, &selectStmt, NULL)==SQLITE_OK) {

NSString *region=@"";
NSString *product = @"";
float unitprice=0.0;
double qty =0;

while (sglite3_step(selectStmt)==SQLITE_ROW) {
region = [NSString stringWithUTF8String:(char *) sqlite3_column_text(selectStmt, 0)];
product = [NSString stringWithUTF8String: (char *) sqlite3_column_text(selectStmt, 1)];
unitprice = sqlite3_column_double(selectStmt, 2);
qty = sqlite3_column_double(selectStmt, 3);

NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];

[dict setObject:region forKey:@"Region'];

[dict setObject:product forKey:@"Product™];

[dict setObject:[NSNumber numberWithFloat:unitprice] forKey:@"UnitPrice'];
[dict setObject:[NSNumber numberWithDouble:qty] forKey:@"Quantity'];

[data addObject:dict];
[dict release];

3
3
else {
NSLog(@"Failed at Prepare Statement in ProductSales.Reason %s',sqlite3_errmsg(dblnstance));

return data;

@end

5. Click File > Save.

Creating XML Metadata File Configured with What-If Columns

Create a new XML metadata file to configure charts with what-if analysis. In the chart configuration
metadata, add datasource columns in the <WhatlfColumns> .. </WhatlfColumns> tag.
1. Inthe MAKitSample project, click File > New > New File.
2. Select iOS > Other > Empty and click Next.
3. Enter WhatlfChartMetadata.xml in the Save As field and click Save.
This creates the What1fChartMetadata.xml file in the Project Navigator.

4, Click WhatlfChartMetadata.xml and add this content to the file:

49| Page





<?xml version="1.0" encoding=""utf-8"?>
<MobileAnalytic MAKitVersion="1.1" xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemalLocation="MAKitMetaFile.xsd">

<Dashboard>

<!-- Whatlf Chart Configuration -->
<Chart Name="WhatlfChart"™ Title="Product Sales Across Regions" ChartType="Column"
Query="ProductSales'>

<Category Format=""" Column="Region" DisplayName="Region" />
<Series Format=""" Column=""Product" DisplayName="Product" />
<Values>

<Value Format="Currency" Expression="UnitPrice * Int(Quantity)" ValueSequence="1"
DisplayName="Sales Amount" />
</Values>

<!-- What If Columns -->
<WhatlfColumns>
<Column Name="Quantity" DisplayName='""Sales Quantity" VariableType="integer"
Value="200" Min="1" Max="3000" />
<Column Name="UnitPrice" DisplayName=""Unit Price" VariableType="float"
Value="0.0" Min="0.0" Max="50.0" Step="0.5" Decimals="2" />
</WhatlfColumns>

</Chart>
</Dashboard>

<DashboardLayout>
<Landscape>
<!-- Dashboard display in Landscape Orientation -->
<Layout Name=" WhatlfChart" Top="0" Left="0" Width="100" Height="80" />
</Landscape>
<Portrait>
<!-- Dashboard display in Portrait Orientation -->
<Layout Name=" WhatlfChart" Top="0" Left="0" Width="100" Height="85" />
</Portrait>
</DashboardLayout>

</MobileAnalytic>

5. Click File > Save.
Adding Scripts in ChartQuery and ViewController Classes

Modifying the ChartQuery Class
Add code to the ChartQuery class to execute the query method.

1. Inthe Project Navigator, click the ChartsQuery.mfile.

2. Append this code to the executeQuery method with the existing script in the method:
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#import "ChartQuery.h"
#import "ChartsDatasource.h"
#import "ChartDataTable.h™

@implementation ChartQuery

#pragma mark -
#pragma mark MAQueryDelegate method

- (id<MAQueryDataTable>)executeQuery: (NSString*)queryName withArgument:
(NSDictionary*)args {

ChartDataTable *dataTable = [[ChartDataTable alloc] init];

else if ([queryName isEqualToString:@"ProductSales™]) {
ChartsDatasource *cds = [[ChartsDatasource alloc] init];
dataTable.tabularData = [cds ProductSales];
[cds release];

}

return dataTable;

@end

3. Click File > Save.

Adding Script to the MainViewController Class
1. Inthe Project Navigator, click the MainViewController .mfile.

2. Add this code to the ViewDidLoad method with the existing script in the method:

- (void)viewDidLoad
{

//What-1f Analysis Chart

dict = [[NSMutableDictionary alloc] init];

[dict setObject:@"MAKIt What-1f Analysis Chart" forKey:@"Title'"];
[dict setObject:@"WhatlfChartMetadata™ forKey:@'MetaData'];
[self.viewControllers addObject:dict];

[dict release];

3. Click File > Save.

Deploying the Application
Deploy the MAKitSample application to the iPad Simulator for testing.
1. Inthe Xcode MAKitSample project, verify that the Scheme is set to MAKitSample > iPad 4.3
Simulator, and select Product > Clean.
2. Select Product > Build.
If you correctly followed all the steps in the tutorial, you see a Build Succeeded message.

3. Select Product > Run.
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The project is rebuilt and iPad Simulator starts and load the application. The initial screen now
contains an “MAKit What-If Analysis Chart” row.

11:22 AM

MAKIt Tutorial

MAKIit Basic Charts >
MAKit Zooming Chart >
MAKit Drilldown Chart >
MAKit Dynamic Analytic Chart >
MAKit What-If Analysis Chart >

4. Click MAKit What-If Analysis Chart.
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5. Click the arrow image in the upper-right corner to load the chart in full screen.
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6. Tap the category “Western.”

The Western region is selected and the value bubble is updated with values for the Western
region.
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7.  While in full-view mode, tap the W.I toolbar button to see the what-if controls for the columns
specified in the metadata.

' Western
Baseball Cap-Cotton Cap: $2,808.00 | @ Baseball Cap-Wool cap: $2,160.00

25K - -

Canada Central Eastemn South Westem

Sales Quantity 312 = Sales Quantity 216 «_

Unit Price g @ Unit Price 10 @
ee Shirt-Crew Neck

Sales Quantity 288 «&_ ) Sales Quantity 324 &

Unit Price 14 @ Unit Price <)

8. Modify the values in the what-if controls to redraw the chart based on those values.
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Lesson 7: MAKit Chart E-Mail Sharing

E-mail sharing is a built-in feature of all MAKit charts that are configured through metadata; no coding is
required.
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With MAKit e-mail sharing, a chart in its current state (as it appears in a device) is captured as an image
and can be further annotated and sent to the business users or peers whose contacts are stored in the
device.

This lesson describes:

e Invoking the e-mail sharing feature

e Annotating a chart and sending it as an e-mail attachment

Sending a Chart Through E-mail

1. Inthe Xcode MAKitSample project, verify that the Scheme is set to MAKitSample > iPad 4.3
Simulator.

2. Select Product > Run.

The project is rebuilt and iPad Simulator starts and load the application.

11:22 AM

MAKIit Tutorial

MAKit Basic Charts >
MAKit Zooming Chart >
MAKit Drilldown Chart >
MAKit Dynamic Analytic Chart >
MAKit What-If Analysis Chart >

3. Click MAKit What-If Analysis Chart.
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4. Click the arrow image in the upper-right corner to load the chart in full screen.
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Tap the W.I toolbar button, which shows the what-if controls for the columns configured in the
metadata.

Tap the mail image E toolbar button. This captures the current screen image and loads it; the
annotation toolbar appears below the image.
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12:19 PM
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7. Use the annotation toolbar items to annotate the image as shown below:
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8. Tap Send to load the annotated image in a new e-mail message as shown:
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Introduction

The Mobile Analytics Kit (MAKit) code examples demonstrate the core features of MAKit charts, such as
dashboard configuration, applying analytical capability to the charts using the dynamic analytic panels,
chart drilldown and filtering, and semantic zooming. Additionally, all charts have a built-in e-mail sharing
feature, which captures a snapshot image of the chart, and allows the device user to first annotate, then
send the image via the configured e-mail application. MAKit can be used with the Sybase® Unwired
Platform Hybrid Web Container.

Code Examples Setup
Note: These setup instructions are specific to the Xcode 4.0 IDE. For earlier versions of Xcode, the steps
may differ.

1. Copy MAKitCodeExamples.zip to your Mac.
2. Unzip MAKitCodeExamples.zip. This creates a folder called MAKitCodeExamples.

3. Inthe Xcode IDE, double-click MAKitCodeExamples.xcodeproj. You should see a screen similar to:

800

@ (.) | MAKitCodeExamples » iPad 5.0 Simulatc

Run Stop Scheme

|| @ A = =» B
B MAKitCodeExamples
1 target, i05 SDK 5.0

MAKit.bundle
| _|Resources
| | MetaData
| | Database
| | Model Classes
| | Ul Classes
| _|MAKitCodeExamples
|£| MaAKitCodeExamplesAppDelegate.h
@ MaAKitCodeExamplesAppDelegate.m
o MainWindow.xib

+ RootViewController.xib
| | Supporting Files

| | Frameworks

| | Products
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e Classes - contains the application source code for the code examples.
e XIB Files - contains the Interface Builder files used in the code examples.

e Database - contains the SQLite® database MAKitSampleDb.sqgl ite, which is the
datasource for the code examples.

e MetaData — has all the metadata files for each individual feature in the code examples.
All other folders are created by default for any Xcode 4.2 project.
4. Torunthe code example in iPad Simulator, select Product > Run, or click the Run toolbar button.

0% Simulator - iPad [/ i0S 5.0 (9A334)

11:36 AM

MAKit Code Examples

Chart Types Dashboard
Sales Dashboard

Dynamic Analytic Panel

Drilldown Example 1

Drilldown Example 2

Filter Example 1

Filter Example 2

Zooming Chart - Example 1

Zooming Chart - Example 2

What-If Analysis Chart

Column Chart

Drilidown Chart

To run the code example on an Apple iPad, install a valid device-provisioning profile in the Xcode IDE
before deploying to the device.

Code Examples
Basic Dashboards
This section demonstrates the chart types supported by MAKit. You can group related charts together to

create a meaningful dashboard, for example, a sales or stock information dashboard. See the
“Dashboard_ChartTypes.xml” metadata file content to learn how to configure different chart types.
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Configure all charts using the <Dashboard>..</Dashboard> tags.

<Chart Name="ColumnChart'" Title="Region/Product Sales" ChartType="Column" Query="SalesOrder'>
<Category Format=""" Column="Region" DisplayName="Region" />
<Series Format=""" Column="Product" DisplayName="Region" />
<Values>
<Value Format="Currency'" Expression="SalesAmount” ValueSequence="1"
DisplayName="Sales Amount" /> </Values>

</Chart>

<Chart Name='"'BarChart" Title="Salary By Dept/Gender" ChartType="Bar" Query="DeptSalary">
<Category Format=""" Column="Department’ DisplayName="Department" />
<Series Format=""" Column=""Sex" DisplayName=""Gender" />
<Values>

<Value Format="Rounded2" Expression="'Salary" ValueSequence="1" DisplayName="Salary" />
</Values>
</Chart>

<Chart Name='"LineChart" Title="Number Of Sales Orders" ChartType="Line" Query="NumberOfOrders'>
<Category Format=""" Column="Year" DisplayName="Year" />
<Series Format=""" Column=""Region" DisplayName="Region" />
<Values>
<Value Format="Rounded0" Expression="0rderCount” ValueSequence="1"
DisplayName=""Number Of Orders" />
</Values>
</Chart>

<Chart Name="PieChart" Title="Printer Sales" ChartType="Pie" Query="PrinterSales">
<Category Format=""" Column="SalesRep'" DisplayName="Sales Rep" />
<Series Format=""" Column=""Product" DisplayName="Type" />
<Values>
<Value Format=""Currency" Expression="Sales'" ValueSequence="1" DisplayName="Sales Amount " />
</Values>
</Chart>

<Chart Name="'BubbleChart" Title="US Crime Data" ChartType="Bubble" Query="CrimeData'>
<Category Format=""" Column="'State" DisplayName="State" />
<Series Format=""" Column=""CrimeType" DisplayName=""CrimeType" />
<Values>
<Value Format="Rounded2" Expression='"'Ratio'" ValueSequence="1" DisplayName="Crime Ratio" />
<Value Format="Rounded2" Expression='"Ratio'" ValueSequence='2" DisplayName='"Crime Ratio" />
</Values>
</Chart>

The metadata file also configures the dashboard layouts for either portrait or landscape mode.

<DashboardLayout>
<Landscape>
<Layout Name="ColumnChart" Top="1" Left="1" Width="49" Height="32" />
<Layout Name='"BarChart" Top="1" Left="51" Width="48" Height="32" />
<Layout Name="LineChart" Top='"34" Left="1" Width="49" Height="'32" />
<Layout Name="PieChart'" Top='"34" Left="51" Width=""48" Height="32" />
<Layout Name="‘BubbleChart"™ Top="'67" Left="1" Width="98" Height="32" />
</Landscape>
<Portrait>
<Layout Name="‘ColumnChart" Top="'1" Left="1" Width="49" Height="32" />
<Layout Name="BarChart" Top="1" Left="51" Width=""48" Height="32" />
<Layout Name="LineChart" Top="34" Left="1" Width=""49" Height="32" />
<Layout Name="PieChart'" Top='"'34" Left="51" Width=""48" Height="'32" />
<Layout Name="BubbleChart" Top="67" Left="1" Width=""98" Height="32" />
</Portrait>
</DashboardLayout>
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This dashboard layout configuration renders a chart similar to:
r
Carrier = 1:29 PM

MAKIt Code Examples Chart Types Dashboard

Region/Product Sales ¢ Salary By Dept/Gender

Region: Canada, Sales Amount: Department  Salary

417800.00 -

nirroc.oo [N

Baseball Cap: $13,369 | [ Shoris: 515,267

i

Mumber Of Sales Orders Printer Sales

Year: 2003, Number Of Orders:

% Canada:8 | @ Central: 239 [ Eastern: 29 B Stellar: 32.2%

e
y
o \/"-

w

US Crime Data

State: Alabama

7 Aggravated_Assault: Crime Ratio: 247.80 Crime Ratio: 247.80 | @ Burglary: Crime Ratio: 953.80 @
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Dynamic Analytic Panel

This section demonstrates the dynamic analytic capabilities of MAKit. Dynamic analytics is a powerful
feature that lets you interactively visualize reports by changing some parameters at runtime, and
refreshing the charts based on the new values.

The heart of dynamic analytics is the variable definition in the metadata, which constructs the value axis
expressions using the variables. When the device user changes the variable value runtime, MAKit
evaluates the value axis expression, and refreshes the charts based on the new value.

Define variables in the metadata using the <variables>...</Variables> tags, and group them in the
DAPanel metadata using the <DAPanel>....</DAPanel> tags. Configure the DAPanel using a dashboard
layout that is similar to that used for configuring charts.

MAKit automatically generates Ul controls to manipulate the values of these variables:

\ Variable Type User Interface Generated by MAKit
integer Slider control
float PickerView control
boolean Switch control
enum PickerView control
datetime Date Picker control
<Variables>

<Variable Name="$salesdrive" DisplayName='""Sales Promotion ?'" VariableType="boolean" Value="0" />

<Variable Name="$region" DisplayName="Sales Promotion in " VariableType="enum"™ Selection="0">
<Choices>
<Choice Display="Eastern" Value="Eastern" />
<Choice Display="Western" Value="Western" />
<Choice Display="Central" Value="Central™ />
<Choice Display="South" Value='"South" />
<Choice Display="Canada" Value="Canada" />
</Choices>
</Variable>
<Variable Name="$dept" DisplayName="Pay Raise Department " VariableType="enum" Selection="0">
<Choices>
<Choice Display="R &amp; D" Value="R &amp; D" />
<Choice Display="Sales" Value="Sales" />
<Choice Display="Finance" Value="Finance" />
<Choice Display="Marketing" Value="Marketing" />
<Choice Display="Shipping" Value="Shipping" />
</Choices>
</Variable>
<Variable Name="$hike"™ DisplayName="Pay Raise % " VariableType="float" Value="0" Min="0"
Max="18" Decimals="1" />
</Variables>

The variables defined in the metadata are used in value expressions of chart configuration as shown here:
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<Chart Name="ProductSales" Title=""Region/Product Sales" ChartType="Column" Query="SalesOrde
<Category Format=""" Column=""Region" DisplayName=""Region" />
<Series Format=""" Column="Product" DisplayName="Product" />
<Values>

<Value Format="Currency" Expression="if($salesdrive==1,SalesAmount+(SalesAmount *
0.30), if(Region==%region, SalesAmount+(SalesAmount * 0.80),Sale
ValueSequence="1" DisplayName=""Sales Amount" />
</Values>
</Chart>

<Chart Name='"Orders" Title="Number Of Sales Orders"™ ChartType="Line" Query="NumberOfOrders"
<Category Format=""" Column="Year" DisplayName="Year" />
<Series Format=""" Column="Region" DisplayName="Region" />
<Values>
<Value Format="RoundedO" Expression="if($salesdrive==1,0rderCount * 2,
if(Region==$region, OrderCount * 6,0rderCount))" ValueSequence="1"
DisplayName="Number Of Orders" />
</Values>
</Chart>

<Chart Name='"'PayRaise" Title="Department Salary" ChartType="Bar" Query="DeptSalary'>
<Category Format=""" Column="Department" DisplayName=""Department" />
<Series Format=""" Column=""Sex" DisplayName=""Gender" />
<Values>
<Value Format="Rounded2" Expression=""if(Department==$dept, (Salary + Salary *

($hike/100)),Salary)" ValueSequence="1" DisplayName=""Salary"

</Values>
</Chart>

r>

sAmount))"

>

<DAPanel Name="SalesDA™ Title="Sales Dynamic Analytic Panel'>
<VariableName Name="$salesdrive’™ Sequence="1" />
<VariableName Name='"$region" Sequence='2" />

</DAPanel>

<DAPanel Name="EmpDA"™ Title="Salary Dynamic Analytic Panel">
<VariableName Name="'$dept' Sequence="1" />
<VariableName Name="$hike" Sequence='2" />

</DAPanel>

<DashboardLayout>

<Landscape>
<Layout Name="ProductSales"™ Top="1" Left="1" Width="49" Height="35" />
<Layout Name="Orders" Top="1" Left="51" Width="48" Height="35" />
<Layout Name="SalesDA"™ Top="37" Left="1" Width=""98" Height='"20" />
<Layout Name='"PayRaise" Top="60" Left="1" Width="53" Height="35" />
<Layout Name="EmpDA"™ Top="60" Left="55" Width="44" Height="35" />

</Landscape>

<Portrait>
<Layout Name="ProductSales'" Top="1" Left="1" Width="49" Height="35" />
<Layout Name="Orders" Top="1" Left="51" Width="48" Height="35" />
<Layout Name="SalesDA"™ Top="37" Left="1" Width=""98" Height=""18" />
<Layout Name="‘PayRaise" Top="57" Left="1" Width="53" Height="40" />
<Layout Name="EmpDA"™ Top="57" Left="55" Width="44" Height="40" />

</Portrait>

</DashboardLayout>
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The Dynamic Analytic panel renders in the dashboard in the same manner as individual chart items. When
variable values are changed, relevant charts are refreshed based on the expression evaluation.

Carrler = 1:45 PM

MAKIt Code Examples Dynamic Analytic Panel

Region/Product Sales . Mumber Of Sales Orders
Region: Canada, Sales Amount: Year: 2003, Number Of Orders:

" Baseball Cap: $13,369 | @ Shorts: 515,267 | " Canada:3 | @ Central: 20 | @ Eastern: 29

.;L.ILLiLI.i. -

Sales Dynamic Analylic Panal

Department Salary Salary Dynamci Analytic Panel

17700.00
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The Dynamic Analytic panel appears when the chart is in full-view mode:

3:07 PM

Number Of Sales Orders

Year: 2003, Number Of Orders:

‘ o Canada:8 | Central:29 [ Eastern: 29 | [ Sou

ha

=7

=1
'

150 -

Sales Promotion 7
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This figure shows the refreshed chart based on a new variable value (“Eastern”):

3:08 PM

Number Of Sales Orders

Year: 2003, Number Of Orders:

Canada: 8 @ Central: 29 | Eastern: 174 @ South: 12 & Western: 5

BOO -

200 -

Eastern
Western

100

‘ Sales Promofion 7 | OFF | lsales promotionin  Eastern

Drilldown Charts
MAKit lets you drill down by category or by series, or both, on a single chart. You can define any level of
drilldown chart in the metadata definition.

You can drill down only when the chart is in full-view mode, by double-tapping the chart (drilldown by
category) or by double-tapping either the category value or the series value in the data grid table of the
chart.

Configure the drilldown charts using <Dril1DownGroup>...</Dri Il lIDownGroup> tags; configure individual
charts at each level using <Chart> ... </Chart> tags.

See the “Drilldown_Sales.xml” and “Drilldown_Energy.xml” metadata files in the code example to see
drilldown configurations.
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<DrillDownGroup Name="Reseller" Title="Reseller Drilldown Charts">
<Chart Name="ResellerSales" Title="Reseller Sales Summary " ChartType="Bar" ChartSequence=""1"
Query="Resel lerSummary" >
Column="Region" DisplayName="Sales Region" />
Column=""ProductCategory' DisplayName="ProductCategory" />

<Category Format=
<Series Format="""
<Values>
<Value Format="Currency' Expression="SalesAmount” ValueSequence=""1"
DisplayName="Sales Amount in US Dollars" />
</Values>
</Chart>
<Chart Name='"'SalesByCountry" Title=""Reseller Sales By Country" ChartType="Bar" ChartSequence="2"
Query="ResellerByCountry" >
"' Column=""Country" DisplayName=""Country" />
Column=""ProductCategory" DisplayName="Product Category" />

<Category Forma
<Series Format=

<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1"
DisplayName="Sales Amount in US Dollars" />

</Values>
</Chart>
<Chart Name='"SalesByCategory'" Title=""Sales By Product Category " ChartType="Bar' ChartSequence="3"
Query="Resel lerByCategory'>
Column=""ProductSubCategory" DisplayName="Product Sub Category" />
Column=""Country" DisplayName="Country" />

<Category Format=
<Series Format=""
<Values>
<Value Format="Currency" Expression="SalesAmount” ValueSequence="1"
DisplayName=""Sales Amount in US Dollars" />
</Values>
</Chart>
</DrilIDownGroup>
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The Drilldown chart renders similarly to other charts configured in the dashboard layout:

' \

Carrler = 1:52 PM 100 % [

MAKIt Code Examples Drilldown Example 1

Reseller Sales Summary

Online Sales Drive

Driver For Sales: Manufaciurer, Sales Amount in US Dollars:

" Europe: 51,207,251 | Morth America: $2,767,663 | I Pacific: $2,023,208
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Drilldown chart in full-view mode:

3:09 PM

Reseller Sales Summary

Sales Reglon Sales Amount in US Dollars 0 10M 20M 30M 40M 50M 60M
| | | | | |

$5,531,144

510,977,163
Europe

$10,855,859

526,589,696

$18,662,273

$56,469,132

North America

$22,662,153

548,392,837

$12,641,135

$15,881,877

Pacific

$12,848,150

$8,044,825 ]

ikes [ Clothin
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Drilldown by category (double-tap “Europe” in the bar chart):

iPad = 3:09 PM
Reseller Sales Summary Reseller Sales By Country
Europe 8¢ ™
Country Sales Amount in US Deollars 0 2M 4M &M 8M 10M 12M 14M
$4,593,259 i )
France (i S
$4,365,383 il

$12,078,586

§1,543,655 -]

$1,990,490

$2,440,790 __7-]

54,636,825 |

$4,393,414

Germany

United Kingdom

54,049,685

59,874,286 ]

Drill down by series (double-tap ”Bikes” in the table):

Carrier = 2:11 PM

Reseller Sales By Country Sales By Product Category

Europe > France, Bikes

Product Sub Category ~ Sales Amount in US Dollars M 2M aM aM 5M
Bib-Shorts 5366,665 | | | |

Bike Racks 5942771

Bottles and Cages 28,779
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Dashboard Filters

MAKit dashboard filters let you filter chart data using query arguments. Filters are global in nature and
affect all charts associated with that filter. Data that does not fulfill the range or criteria specified is
filtered out.

Filters are initially defined in the metadata using <Dashboard> ...</Dashboard> tags, and individual charts
configured in the metadata can apply previously defined filters.

There are two types of filter: a range filter lets you specify an integer range, and a picklist filter lets you
select discrete sets of data criteria.

<I!-- Filter Definition in Dashboard -->
<Filters>
Column=""ProductCategory" />
<Filter Name="Region" Sequence="2" SourceQuery="ResellerQry" FilterType="picklist" Column="Region" />
<Filter Name="Sales Reason" Sequence="3" SourceQuery="OnlineSalesQry" FilterType="picklist"
Column=""SalesReason" /
</Filters>

<I-- Configuring Charts with Filters -->

<Chart Name="ResellerSales" Title="Reseller Sales By Product”™ ChartType="Column" Query="ResellerQry">
<Category Format=""" Column="ProductCategory" DisplayName="Product Category" />

<Series Format=""" Column=""Region" DisplayName="Sales Region"/>
<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName=" " />
</Values>
<Filters>

<FilterName Name="Products" />
<FilterName Name="Region" />
</Filters>

</Chart>
<Chart Name="OnlineSales'" Title="Online Sales Drive" ChartType="StackedColumn" Query="OnlineSalesQry">
<Category Format=""" Column="SalesReason'" DisplayName="Sales Reason" />
<Series Format=""" Column="Region'" DisplayName="Sales Region'/>
<Values>
<Value Format="'Currency" Expression="'SalesAmount' ValueSequence="1" DisplayName=""" />
</Values>
<Filters>

<FilterName Name=''Sales Reason" />
<FilterName Name="Region" />
</Filters>
</Chart>

Dashboard filters work only in the dashboard view; they are unavailable full-view mode.
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The filters defined on the dashboard appear in the top row:

Carrier = 2:15 PM

MAKIt Code Examples Filter Example 1

‘Products | Region | Sales Reason

Reseller Sales By Product

Product Category: Accessories, Sales Amount in Local Currency:
Europe: 55,531,144 [ North America: $18,552,273 | @ Pacific: $12,641,135

Online Sales Drive

Sales Reason: Manufaciurer, Sales Amount in Local Currency:

" Europe: 1,207,251 [ MNorth America: 52,767,663 [ Pacific: $2,023,208
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Picklist filter:

Carrier = 218 PM

MAKt Code Examples Filter Example 1

Products | Region | Sales Reason '

cancel  ProductCategory

Sales By Product

igories, Sales Amount in Local Currency:
Accessories

th America: §18,552,273 | W Pacific: $12,641,135
Bikes
Clothing

Components

Online Sales Drive

Sales Reason: Manufacturer, Sales Amount in Local Currency:

" Europe: 51,207,251 [ MNorth Amerlca: 52,767,663 | [ Pacific: 2,023,208
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Result of filters applied:

Carrier = F PM

MAKIt Code Examples Filter Example 1

‘Products: 3 | Region | Sales Reason

Reseller Sales By Product

Product Category: Accessories, Sales Amount in Local Currency:

Europe: $5,531,144 | [ North America: 518,552,273 [ Pacific: $12,641,135

Zooming Charts
Semantic zooming lets users view a large data set in different scales. Users can see an overview of a large
chart by zooming out, or see every detail by zooming in.

Configure zooming charts, and the behavior of a chart at each zooming level, in the metadata
configuration file.

Like drilldown charts, zooming can be performed only in full-view mode, via hierarchy buttons.
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<Chart Name="ZoomingChart"™ Title="Sales By Product Category" ChartType="Column'>
<Category Format=""" DisplayName=""" />
<Values>
<Value Format="Rounded2" Expression=""SalesAmount" ValueSequence="1" DisplayName="Sales Amount" />
</Values>
<ZoomingLevels>
<ZoomingLevel Query="SalesByCategory" CategoryColumn="ProductCategory"
Title="ProductCategory" />
<ZoomingLevel Query="SalesBySubCategory" CategoryColumn="SubCategory"
Title="ProductSubCategory" />
<ZoomingLevel Query="SalesBySubCategoryAndYear'™ CategoryColumn='"Year"™ Title="Year" />
</ZoomingLevels>
</Chart>

Chart at ZoomLevel=1:

3:11 PM

Sales By Product Category

ProductCategory ProductSubCategory

‘ ProductCategory: A ies, Sales Amount: ‘

= 67445112.00

160M -

120M -

BOM -

G6OM -

20M -

Accessories Bikes Components
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Chart at ZoomLevel=2:

3:11 PM

s By Product Catec

ProductCategory ProductSubCategory

‘ ProductCategory: Accessories, ProductSubCategory: Bike Racks, Sales Amount: ‘

|
1726342.25 |

7OM -

GOM -

50M -

40M -

20M -

| - =

Bikes Components
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Chart at ZoomLevel=3:

3:11 PM

s By Product Category

ProductCategory ProductSubCategory

ProductCategory: Accessories, ProductSubCategory: Bike Racks, Year: 2003, Sales Amount:

986353.94

E0M -

|
- G,,—----,-,--,--,-'-:f---,--,----“ el iiiiaeﬁf.,r.--r...'-,.r.-...'._..r-Di-..::-)i.,-:-- |

What-If Analysis

What-if analysis is similar to dynamic analytics. Both allow the user to change data behind the chart and
immediately see the chart updated; both map the data to Ul controls on the screen. However, dynamic

analytics changes the variables defined in expressions, while what-if analysis changes data retrieved from
the datasource.

Configure what-if analysis in the metadata, using what-if columns, which are used in value expressions in
the chart configuration.

Configure what-if columns using <WhatlfColumns>..</WhatlfColumns> tags.
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Example of What-If Analysis Configuration

<Chart Name="WhatlfChart" Title="Net Income From Sales" ChartType="Line" Query="ProductSales">
<Category Format=""" Column="'Region’ DisplayName="Region" />
<Series Format=""" Column="Product” DisplayName="Product" />
<Values>
<Value Format="Currency" Expression="((UnitPrice * Quantity) - ((Cost_Of Revenue * Quantity) +
(RD_Cost * Quantity) + (Mkt_Cost * Quantity) + (Admin_Cost * Quantity)))"
ValueSequence="1" DisplayName="Net Income" />
</Values>
<l-- What If Columns -->
<WhatlfColumns>
<Column Name="UnitPrice'" DisplayName="Unit Price" VariableType="float"” Min="1.0" Max="110.0"
Step="'1.0" Decimals="2" />
<Column Name="Cost_Of_Revenue'" DisplayName="Cost Of Revenue'" VariableType="integer"” Min="1"
Max="40" />
<Column Name="RD_Cost'" DisplayName="R &amp; D Cost" VariableType="integer" Min="1" Max='"18" />
<Column Name="Mkt_Cost" DisplayName="Marketing Cost" VariableType="float" Min="1.0" Max='"10.0"
Step=""1.0" Decimals="2" />
</WhatlfColumns>
</Chart>

What-if analysis works only in full-view mode, rendering a Ul control for each what-if column in the
metadata.

e
To see what-if analysis behavior, select a category and tap the What-if button in the toolbar. Tap
the button again to close the what-if panel. When the what-if panel is open, changing the values in a
what-if column immediately updates the chart for the selected category.
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Chart in full-view mode before invoking the what-if panel:

iPad = 3:12 PM

Done Net Income From Sales

Region: Canada, Net Income:

© Baseball Cap-Cotton Cap: $3,699 | [ Tee Shirt-Crew Neck: $11,655 [ Tee Shirt-Tank Top: 53,523

45K -

30K -

ra

th

=
1

Canada Central Eastern South Westamn
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"
Tap the What-if button to invoke the what-if panel for the selected category (“Central” region):

3:12 PM

Net Income From Sales

Region: Central, Net Income: |

. Baseball Cap-Cotton Cap: $17,088 [ Tee Shirt-Crew Neck: $37,727 | @ Tee Shirt-Tank Top: 510,188

45K -

40K -

Canada Cantral Eastern South Westarn

Baseball Cap-Cotton Cap e

Unit Price 38 @ Unit Price 66 @

Cost Of Revenue 14 e ——— (Cost Of Revenue 24 o—T
R & D Cost 4 e T R&DCost 8 e

Marketing Cost 3 O Marketing Cost 6 G

Unit Price 38 @

Cost Of Revenue 14 e
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Changing the values in a what-if column updates the chart accordingly:

3:13 PM

Net Income From Sales

Region: Central, Net Income: |

.~ Baseball Cap-Cotton Cap: $36,131 | [ Tee Shirt-Crew Neck: $37,727 | [ Tee Shirt-Tank Top: 510,188 |

45K -
40K -
35K -
30K -
25K -
20K -
15K -
10K -
5K -
o
Canada Central Eastern South Westermn
e
Unit Price 38 @ Unit Price 66 @
Cost Of Revenue 3  m——— Cost Of Revenue 24 e
R & D Cost 2 . > RA&DCost 8 e
Marketing Cost 1 O Marketing Cost B O

Unit Price 38 @

Cost Of Revenue 14 o
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MAAnalyticChartView

Use the MAAnalyticChartView class to create a single-chart view using metadata definitions. Drilldown,
semantic zooming, and what-if analysis are all available in the single-chart view.

The metadata definition is the same as that used to create dashboard view, but only the first chart in the
metadata is used. Dashboard layout configurations defined in the metadata are not applicable.

<MobileAnalytic >
<Dashboard>
<!-- Whatlf Chart Configuration -->
<Chart Name="WhatlfChart" Title="Net Income From Sales'" ChartType="Line" Query="ProductSales">

<Category Format=""" Column=""Region" Description="Region" />
<Series Format=""" Column="Product" Description="Product" />
<Values>

<Value Format="Currency" Expression="((UnitPrice * Quantity) - ((Cost_Of_Revenue *
Quantity) + (RD_Cost * Quantity) + (Mkt_Cost * Quantity) + (Admin_Cost * Quantity)))"

ValueSequence=""1" Description="Net Income" />
</Values>
<l-- What If Columns -->
<WhatlfColumns>
<Column Name="UnitPrice" Description="Unit Price" VariableType="float" Value="0.0"
Min="1.0" Max="110.0" Step="1.0" Decimals="2" />
<Column Name="Cost_Of_Revenue' Description="Cost Of Revenue" VariableType="integer"
Value="0" Min="1" Max="40" />
<Column Name="RD_Cost'" Description="R &amp; D Cost" VariableType="Integer" Value="0"
Min="1" Max="18" />
<Column Name=""Mkt_Cost" Description="Marketing Cost" VariableType="float" Value="0.0"
Min="1.0" Max="10.0" Step="1.0" Decimals="2" />
</WhatIfColumns>
</Chart>

</Dashboard>
</MobileAnalytic>

Sales Year: 2004, Sales Amount in US Dollars:

12M -

aM -

2M -

2001 2002

K
=]
=1

i}
ra
=}
=}

E
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Influence Diagram

An influence diagram is a graphical representation of a decision problem, offering a way to
identify and display essential elements, including decisions, uncertainties, and objectives, and
how they influence each other.

An influence diagram comprises one default node, and multiple primary nodes and secondary or
satellite nodes. Primary nodes directly impact the default node. Each primary node may have
multiple associated secondary or satellite nodes. The default mode and all primary nodes are
always visible in the model.

Each node in the model shows the measure name, and the current actual value or percentage
text.

MAKit influence diagrams include three views: snapshot view, full-screen view in normal mode,
and full-screen view in goal-seek mode. It also supports associated charts for some nodes. In
full-screen view in goal-seek mode, you can show the cause and effect relationships between
nodes as they are defined in the expression attribution of the metadata. You can change the
actual value of a node using the keyboard, or by holding and dragging the handle of a node.

Set the cause and effect relationship between the nodes, and associated charts in metadata.

<?xml version="1.0" encoding=""utf-8"?>
<Diagram Name="EVA-Value-Driver" Query="EVAQuery'>
<Node Name="EVA" Text="EVA" Format="'Rounded2" Expression="OperatingProfitl-CostofCaptial™
Default="true"/>
<Node Name="OperatingProfitl"” Text="Operating Profit" ParentNode="EVA"
Expression="RONA*NetAssetsl"” Format="Rounded0" Charts="chartl,chart2">
<NodeTo Name="EVA"/>
</Node>
<Node Name='"CostofCaptial’ Text="Cost of Captial' ParentNode="EVA"
Expression="NetAssets1*WACC" Format="Rounded2'" Charts="chartl'>
<NodeTo Name="EVA"/>
</Node>
<Node Name="RONA"™ Text=""RONA" ParentNode="'OperatingProfitl"
Expression="ProfitMargin*NetAssetTurnover" Format="Percentage' Charts="chart2'">
<NodeTo Name="OperatingProfitl"/>
</Node>
<Node Name="NetAssetsl" Text=""Net Assets" ParentNode="OperatingProfitl,CostofCaptial™
Format="Rounded0"">
<NodeTo Name="‘OperatingProfitl'/>
<NodeTo Name="CostofCaptial'/>
</Node>
<Node Name="WACC" Text="WACC" ParentNode='"'CostofCaptial’ Format="Percentage'>
<NodeTo Name='"CostofCaptial'/>
</Node>
<Node Name="ProfitMargin" Text="Profit Margin" ParentNode="RONA"
Expression="0OperatingProfit2/Salesl” Format="Percentage'>
<NodeTo Name="RONA"/>
</Node>
<Node Name="'NetAssetTurnover™ Text="Total Net Asset Turnover' ParentNode="RONA"
Expression="Salesl/NetAssets2" Format="Rounded2'>
<NodeTo Name="RONA"/>
</Node>
<Node Name="OperatingProfit2" Text="Operating Profit" ParentNode="ProfitMargin®
Expression="EBIT*IncomeTax" Format="Rounded0'>
<NodeTo Name="ProfitMargin'/>
</Node>
<Node Name="Salesl" Text="Sales" ParentNode="ProfitMargin,NetAssetTurnover"
Format=""Rounded0'*>
<NodeTo Name="‘ProfitMargin’/>
<NodeTo Name="NetAssetTurnover'/>
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</Node>
<Node Name="'NetAssets2" Text="'Net Assets" ParentNode="'NetAssetTurnover"
Expression=""Assets-Liabilities" Format="Rounded0">
<NodeTo Name="NetAssetTurnover'/>
</Node>
<Node Name="EBIT" Text="EBIT" ParentNode="OperatingProfit2" Expression="Contribution-
Overhead" Format="'Rounded0O'>
<NodeTo Name="‘OperatingProfit2"/>
</Node>
<Node Name="IncomeTax" Text="(1-Rate of Income Tax)" ParentNode="OperatingProfit2"
Format="Rounded2">
<NodeTo Name="OperatingProfit2'"/>
</Node>
<Node Name="Assets" Text="Assets" ParentNode="'NetAssets2"
Expression="FixedAssets+CurrentAssets" Format="Rounded0O'>
<NodeTo Name="NetAssets2"/>
</Node>
<Node Name="Liabilities" Text="Interest Free Liabilities" ParentNode="NetAssets2"
Format="Rounded0"">
<NodeTo Name="‘NetAssets2'/>
</Node>
<Node Name='"Contribution" Text="Contribution” ParentNode="EBIT" Expression="Sales2-
GoodsSold" Format="Rounded0'>
<NodeTo Name="EBIT"/>
</Node>
<Node Name="Overhead" Text="Overhead" ParentNode="EBIT" Format="Rounded0'>
<NodeTo Name="EBIT"/>
</Node>
<Node Name="'FixedAssets" Text="Fixed Assets' ParentNode="Assets" Format="RoundedO'>
<NodeTo Name="‘Assets"/>
</Node>
<Node Name='"CurrentAssets" Text=""Current Assets' ParentNode="Assets" Format=""Rounded0'>
<NodeTo Name="‘Assets"/>
</Node>
<Node Name="Sales2" Text="Sales' ParentNode="Contribution”™ Format="Rounded0'>
<NodeTo Name="‘Contribution"/>
</Node>
<Node Name="GoodsSold" Text="Variable Cost of Goods Sold" ParentNode="Contribution"
Format="Rounded0">
<NodeTo Name="Contribution"/>
</Node>
</Diagram>
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Snapshot view:
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Full-screen view in goal-seek mode:

@ Operating Profit
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Predictive Analysis and Threshold Reference

Predictive analysis shows forecasted or projected data points using a dashed-line pattern.
Threshold values highlight values that fall outside of a specified range; for example, you can
assign a reference value, which appears on the y-axis, to highlight some benchmark value.

Predictive analysis and threshold references are supported only in line charts. Configure the
required parameters for predictive analysis and threshold reference with the corresponding
values.

Configure these variables for threshold reference and predictive analysis:

e referenceValue
e upperThreshold
e |owerThreshold

e predictiveStartCategory

// This is for Predictive Analysis and Threshold Reference

else if ([queryName isEqualToString:@"SalesOrder_Pred"]) {
SgliteDataSource *s1 = [[SgliteDataSource alloc] init];
table.chartData = [sl1 SalesOrderSummary];

table.referencevalue
table.upperThreshold
table. lowerThreshold

[LINSNumber alloc]initWithDouble:100000]autorelease];
LLINSNumber alloc]initWithDouble:150000]autorelease];
[LINSNumber alloc]initWithDouble:50000]autorelease];

table.predictiveStartCategory = @"Eastern;

[sl release];

}

// This is for Predictive Analysis
else if ([queryName isEqualToString:@" NumberOfOrders_Pred"]) {
SgliteDataSource *sl1 = [[SgliteDataSource alloc] init];
table.chartData = [s1 NumberOfOrdersByYear];
[s1 release];

table.referencevalue
table.upperThreshold
table. lowerThreshold

[LINSNumber alloc]initWithDouble:80]Jautorelease];
LLINSNumber alloc]initWithDouble:120]autorelease];
[LINSNumber alloc]initWithDouble:40]Jautorelease];
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This example shows a line chart with a threshold reference. Threshold references highlight the
benchmark values and the values that comprise the upper and lower thresholds. Benchmark
values use a dotted blue horizontal line, whereas the upper and lower threshold values are
shaded with reference to the y-axis.

Year: 2003, Number Of Orders :

7 Canada: & | @ Central: 29 @ Eastern: 29 | @ South: 12 | @ Western: 5

140 -

i00 -

o

Of Orders

Numbar

60 -

40

2003 2004 2005 2006
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In this example, a line chart that shows predictive analysis and a threshold reference, the
predictive line begins at the “Eastern” category, which is also shown in the example metadata:

Region: Canada, Sales Amount :

" Baseball Cap: 513,369 | [ Shorts: 515,267 [ Sweatshirt: $52,727 | @ Tee Shirt: $39,175 | [ Visor: $8,73
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Introduction

The MAKit Developer Guide: iOS is to help developers quickly understand Mobile Analytics Kit (MAKit)
concepts, and expedite application development. MAKit, which lets users graphically view data and
modify chart values to examine “what-if” scenarios, is distributed as a static library on the iPhone/iPad.
MAKit can be used with the Sybase® Unwired Platform Hybrid Web Container.

Other visualization packages typically require you to upload your data to a server. MAKit is datasource-
independent, providing easy-to-use APls that allow application developers to retrieve data from Web

services, Sybase Unwired Platform, CSV files, or local SQLite® databases.

A large component of MAKit is its charting abilities. There are currently six main chart types—column,
stacked column, bar, line, bubble and pie, as shown below.

Region: Canada, Sales Amount: Department  Salary

0 800K  1.6M
T Daseball Cap: $13.369 W Shants: §15,26 B |
417800.00
00K - = = Finance
1 | | B L
i L ¢ P 1 B 117700.00 [
o | I ” 1 1 335679.00
Year: 2003, Number Of Orders: State: Alabama
Canada: 8 M Central: 29 @ Eastern 7 Aggravated Assault: Crime Ratio: 247 4 [ | Stellar: 32.2%

o ——— U inlheten SRty BN
& e.._.#-——-‘——h—,_o o .
Another major component of MAKit is the influence diagram.

Architecture

This figure shows the MAKit modules. UI/Presentation includes the Ul with its Views and Controller, and
is typically the module applications use the most. The Analytics module processes on-device analytics,
and Query Interface provides a standard way to feed data into MAK:it.
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ﬂvice Application \

MAKit

Ul / Presentation

High-Level
APIs

Analytics

Low-Level
APls

Query Interface

\- /

High-level APIs offer rich features and ease of use, whereas low-level APIs offer more flexibility and
customization options.

See Appendix: API Reference on page 89 for more information about the APIs.

MAK:Iit iOS Charting API

When using MAKit for the first time, the developer must first decide which API to use. Charting APIs are
categorized into two levels:

APl Level Scope Coding Flexibility

High Packaged components (for example, MAView and Less Low
MAAnalyticChartView)

Low Core components (for example, MAChartView and More High
MADashboardView)

Developers can choose a suitable API level based on the functions and flexibility required.

High-level APIs are packaged components that provide predefined functionalities customizable by
metadata. High-level APIs are suitable for tabular data that must be represented visually in different
formats on the mobile device. The high-level APIs are also suitable for data retrieved by query
mechanisms, such as database servers.
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Minimal coding is required for applications using high-level APls, as complex functionalities are already

provi
[ ]
[ ]
[ )
[ ]

ded. The functionalities provided by high-level APIs include:
Semantic zooming (hierarchical categories)
Drilldown
Filters
Dynamic analytics

What-if analysis

Low-level APIs are basic, independent, and comprehensive, offering highly customizable application

build
requi

ing blocks. High flexibility of low-level APIs comes at a cost to the developer as more coding is
red. If you do not require complex analytics and navigation, Sybase recommends using high-level

APIs to save development effort.

High-Level APIs—Packaged Components

High-level APls comprise these components:

Metadata file

Datasource — MAQueryDelegate and MAQueryDataTable

View — MAView Oor MAAnalyticChartView

Delegate — MAviewDelegate Or MAAnalyticChartViewDelegate

Theme — MAChartTheme and MADashboardTheme

MAViewDelegate J MADashboardTheme J

r U

Metadata File ‘

MAQueryDelegate Jﬂ'/ MAView
MAQueryDataTable J_E'/'

MAAnalyticChartViewDelegate J MAChartTheme J

r U

Metadata File “

MAQueryDelegate Jﬂ'/ MAAnalyticChartView

MAQueryDataTable 1'5,/'
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MAView and MAAnalyticChartView are view components, whereas the datasource is made up of the
metadata file, MAQueryDelegate, and MAQueryDataTable. The application can be notified of events via
MAViewDelegate and MAAnalyticChartViewDelegate. Customize colors and fonts using MADashboardTheme
and MAChartTheme.

Query Generation Tool

MAKit includes a Java tool, MAGen, that parses the metadata file and generates the code skeleton of
classes that adopt the MAQueryDelegate and MAQueryDataTable protocols.

To use MAGen:
e Install the latest JRE, if necessary.
e Add MAGen.jar to the class path.

e From a command line, run:

java com.sybase.mobileanalytic.MAGen metadata_path output_path [query_name] [datatable_name]

Argument Description
metadata_path Full path of the metadata file
output_path Output directory
query_name (optional) Name of the generated class that adopts the MAQueryDelegate

protocol. The default is MyQuery.

datatable_name (optional) Name of the generated class that adopts the MAQueryDataTable
protocol. The default is MyDpataTable. You must specify query name
before you can specify datatable_name.

Here are some examples:

java com.sybase.mobileanalytic.MAGen d:\MAKit\comb.xml d:\MAKit\out\
java com.sybase.mobileanalytic.MAGen d:\MAKit\comb.xml d:\MAKit\out\ MAQuery
java com.sybase.mobileanalytic.MAGen d:\MAKit\comb.xml d:\MAKit\out\ MAQuery MADataTable

Chart View

MAAnalyticChartView is a UIView subclass representing a single chart in MAKit.

13
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MAAnalyticChartView comprises the chart and other Ul components, such as the range selector and
hierarchy buttons.

For added convenience, a corresponding UIViewController—MAAnalyticChartViewController—is also
available.

See “Creating a Simple Chart Using the High-Level APIs” on page 18 for details.

Dashboard View

MAView is a UIView subclass representing the dashboard component in MAKit.

14
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RegionFroduct Sales Ca wumber Of Sales Ovders
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The dashboard comprises charts, dynamic analytic panels, and toolbars. The bottom toolbar provides
additional functionalities, such as refresh and e-mail sharing. The top toolbar displays filtering options.
The layout of charts and panels in the dashboard is defined in the metadata.

For added convenience, a corresponding UIViewController—MAViewController—is also available.

See “Creating a Dashboard Using the High-Level API” on page 24 for details.
Low-Level APIs—Core Components

Chart View

MAChartView is a UIView subclass that represents a chart.

MAChartView requires a datasource that adopts the MAChartVviewDataSource protocol, and provides the
information required to draw the chart. The machartview can optionally include a delegate that adopts
the MAChartviewDelegate protocol. The delegate receives events, and can be notified of gestures. You
can further customize the look-and-feel of machartview by specifying an object that adopts the
MAChartTheme delegate, to change colors and fonts.

MAChartViewDataSource | N>
MAChartViewDelegate ) . MAChartView

MAChartTheme ‘ \

See “Creating a Simple Chart Using the Low-Level API” on page 29 for details.
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Dashboard View

MADashboardView is a ulview subclass that represents a dashboard.

ADashboardView is similar to MAChartView in that it too requires a datasource and can optionally have a
delegate. The datasource that adopts MADashboardviewDataSource provides the information required to
draw the dashboard. The delegate that adopts the MADashboardviewDelegate protocol receives events
and can be notified of gestures. You can also specify an object that adopts the MADashboardTheme to
customize the appearance of the dashboard.

MADashboardViewDataSource ﬂ'/'

7

MADashboardViewDelegate _5'/ MADashboardView

MADashboardTheme .5/

MAKit iOS Influence Diagram API

Influence Diagram APIs—Packaged Components
Influence diagram APIs comprise:

e Metadata file/influence diagram spec objects

e Datasource — MAQueryDelegate and MAQueryDataTable

e View — MAInfluenceDiagramView

e Delegate —MAInfluenceDiagramDelegate

e Theme — MADiagramTheme

MAInfluenceDiagramDelegate J MADiagramTheme J

r U

Metadata File/ Spec Objs J.E'/

MAlInfluenceDiagramView
MAQueryDelegate J

—
MAQueryDataTable J _5'/ /
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MAInfluenceDiagramView is view component, whereas the datasource is made up of the metadata
file/spec objects, MAQueryDelegate, and MAQueryDataTable. The application can be notified of events via
the MAInfluenceDiagramDelegate. YOu can use MADiagramTheme to customize colors, images, and fonts.

IM

See “Creating an Influence Diagram Using High-Level API” on page 59 for details.

Using MAKit in an Xcode Project

This section provides detailed steps for importing MAKit libraries into your Xcode project.

Creating an iOS Project in Xcode 4
e Choose File > New > New Project.
e Select the Single View Application project template for your iOS application, and click Next.
e Enter the product name and other project details, and click Next.

e Specify the project’s location in your file system, and click Create.

Adding MAKit to the Project

The MAKit library is delivered with a bundle file and two folders—includes and libs. Copy the
MAKit deliverables folder to your file system. Assuming that the MAKit folder in your file system is
/Users/<username>/MAKIt, modify your project’s build settings:

e Inthe navigator area of the Xcode workspace window, click your project file.
e Choose Build Settings and scroll down to Search Paths.
e To Header Search Paths, add ZUsers/<username>/MAKit/includes.

e To Library Search Paths, add /Users/<username>/MAKit/libs/$(BUILD _STYLE)-
$(PLATFORM_NAME).

Add these files to your project:

e MessageUl.framework

e QuartzCore.framework

e MAKIt.a

e MAKit.bundle

o libsglite3.0.dylib (if you are using a SQLite database)

Using MAK:it Classes

In the files that use MAKit, import MAKit.h, the header file that includes all public headers for the
MAKit library.

Next, create charts and diagrams using these instructions:

e “Creating a Simple Chart Using the High-Level APIs” on page 18
e “Creating a Dashboard Using the High-Level APIs” on page 24
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e “Creating a Simple Chart Using the Low-Level APIs” on page 29
e “Creating a Dashboard Using the Low-Level APIs” on page 34

e “Creating an Influence Diagram Using High-Level APIs” on page 59

Creating a Simple Chart Using the High-Level APIs

This task constructs a simple chart of sales revenue per year for three types of bikes.

Sales Year: 2004, Sales Amount in US Dollars:

¥ Mountain Bikes: $15,500,026 [ Road Bikes: $14,796,639 | @ Touring Bikes: $15,427,533

Step 1: Metadata
e Add anew XML file into the project.

e Construct the metadata file using the code snippet below.

<MobileAnalytic><Dashboard>
<Chart Name="Sales" Title="Bike Sales Summary" ChartType="Line" Query="SalesSummary">
<Category Format="Rounded®" Column="Year" DisplayName="Sales Year" />
<Series Column="Product" DisplayName="Sales Year" />
<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName="Sales Amount in US
Dollars" />
</Values>
</Chart></Dashboard>
</MobileAnalytic>

Most metadata examples used in this document are shown in XML format; however, MAKit metadata
can also be in plist format, or coded by NSDictionary. See “Metadata Formats other than XML” on page
72 for detailed information about these alternative formats. For example, using the above snippet, a
developer can add a plist file called BikeSales.plistinto the project, as shown in the figure below.
This example can use either BikeSales.plist or BikeSales.xml as the metadata file. See
“Step 4: MAAnalyticChartView” on page 21.
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Metadata attributes such as Title, Format, and DisplayName affect the labels shown on the chart. Use
different sets of metadata for localization purposes. The chart is plotted by value (Sales Amount)
against category (Year). Multiple sets of data are represented using Series (Product). Metadata
attributes such as Query and Column obtain the datasource of the chart. These attributes are closely

Key
MetaName

MetaName
0
MetaName
Marme
Title
ChartType
Query
0
MetaName
Format
Column
DisplayName

MetaName
Column
DisplayName

MetaName

0
MetaMame
Format
Expression

ValueSequence

DisplayName

Type
String

Diction. ..

String

Diction...

String
String
String
String
String

Diction...

String
String
String
String

Diction...

String
String
String

Diction...

String

Diction...

String
String
String
String
String

linked with the implementation of the query protocols.

See “Expressions” and “Metadata File” on pages 65 and 72 respectively for details about metadata
construction.

Step 2: MAQueryDataTable

@interface ChartDataTable :

}

@property(nonatomic,retain) NSArray *tableRows;

@end

@implementation ChartDataTable
- (id)getData: (NSString*)colName atIndex:(int)rowIndex {

if ([colName isEqualToString:@"Year"] || ([colName isEqualToString:@"Product"] || ([colName

isEqualToString:@"SalesAmount"])

{

NSObject<MAQueryDataTable> {

19
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Dashbeoard
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Chart
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Sales Amount in US Dollars

Add a new Objective-C class, ChartDataTable, into the project.

NSDictionary* row = (NSDictionary*)[self.tableRows objectAtIndex:rowIndex];

Ensure that chartDataTable adopts the MAQueryDataTable protocol, as illustrated below in
the .h and .mfiles, respectively.
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return [row objectForKey:colName];

}

retun nil;

by

@end

An object that adopts the MAQueryDatatable protocol represents the tabular datasource of the chart.
Each row of the tabular datasource represents a data item in the chart. In this example, there are 4
categories and 3 series—a total of 12 data rows. The columns are defined in the metadata as vear,
Product, and SalesAmount.

A simple snapshot of the tabular data for the chart is as shown below.

Row Year Product SalesAmount
1 2000 Mountain Bikes $10,029,815
2 2000 Road Bikes $12,174,936
3 2000 Touring Bikes $10,447,665
4 2001 Mountain Bikes $10,893,468

In the row retrieval code snippet for ChartDataTable shown above, the array tableRows stores all the
rows of this tabular data. Each row is further represented as a dictionary for fast retrieval of the values
by column name.

Step 3: MAQueryDelegate
e Add a new Objective-C class, ChartQuery into the project .

e Ensure that chartQuery adopts the MAQueryDelegate protocol, as illustrated below in the . h
and .mfiles, respectively.

@interface ChartQuery: NSObject<MAQueryDelegate> {
}

@implementation ChartQuery

- (id<MAQueryDataTable>)executeQuery: (NSString*)queryName withArgument:(NSDictionary*)args

{
ChartDataTable *table = [[[ChartDataTable alloc] init] autorelease];

if ([queryName isEqualToString:@"SalesSummary"])
{
NSMutableArray *tableRows = [[NSMutableArray alloc] init];
const char *SELECT = "SELECT Year, ProductSubCategory,sum(SalesAmount)
" FROM CompanySales "
" WHERE ProductCategory='Bikes' "
" GROUP BY Year,ProductSubCategory "
" ORDER BY Year,ProductSubCategory";

20
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sqlite3_stmt *selectStmt = nil;

sqlite3_prepare_v2(dbConn, SELECT, -1, &selectStmt, NULL);

while (sqlite3_step(selectStmt)==SQLITE_ROW)

{
int year = sqlite3_column_int(selectStmt, 0);
NSString *product = [NSString stringWithUTF8String:(char *) sqlite3_column_text(selectStmt, 1)];
double amount = sqlite3_column_double(selectStmt, 2);

NSMutableDictionary *row = [[NSMutableDictionary alloc] init];

[row setObject:[NSNumber numberWithInt:year] forKey:@"Year"];

[row setObject:product forKey:@"Product"];

[row setObject:[NSNumber numberWithDouble:amount] forKey:@"SalesAmount"];
[tableRows addObject:row];

[row release];

}
sqlite3_reset(selectStmt);

sqlite3_finalize(selectStmt);
table.tableRows = tableRows;
[tableRows release];

}

return table;

}
@end

An object, chartQuery, that adopts the MAQueryDelegate protocol, is implemented to correspond to the
metadata definition. This example illustrates how to use a SQLite database as the query delegate; for
simplicity, error handling has been omitted from the code snippets.

Query, defined in the metadata, is used as the input parameter of the class that adopts the
MAQueryDelegate protocol. Column and Expression, also defined in the metadata, are used as the input
parameters of the class that adopts the MAQueryDataTable protocol. This is summarized in this table:

Metadata Query
Query="SalesSummary" Protocol MAQueryDelegate
Method executeQuery: withArgument:
Input parameter queryName
Column="Year" Protocol MAQueryDataTable
Column="Product Method getData: atindex:
Expression="SalesAmount"
Input parameter colName

Step 4: MAAnalyticChartView
e Add a new view controller ChartviewController into the project.

e Import MAKIt.h, the header file that includes all public headers of the MAKit library.
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e (Create AnalyticChartView in viewDidLoad.

e Set the theme. Included in the library are two default themes: MAKitTheme_WelterWeight and
MAKitTheme_WelterWeightDark.

e Associate the created datasource MAChartQuery with the view component MAAnalyticChartView.
e Set the chart’s frame and refresh the chart in viewWillAppear.
This code snippet assumes that Automatic Reference Counting (ARC) is not enabled:

#import “MAKit.h”
@interface ChartViewController ()

@property(nonatomic,retain) MAAnalyticChartView* chartView;
@end

@implmentation ChartViewController
@synthesize chartView;

- (void)dealloc
{
self.chartView = nil;
[super dealloc];
}
- (void)viewDidLoad
{
[super viewDidLoad];
MAAnalyticChartView *aChartView = [MAAnalyticChartView alloc] initWithFrame:aFrame];
self.chartView = aChartView;
[aChartView release];
[self.view addSubView:self.chartView];
MAKitTheme_WelterWeight *aTheme = [[MAKitTheme_WelterWeight alloc] init];
self.chartView.theme = aTheme;
[aTheme release];
self.chartView.metaDataPath = [[NSBundle mainBundle] pathForResource:@"BikeSales" ofType:@"xml"];
ChartQuery *dataSource = [[ChartQuery alloc] init];
self.chartView.dataSource = dataSource;
[dataSource release];
}
- (void)viewWillAppear
{
self.chartView.frame = aFrame;
[self.chartView reloadData:YES];
}
@end

Invoke reloadData only after the bounds and frame of the charts have been set, so that all subviews of
the chart can be correctly laid out. The developer must invoke reloadData at least once after the view is
initialized. Developers may also refresh the data again in applications as required.

The code above assumes the developer is using an XML metadata file. If the developer uses
BikeSales.plist as the metadata file, he or she must also change:

self.chartView.metaDataPath = [[NSBundle mainBundle] pathForResource:@"BikeSales" ofType:@"xml"];
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To:

self.chartView.metaDict = [NSMutableDictionary dictionaryWithContentsOfFile:
[[NSBundle mainBundle] pathForResource:@"BikeSales" ofType:@"plist"]];

If the plist format Is used instead of the XML format, an intermediate NSDictionary is passed to
self.chartview. The intermediate NSDictionary is parsed from BikeSales.plist. This implies the
developer can build the NSDictionary as metadata, without adding a metadata file to the project, but

the structure (or schema) of the NSDictionary must be exactly the same as the NSDictionary parsed from
the plist file.

MAAnalyticChartViewController

If a simple UIviewController is required, the developer may use MAAnalyticChartViewController. The
view controller includes a toolbar, which provides functionalities such as tabular representation, data
refresh, and e-mail sharing in addition to the chart view.

Done Bike Sales Summary

Sales Year: 2004, Sales Amount in US Dollars:

BM -

EM -

After creating the analytic chart view as shown in the previous selection, you can initialize the analytic
chart view controller with the view.

MAAnalyticChartViewController *viewController = [[MAAnalyticChartViewController alloc]
initWithAnalyticChartView:aChartView] autorelease];
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Creating a Dashboard Using the High-Level APIs

This task constructs a dashboard similar to that shown below. Besides charts, the dashboard may also
include Dynamic Analytic panels, which are described in more detail in “Advanced Chart Features” on

page 38.

MAKH CoseExmtipn Chart Types Dashboart

RegionPreduct Sales P Salary By DepliGender
Aeglon: Canasda, Sales Amount: Depanimet  Salnmy Ak
Baseball Cap- 513358 W Shoris- 515,200
S17E00.00 -
| i nronoo [
| | L .
' | I
& | . - W arkatng M
A IHI il sezsr7s D
Mumber OF Salas Cvders s Printar Sales

Yoar: 2003, Number Of Orders:

Cannda- # B Corirat: 208 W Eastern- 280

LS Crima Dl

Sate:; Aksbane

Aggravated_Assaulf: Crime Raflo: 347.B0 Crime RAotio: B Burglary: Crime Raflo: 553.80 Cri

. Woatetes . 0ele P o 2 T H.u% 8.0 W
0. "1'- l"‘ - B # +® ;"v?fl';'.' ‘."Ei-.E?l!‘,‘?"‘fi"“"ﬂ“;‘_ﬁ".

Tap the expand button in the upper-right corner of the chart to open the chart in full-screen mode,
which allows additional operations, such as zooming and drilldown. The top toolbar also provides users
the options to show a tabular representation of the chart or share the chart via an e-mail message.
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State: Alabama
T Aggravated_Assault: Crime Ratio: 247.80 Crime Ratio: 247.80 Burglary: Crime Ratio: 953.80 Crime Ratio: 953.80 | [l Motor_Vehicle_Thef |

2K -

1.5K -

B 8
6003.90930009?30?8

500 -

500 -

© Aggravated_Assault [ Burgla _Theft Murder

State CrimeType Crime Ratio Crime Ratio
Aggravated_Assault 247.80 247.80
Alabama Burglary 953.80 953.80
Alabama Motor_Vehicle_Theft 288.30 288.30
Alabama Murder 8.20 8.20
Alabama Robbery 141.40 141.40
Alaska Aggravated_Assault 465.10 465.10
Alaska Burglary 622.50 622.50
Alaska Motor_Vehicle_Theft 391.00 391.00
Alaska Murder 2.20 2.20
Alaska Robbery 80.90 80.90
Arizona Aggravated Assault 327.40 327.40
Arizona Burglary 948.40 948.40
Arizona Mator_Vehicle_Theft 924.40 924.40
Arizona Murder 7.50 7.50

Step 1: Metadata
e Add anew XML file into the project.

e Construct the metadata file using the code snippet below.

<MobileAnalytic>
<Dashboard>
<Chart Name="ColumnChart" Title="Region/Product Sales" ChartType="Column" Query="SalesOrder">
<Category Column="Region" DisplayName="Region" />
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<Series Column="Product" DisplayName="Region" />
<Values>

<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName="Sales Amount" />
</Values>

</Chart>

<Chart Name="BarChart" Title="Salary By Dept/Gender" ChartType="Bar" Query="DeptSalary">
<Category Column="Department" DisplayName="Department" />
<Series Column="Sex" DisplayName="Gender" />
<Values>
<Value Format="Rounded2" Expression="Salary" ValueSequence="1" DisplayName="Salary" />
</Values>

</Chart>

<Chart Name="LineChart" Title="Number Of Sales Orders" ChartType="Line" Query="NumberOfOrders">
<Category Column="Year" DisplayName="Year" />
<Series Column="Region" DisplayName="Region" />
<Values>
<Value Format="Rounded@" Expression="OrderCount" ValueSequence="1" DisplayName="Number Of Orders"
/>
</Values>
</Chart>

<Chart Name="PieChart" Title="Printer Sales" ChartType="Pie" Query="PrinterSales">
<Category Column="SalesRep" DisplayName="Sales Rep" />
<Series Column="Product" DisplayName="Type" />
<Values>
<Value Format="Currency" Expression="Sales" ValueSequence="1" DisplayName="Sales Amount " />
</Values>
</Chart>

<Chart Name="BubbleChart" Title="US Crime Data" ChartType="Bubble" Query="CrimeData">
<Category Column="State" DisplayName="State" />
<Series Column="CrimeType" DisplayName="CrimeType" />
<Values>
<Value Format="Rounded2" Expression="Ratio" ValueSequence="1" DisplayName="Crime Ratio" />
<Value Format="Rounded2" Expression="Ratio" ValueSequence="2" DisplayName="Crime Ratio" />
</Values>
</Chart>

</Dashboard>
<DashboardLayout>
<Landscape>
<Layout Name="ColumnChart" Top="1" Left="1" Width="49" Height="32" />
<Layout Name="BarChart" Top="1" Left="51" Width="48" Height="32" />
<Layout Name="LineChart" Top="34" Left="1" Width="49" Height="32" />
<Layout Name="PieChart" Top="34" Left="51" Width="48" Height="32" />
<Layout Name="BubbleChart" Top="67" Left="1" Width="98" Height="32" />
</Landscape>
<Portrait>
<Layout Name="ColumnChart" Top="1" Left="1" Width="49" Height="32" />
<Layout Name="BarChart" Top="1" Left="51" Width="48" Height="32" />
<Layout Name="LineChart" Top="34" Left="1" Width="49" Height="32" />
<Layout Name="PieChart" Top="34" Left="51" Width="48" Height="32" />
<Layout Name="BubbleChart" Top="67" Left="1" Width="98" Height="32" />
</Portrait>
</DashboardLayout>

</MobileAnalytic>
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The metadata also contains the dashboard layout configuration. There are layouts for portrait and
landscape orientations. There are two scales for the dashboard: percentage and points. The default
scale value is the percentage the dashboard does not scroll in this scale. Specify layout dimensions in
percentage form (0 — 100).

Scrollable Dashboard

The default scale of the dashboard layout is percentage, which is not scrollable. If you require a
scrollable dashboard, specify the scale of DashboardLayout in points. Also specify ContentWidth and
ContentHeight in both landscape and portrait modes, and the top, left, width, and height properties of
Layout using points.

The values of ContentWidth and ContentHeight determine dashboard scrolling.

For example:

<DashboardLayout Scale = "Points" >
<Landscape ContentWidth = "1300" ContentHeight = "1200">
<Layout Name="ZoomingChart" Top="10" Left="10" Width="1000" Height="300" />
<Layout Name="Drilldown" Top="315" Left="10" Width="1000" Height="700" />
<Layout Name="DA" Top="920" Left="10" Width="1000" Height="200" />
</Landscape>
<Portrait ContentWidth = "800" ContentHeight = "1100">
<Layout Name="ZoomingChart" Top="10" Left="10" Width="750" Height="300"/>
<Layout Name="Drilldown" Top="315" Left="10" Width="750" Height="600" />
<Layout Name="DA" Top="920" Left="10" Width="750" Height="200" />
</Portrait>
</DashboardLayout>

Step 2: Query
e Add a new Objective-C class, DashboardQuery, into the project.

e Ensure that DashboardQuery adopts the MAQueryDelegate protocol, as illustrated in this code
snippet:

- (id<MAQueryDataTable>)executeQuery: (NSString*)queryName withArgument:(NSDictionary*)args

{
if ([queryName isEqualToString:@"SalesOrder"]) {

)2
else if ([queryName isEqualToString:@"DeptSalary"]) {

}
else if ([queryName isEqualToString:@"NumberOfOrders"]) {

}
else if ([queryName isEqualToString:@"PrinterSales"]) {

}
else if ([queryName isEqualToString:@"CrimeData"]) {

}
}

Each chart in a dashboard retrieves data using one or multiple queries. Each query has a unique name
for retrieval of the corresponding data set. The class that adopts the MAQueryDelegate protocol must
handle all queries in the dashboard.

Step 3: MAView

e Add a new view controller, DashboardviewController, into the project.

27





MAKit Developer Guide: iOS 2012

e Import MAKiIt.h, the header file, which includes all public headers of the MAKit library.
e C(Create MAView in viewDidLoad.
e Assign a UIViewController to MAView.

e Set the theme. Included in the library are two default themes: MAKitTheme_WelterWeigh and
MAKitTheme_WelterWeightDark.

e Associate the created datasource MADashboardQuery with the view component MAView.

e Set the chart’s frame and refresh the view in viewWillAppear.
This code snippet assumes that Automatic Reference Counting (ARC) is not enabled:

#import “MAKit.h”

[maView refresh];
#import “MAKit.h”

@interface DashboardViewController ()
@property(nonatomic,retain) MAView* maView;
@end

@implmentation DashboardViewController
@synthesize maView;

(void)dealloc

self. maView = nil;
[super dealloc];

(void)viewDidLoad
[super viewDidLoad];

MAView *aMaView = [[MAView alloc] initWithFrame:aFrame];
self.maView = aMaView;

[aMaView release];

[self.view addSubView:self.chartView];

self.maView.controller = self;

MAKitTheme_WelterWeight *aTheme = [[MAKitTheme_WelterWeight alloc] init];
self.maView.theme = aTheme;
[aTheme release];

self.maView.metaDataPath = [[NSBundle mainBundle] pathForResource:@"DashboardMetadata" ofType:@"xml"];
DashboardQuery *dataSource = [[DashboardQuery alloc] init];

self.maView.dataSource = dataSource;

[dataSource release];

- (void)viewWillAppear
{

self.maView.frame = aFrame;
[self.maView refresh];
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)2
@end

After the metadata and datasource have been set as MAView’s properties, invoke refresh to load the
data. The developer must refresh at least once after the view is initialized. Developers may also refresh
the data again in applications as required, such as when the data on the back-end server has been
updated.

MAViewController
If no special handling is required for the view controller of MAview, the developer can directly create the

dashboard by using MAViewController.

#import “MAKit.h”

MAViewController *maViewController = [[[MAViewController alloc] init] autorelease];
MAKitTheme_WelterWeight *aTheme = [[MAKitTheme_WelterWeight alloc] init];
maView.theme = aTheme;

[aTheme release];

maViewController.metaDataPath = [[NSBundle mainBundle] pathForResource:@"MAMeta" ofType:@"xml"];
DashboardQuery *dataSource = [[DashboardQuery alloc] init];

maViewController.dataSource = dataSource;

[dataSource release];

[maViewController refresh];

Creating a Simple Chart Using the Low-Level APIs

This task creates a simple chart that shows product category against sales revenue. There are four
categories—Accessories, Bikes, Clothing, and Components. There are also two series that represent two
years of data.

Company Sales Data

10M 20M 30M 40M 50M
' | ' | |

4290052.5

I

Accessories

4107610.5

40992312

45724396

13584524
Clothing
7859807.5

35310012
Components

13452856

= 2003 W 2004

Step 1: ChartViewController

The developer must create classes that adopt the MAChartVviewDataSource and MAChartViewDelegate
protocols. Often, the two protocols are implemented within a subclass of UIviewController.

e Add a new view controller, ChartViewController, into the project.
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e Ensure that chartViewController adopts the MAChartViewDataSource and MAChartViewDelegate
protocols, as illustrated in the code snippet below.

@interface ChartViewController : UIViewController <MAChartViewDataSource, MAChartViewDelegate>
{
¥

Step 2: MAChartViewDataSource

Implement the required methods of the MAChartviewDataSource protocol in ChartvViewController. The
following code snippets implement the methods in a simplistic way for illustration purposes only: in
general, the data comes from a dynamic back-end server, and is not static. The data returned should
also include localization. The code snippets assume that Automatic Reference Counting (ARC) is not
enabled.

e Construct the data in init:

@interface ChartViewController
@property(nonatomic,retain) NSArray *categoryArray;
@property(nonatomic,retain) NSArray *seriesArray;
@property(nonatomic,retain) NSDictionary *valueDict;
@end

@implementation ChartViewController
@synthesize categoryArray;
@synthesize seriesArray;
@synthesize valueDict;

- (id)init
{

self.categoryArray = [NSArray arrayWithObjects:@"Accessories", @"Bikes", @"Clothing",
@"Components", nil];

self.seriesArray = [NSArray arrayWithObjects:[NSNumber numberWithInt:2003], [NSNumber
numberWithInt:2004], nil];

NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];
self.valueDictionary = dict;

[dict release]

for (NSUInteger categoryIndex=0; categoryIndex<[self.categoryArray count]; categoryIndex++)

{
for (NSUInteger seriesIndex =0; seriesIndex <[self. seriesArray count]; seriesIndex ++)
{
NSUInteger indexes[] = {categoryIndex, seriesIndex};
NSIndex* indexPath = [NSIndexPath indexPathWithIndexes:indexes length:2];
double value = arc4random % 10000;
[self.valueDictionary setObject:[NSNumber numberWithDouble:value] forKey:indexPath];
}
)

}

e Give the chart a title, for example, “Company Sales Data”:

- (NSString*)titleForChartView: (MAChartView *)chartView
{

return @"Company Sales Data";

}
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e Return the chart type as a bar chart, to correspond to the screenshot above:

- (NSUInteger)chartView: (MAChartView *)chartView chartTypeForChartLayer:(NSUInteger)layerIndex

{
return MAChartTypeBar;

}

e Return the categories stored in the category array:

- (NSUInteger)chartView: (MAChartView *)chartView
numberOfCategoriesInLevel: (NSUInteger)categorylLevelIndex {
return [self.categoryArray count];

}

- (id)chartView: (MAChartView *)chartView categoryAtIndex:(NSUInteger)categoryIndex
inCategoryLevel: (NSUInteger)categorylLevelIndex

{
return [self.categoryArray objectAtIndex:categoryIndex]

}

For numeric data, return an object of either NSString or NSNumber. The datatype affects the
sorting, which in turn affects the order in which data appears in the chart.

The input parameter categoryLevelIndex is used in complex charts, such as semantic zooming
charts, in which categories are hierarchical.

See “Semantic Zooming” on page 38.

e Return the series stored in the series array:

- (NSUInteger)numberOfSeriesInChartView: (MAChartView *)chartView
{

return [self.seriesArray count];

- (id)chartView: (MAChartView *)chartView seriesAtIndex:(NSUInteger)seriesIndex
{

return [self. seriesArray objectAtIndex: seriesIndex]

}

e Return the values stored in the value array:

- (id)chartView: (MAChartView *)chartView valueAtDimension:(NSUInteger)valueDimensionIndex
forCategory: (NSUInteger)categoryIndex inCategoryLevel:(NSUInteger)categorylLevelIndex
andSeries: (NSUInteger)seriesIndex

{
NSUInteger indexes[] = {categoryIndex, seriesIndex};
NSIndex* indexPath = [NSIndexPath indexPathWithIndexes:indexes length:2];
return [self.valueDictionary objectForKey:indexPath];

}

The value represents the sales revenue. The input parameter valueDimensionIndex is applicable
to charts that have multiple value dimensions, such as bubble charts.

Step 3: MAChartViewDelegate

All methods in MAChartViewDelegate are optional, and you can use them to be notified of chart
operations such as category selection and double-tapping to perform additional operations.
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In this example, the delegate synchronizes selections between the bar chart and the datagrid chart, both
of which represent the same set of data. When the second category, Bike, is selected in the bar chart,
the same category should also be selected in the datagrid chart.

Company Sales Data
0 10M 20M 30M 40M 50M
| | | | |

4290052.5
Accessories
4107610.5

40992312
Bikes
45724396

13584524
Clothing
7859807.5 |8

35310012
Components

13452856 ||

= 2003 | 2004

I 2003 | 2004

Accessories 42900525 4107610.5
40992312 45724396
Clothing 13584524  7859807.5

Components 35310012 13452856

This code snippet shows how to implement this example:

- (void)chartView: (MAChartView *)chartView didSelectCategory:(NSUInteger)categoryIndex

{
if (chartView.tag == 1) {
[self.dataGrid selectCategoryAtIndex:categoryIndex];
[self.dataGrid setNeedsDisplay];

}

else {
[self.chart selectCategoryAtIndex:categoryIndex];
[self.chart setNeedsDisplay];

Step 4: MAChartView
e Create the Chart View in the viewdidLoad method of the subclass of UTviewController.

e Set the theme. Included in the library are two default themes: MAKitTheme_WelterWeigh and
MAKitTheme_WelterWeightDark.

e Associate the class ChartVviewController, which adopts the MAChartviewDataSource and
MAChartViewDelegate protocols, with the view component MAChartView.
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e Set the chart’s frame and refresh the chart in viewWillAppear.

After the delegate and datasource have been set as MAChartView properties, invoke refresh to load the
data. The developer must refresh at least once after the view is initialized. Developers may also refresh
the data again in applications as required.

{

{

(void)viewDidLoad
[super viewDidLoad];

MAChartView *aChart = [[MAChartView alloc] initWithFrame:CGRectZero];
self.chart = aChart;
[aChart release];

MAKitTheme_WelterWeight *aTheme = [[MAKitTheme_WelterWeight alloc] init];
self.chart.theme = aTheme;
[aTheme release];

self.chart.tag = 1;

self.chart.identifier =@"chart";

self.chart.contentMode = UIViewContentModeRedraw;

self.chart.autoresizingMask = UIViewAutoresizingFlexibleWidth | UIViewAutoresizingFlexibleHeight;

self.chart.dataSource = self;
self.chart.delegate = self;

[self.view addSubview:self.chart];

- (void)viewWillAppear: (BOOL)animated

self.chart.frame = self.view.bounds;
[self.chart refresh];
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Creating a Dashboard Using the Low-Level APIs

This task creates a simple dashboard for two charts.

Beverage Consumption History in ABC Group

= Pepsi: 5 | @ Coca-Cola: 52 | [ Target: 123

Step 1: CustomDashboardViewController

Create classes that adopt the MADashboardViewDataSource and MADashboardViewDelegate protocols.
These two protocols are often implemented within a subclass of UIviewController.

e Add a new view controller CustomDashboardviewController into the project.

e Ensure that CustomDashboardviewController adopts the MADashboardviewDataSource and
MADashboardViewDelegate protocols:

@interface CustomDashboardViewController : UIViewController <MADashboardViewDataSource,
MADashboardViewDelegate>

{
X

Step 2: MADashboardViewDataSource

Implement the required methods of the MADashboardviewDataSource  protocol in
CustomerDashboardViewController. The following code snippets implement the methods in a simplistic
way for illustration purposes only, and assume that Automatic Reference Counting (ARC) is not enabled.

e Construct the data in init:

@interface CustomDashboardViewController () <MADashboardViewDataSource, MADashboardViewDelegate>
@property(nonatomic,retain) MADashboardView *dashboardView;
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@property(nonatomic,retain) id<MAChartTheme,MADashboardTheme> theme;
@property(nonatomic,retain) NSArray *charts;
@end

@implementation CustomDashboardViewController
@synthesize dashboardView;

@synthesize theme;

@synthesize charts;

- (id)init
{
/* Create theme */
MAKitTheme_WelterWeight *welterWeightTheme = [[MAKitTheme_WelterWeight alloc] init];
self.theme = welterWeightTheme;
[welterWeightTheme release];
/* Create dashboard items */
NSMutableArray *array = [[NSMutableArray alloc] initWithCapacity:2];
MAChartView *chartl = [[MAChartView alloc] initWithFrame:CGRectZero];
.. // Customize chart and set data source and delegate
[chartl refresh];
[array addObject:chartl];
[chartl release];
MAChartView *chart2 = [[MAChartView alloc] initWithFrame:CGRectZero];
.. // Customize chart and set data source and delegate[chart2 refresh];
[array addObject:chart2];
[chart2 release];
self.charts = array;
[array release];
}

e Return charts as dashboard item contents:

- (UIView *)dashboardView: (MADashboardView *)dashboardView contentForItemAtIndexPath:(NSIndexPath
*)indexPath;

{
NSUInteger idx = [indexPath indexAtPosition:@];
return [self.charts objectAtIndex:idx];

}

e Return the dashboard item count:

- (NSInteger)numberOfItemsInDashboardView: (MADashboardView *)dashboardView

{

return [self.charts count];

Step 3: MADashboardViewDelegate

The following code snippets show how to implement the methods of the MADashboardviewDataDelegate
protocol in CustomerDashboardViewController

e Return the dashboard theme:

- (id<MADashboardTheme>)themeForDashboardView: (MADashboardView *)dashboardView

{
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return self.theme;

}

e Return the frame of each dashboard item:

- (CGRect)dashboardView: (MADashboardView *)dashboardView frameForItemAtIndexPath:(NSIndexPath

*)indexPath withContentSize:(CGSize)contentSize

{

CGFloat padding = 5.ef;

CGFloat width = contentSize.width - padding * 2;

CGFloat height = roundf((contentSize.height - padding * 3)/2);

NSUInteger idx = [indexPath indexAtPosition:@];

return CGRectMake(padding, padding + idx * (height + padding), width, height);
}

Step 4: MADashboardView

e Create the Dashboard view in the viewdidLoad method of the subclass of UIvViewController.

e Associate the class CustomDashboardViewController, which adopts the

MADashboardViewDataSource and MADashboardViewDelegate protocols, with the view component

MADashboardView.

e Invoke reloadData of MADashboardView.

- (void)viewDidLoad

{

[super viewDidLoad];

/* Create dashboard */
MADashboardView* dashboard = [[MADashboardView alloc] initWithFrame:self.view.bounds];
dashboard.contentMode = UIViewContentModeRedraw;
dashboard.autoresizingMask = UIViewAutoresizingFlexibleLeftMargin
| UIViewAutoresizingFlexibleRightMargin
| UIViewAutoresizingFlexibleTopMargin
| UIViewAutoresizingFlexibleBottomMargin
| UIViewAutoresizingFlexibleWidth
| UIViewAutoresizingFlexibleHeight;
dashboard.delegate = self;
dashboard.dataSource = self;
[dashboard reloadData];

[self.view addSubview:dashboard];

self.dashboardvView = dashboard;
[dashboard release];
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Complex Charts
Rich Format Table
The rich format table (RFTable) can contain text, chart, and variance columns.
KPIName Past Trend Actual Target Variance Target
Cost $1,456,750 < $2,348,780 ($892,030)
Cost1 $2,456,750 < $3,348,780 ($892,030)
Costi0 ’\/_/_/\J $32,416,750 > $23,488,780
Cost11 /\/\/\/\/\,1 $324,167,500 > $234,887 800
Costi2 /\,\/\/\/ $132,416,750 < $223,488,780 (891,072,030)
Cost13 —'\/\/\j $324,161,750 > $234,882,780
Cost14 NNW $132,416,750 < $523,488,780 ($391,072,030)
Cost1s f\/_,./\f $82,416,750 > $53,488,780
Costis /\/\/\/b 232,416,750 < $523,488,780 ($291,072,030)
Cost17 /—\/\/\> 543,241,650 < $72,348,780 ($29,107,130)
Cost18 /\W $62,416,750 > $33,488,780
Cost19 $92,416,750 > $73,488,780
Cost2 g $4.456,750 > 54,348,780
Cost20 \J\/\/\/\/‘ $72416750 > $43,488,780
Metadata

For variance column types, a color expression is required. For chart column types, the chart definition
must also be present in the metadata.

<DataGrid Name="RFTable" Title="Table Chart" Query="TableQuery">
<Columns>
<Column Type="Data" Value="kpi_name" Header="KPI Name" IsHeaderColumn="1"/>
<Column Type="Chart" Value="char data" ChartName=" " Header="Past Trend" ColumnSequence="1"/>
<Column Type="Data" Value="actual" Format="Currency" Header="Actual" ColumnSequence="2"/>
<Column Type="Data" Value="op" ColumnSequence="3" />
<Column Type="Data" Value="target" Format="Currency" Header="Target" ColumnSequence="4"/>
<Column Type="Variance" Value="actual-target" Color="if(actual > target, 'green', 'red')"
Format="Currency" Header="Variance Target" ColumnSequence="5"/>
</Columns>

<Charts>
<Chart Name=" " Title="Month Trend" ChartType="Line">
<Category Column="Month" DisplayName="Month" />
<Values>
<Value Format="Rounded2" Expression="Amount" ValueSequence="1" DisplayName="Trend Value" />
</Values>
</Chart>
</Charts>
</DataGrid>

Query

To use charts as columns of the RFTable, the class that adopts the MAQueryDataTable protocol must
return chart data as a data table, which also adopts the MAQueryDataTable protocol.

- (id)getData: (NSString*)colName atIndex:(int)rowIndex
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{
if ([colName isEqualToString:@"char_data"])
{
MyQueryDataTable *chartData = [MyQueryDataTable alloc] init] autorelease];
Return chartData;
3

-

Advanced Chart Features

Advanced chart features are available through the use of high-level APIs. See “Creating a Dashboard
Using the High-Level APIs” on page 24 to understand the relationship between metadata and data
retrieval via the query protocols.

Semantic Zooming

Semantic zooming is useful for aggregating data. A commonly used scenario is to aggregate data by year,
quarter, and month. Another scenario is to aggregate data by region, country, state, and city. The chart
below uses three category hierarchies—Year, Quarter, and Month.

"Bone " Sales By Year

¢ =

Quarter Month

Year: 2004, Quarter: Q1, Month: 1, Sales Amount:

= Actual Sales: 7094108.50 W Mfg Cost: 2870886.75 |

25M -

Metadata

<Chart Name="ZoomingChart" Title="Sales By Year" ChartType="Line" >
<Category DisplayName="Sales ByYear-Quarter-Month" />
<Series Column="AmountType" DisplayName="Sales Region" />
<Values>
<Value Format="Rounded2" Expression="Amount" ValueSequence="1" DisplayName="Sales Amount" />
</Values>
<ZoomingLevels>
<ZoominglLevel Query="ResellerYear" CategoryColumn="Year" Title="Year" />
<ZoominglLevel Query="ResellerQtr" CategoryColumn="Quarter" Title="Quarter" />
<ZoominglLevel Query="ResellerRegion" CategoryColumn="Month" Title="Month" />

38





MAKit Developer Guide: iOS 2012

</ZoominglLevels></Chart>

Query

The zooming levels have a hierarchical relationship: items in the second level are subordinate to items in
the first level (for example, quarters of a calendar or fiscal year). The data table returned by queries of
the two zooming levels must reflect this relationship. In this example, the first-level query should return
a table with two columns—“Year” and “Amount.” The second-level query should return a table with
three columns—“Year,” “Quarter,” and “Amount.”

Drilldown

Drilldown is useful for data filtering, whereby different details of chart data are shown at different chart
levels. For each drilldown level, you can use a different chart type to present the data. The filter action is
triggered by a double-tap. You can also combine the drilldown feature with semantic zooming charts.

This chart defines three drilldown levels. The top level displays the sales revenue grouped by regions.

Reseller Sales Summary

Sales Region  Sales Amourit in US Dollars 10M 20M 30M 1OM 50M BOM
| | | | |
$5,531,144
$10,977,163
Europe
§10,855,859
$26,589,696
$18,552,273
$56,469,132
North America
$22,662,153
$48,392,837
$15,881,877 |
Paciic ‘
$8,044,825
$12,948,150

7 Accessories [ Bikes W Clothing @ Components
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Double-tapping a country drills down to the second level, in which sales revenue is grouped by the
countries of the selected region.

Reseller Sales Summary

Europe H o =
Country Sales Amount in US Dollars M m - aM oM 12 1AM
$2,113,396 I I ‘ I
$4,593,259

France
$4,366,383

$12,078,586

$1,543,655

$1,990.490
Germany
$2,440,790

$4,636,825

$1,874,093

$4,.393414
United Kingdom
$4,049,685

$9,874,286

= Accessories [l Bikes [l Ciothing [ Components

Double-tapping a region drills down to the third level, in which sales revenue is grouped by product
categories for the selected country and region.

Reseller Sales By Country Sales .‘:.'V Product C.ﬂ,'lrjgmry
Europe > France 3 e =
Product Sub Category ~ Sales Amount in US Dollars 500K M 1.5M oM 2.5M am 3.5M A 45M
Bib-Shorts $366,665 ‘ I ‘ I ‘ ‘ I ‘
Bike Racks $942,771
Bottles and Cages $28,779
Bottom Brackels $63,251
Brakes $105,760
Caps $61,440
Chains $17,085
Cleaners $46,032
Cranksets $341.898
Derailleurs $119,374
Forks $64,902
Gloves $462,917
Handlebars $134,808
Headsets $39,979
Metadata

Drilldown charts comprise multiple elementary charts, each with its own query.
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<DrillDownGroup Name="Reseller" Title="Reseller Drilldown Charts">
<Chart Name="ResellerSales" Title="Reseller Sales Summary "
Query="ResellerSummary" >
<Category Column="Region" DisplayName="Sales Region" />
<Series Column="ProductCategory" DisplayName="ProductCategory" />
<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName="Sales Amount in
US Dollars" />
</Values>
</Chart>

ChartType="Bar" ChartSequence="1"

<Chart Name="SalesByCountry" Title="Reseller Sales By Country" ChartType="Bar" ChartSequence="2"
Query="ResellerByCountry" >
<Category Column="Country" DisplayName="Country" />
<Series Column="ProductCategory" DisplayName="Product Category" />
<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName="Sales Amount in
US Dollars" />
</Values>
</Chart>
<Chart Name="SalesByCategory" Title="Sales By Product Category " ChartType="Bar" ChartSequence="3"
Query="ResellerByCategory"”>
<Category Column="ProductSubCategory"” DisplayName="Product Sub Category" />
<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName="Sales Amount in
US Dollars" /> </Values>
</Chart>
</DrillDownGroup>

Query

Queries in a drilldown chart may have parameters. The query for the top-level chart, ResellerSummary,
needs no arguments.

The query for the second level chart, ResellerByCountry, requires two arguments that correspond to the
category and series definitions in the top-level chart. This is because the top-level chart allows drilling
down by either category or series. The user can double-tap a region to drill down by category. The user
can also drill down by both category and series, by first selecting a product in the legend bar at the
bottom of the chart, then double-tapping a region.

The last-level query also inherits the query arguments of the second-level query as the context of a
drilldown level is the data scope of its parent level. Thus, the third-level query, ResellerByCategory,
requires three arguments—region, product, and country.

The developer can use MAGen to automatically generate a skeleton of the query datasource that includes
all the proper arguments for each query.

- (id<MAQueryDataTable>)executeQuery: (NSString*)queryName withArgument:(NSDictionary*)args

{
if ([queryName isEqualToString:@"ResellerSummary"])

{

3
else if ([queryName isEqualToString:@"ResellerByCountry"])

{
NSString *region = [args objectForKey@"Region"];
NSString *product = [args objectForKey@"ProductCategory"];
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}
else if ([queryName isEqualToString:@"ResellerByCategory"])
{
NSString *region = [args objectForKey@"Region"];
NSString *product = [args objectForKey@"ProductCategory"];
NSString *product = [args objectForKey@"Country"];
¥

-

Dynamic Analytics

Dynamic analytics (DA) allows the user to dynamically change the value of a global variable and see that
change reflected instantly in the chart. You can use dynamic analytic controls in both the dashboard
view and the single chart view. Dynamic analytics is applicable to all charts, except semantic zooming
charts.

Dynamic Analytic Panel

]

Region/Product Sales ) Number Of Sales Orders s

Region: Canada, Sales Amount: Year: 2003, Number Of Orders:
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Canada Eastern Western
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Department Salary " Salary Dynamci Analytic Panel
Department  Salary o 400K 800K 1.2m || Pay Raise Departr Sales @

| \ |
335679.00
Pay Raise % 00 @
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Region/Product Sales

Region: Canada, Sales Amount:
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150K -
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Sales Promation ' Sales Promotionin -~ WWestern
Metadata

In dynamic analytics, the chart value is computed from an expression that includes one or more dynamic
analytic variables.

See the sections “Expressions” and “Metadata File” on pages 65 and 72 respectively for details about
contstruction dynamic analytic variables.

In the dashboard view, you can group related dynamic analytic variables in the same Dynamic Analytic
panel.

<Dashboard>

<Variables>
<Variable Name="$salesdrive" DisplayName="Sales Promotion ?" VariableType="boolean" Value="0" />
<Variable Name="$region" DisplayName="Sales Promotion in " VariableType="enum" Selection="0">
<Choices>
<Choice Display="Eastern" Value="Eastern" />
<Choice Display="Western" Value="Western" />
<Choice Display="Central" Value="Central" />
<Choice Display="South" Value="South" />
<Choice Display="Canada" Value="Canada" />
</Choices>
</Variable>
</Variables>

<Chart Name="ProductSales" Title="Region/Product Sales" ChartType="Column" Query="SalesOrder">

<Category Column="Region" DisplayName="Region" />

<Series Column="Product" DisplayName="Product" />

<Values>

<Value Format="Currency" Expression="if($salesdrive==1,SalesAmount+(SalesAmount *

0.30),if(Region==%region, SalesAmount+(SalesAmount * @.80),SalesAmount))" ValueSequence="1"
DisplayName="Sales Amount" />

</Values>
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</Chart>
<DAPanel Name="SalesDA" Title="Sales Dynamic Analytic Panel">
<VariableName Name="$salesdrive" Sequence="1" />
<VariableName Name="$region" Sequence="2" />
</DAPanel>
</Dashboard>

Query

Dynamic analytics is automatically performed by the system; no special handling is required for the
Query datasource. The class that adopts the MAQueryDataTable protocol is unaware of the dynamic
analytic variables Ssalesdrive and Sregion; it returns only data that corresponds to the SalesAmount
column .

- (id)getData: (NSString*)colName atIndex:(int)rowIndex

{
if ([colName isEqualToString:@"SalesAmount"])

{

-

What-If Analysis

What-if analysis allows the user to dynamically change input data and see those changes instantly
updated in the chart. What-if analysis is applicable to all charts, except semantic zooming charts.

Done Net Income From Sales

Region: Canada, Net Income:

T Baseball Cap-Cotton Cap: $3,699 | [l Tee Shirt-Crew Neck: $11,655 | [ Tee Shirt-Tank Top: $3,523 |

30K -

20K -

10K -

Canada Central Eastern South Waestern
Unit Price 38 @ Unit Price 66 @
Cost Of Revenue 14 e ————— Cost Of Revenue 2 cE——
R & D Cost 4 e = R&D Cost 8 en—
Marketing Cost 3 @ Marketing Cost 65 @

Metadata

In what-if analysis, the chart value is computed from an expression, which is made up of one or more
what-if column names.

<Chart Name="WhatIfChart" Title="Net Income From Sales" ChartType="Line" Query="ProductSales">
<Category Column="Region" DisplayName="Region" />
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<Series Column="Product" DisplayName="Product" />

<Values>
<Value Format="Currency" Expression="(( * Quantity) - (( * Quantity) +
(RD_Cost * Quantity) + ( * Quantity) + (Admin_Cost * Quantity)))" ValueSequence="1"
DisplayName="Net Income" />
</Values>
<WhatIfColumns>

<Column Name=" DisplayName="Unit Price" VariableType="float" Value="90.0" Min="1.0"
Max="110.0" Step="1.0" Decimals="2" />

<Column Name=" " DisplayName="Cost Of Revenue" VariableType="integer" Value="0" Min="1"
Max="40" />

<Column Name="RD_Cost" DisplayName="R &amp; D Cost" VariableType="integer" Value="0" Min="1" Max="18"
/>
<Column Name=" " DisplayName="Marketing Cost" VariableType="float" Value="0.0" Min="1.0"
Max="10.0" Step="1.0" Decimals="2" />

</WhatIfColumns>

</Chart>

Query

What-if analysis is performed by the system; no special handling is required for the Query datasource.
The class that adopts the MAQueryDataTable protocol need not be concerned about the Value expression
parsing, and returns data based only on the six column names defined, of which four can be adjusted for
what-if analysis.

- (id)getData: (NSString*)colName atIndex:(int)rowIndex

{
if ([colName isEqualToString:@" ") {

}
else if ([colName isEqualToString:@" "1 {

X
else if ([colName isEqualToString:@"RD_Cost"]) {

X
else if ([colName isEqualToString:@" "1 {

X
else if ([colName isEqualToString:@"Admin_Cost"]) {

X
else if ([colName isEqualToString:@"Quantity"]) {

}

Filter

Developers can use query arguments to filter chart data. Filters are global in nature and affect all charts
associated with that filter. Filters allow users to focus only on the data of interest; data that does not
fulfill the specified criteria is not included in chart results. Two types of filters are available. A range filter
allows the specification of an integer range. A pick list filter allows selection of discrete sets of data
criteria.

In the following example, the charts can be filtered by region. The first dashboard shows the charts with
data of three regions.
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The second dashboard shows the results after filtering, which now includes data from only two regions,
North America and Pacific.

Products | Region: 2 | Sales Reason

Reseller Sales By Product s

‘ Product Category: Accessories, Sales Amount in Local Currency: |

ll & North America: $18,552,273 B Pacific: $12,641,135

40M -
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0
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Sales Reason: Manufacturer, Sales Amount in Local Currency:
North America: $2,767,663 B Pacific: $2,023,208
BM -

1 1.

Manutfacturer Other Quality Television Advartiser

¢ =

Metadata

A sample metadata with filter is shown below. The SourceQuery for the filter must be defined as a Query
by at least one Chart node in the dashboard. Filters can be shared by multiple charts, and as such, the
sourceQuery need not be the same as that of the Query of the chart which uses it.

<Dashboard>

<Filters>
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<Filter Name="
Column="ProductCategory"” />
<Filter Name="
Column="Region" />
</Filters>
<Chart Name="ResellerSales" Title="Reseller Sales By Product" ChartType="Line" Query="ResellerQry">
<Category Column="ProductCategory" DisplayName="Product Category" />
<Series Column="Region" DisplayName="Sales Region"/>
<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName="Sales Amount in
Local Currency" />
</Values>
<Filters>
<FilterName Name=" />
<FilterName Name=" ">
</Filters>
</Chart>
</Dashboard>

Sequence="1" SourceQuery="ResellerQry" FilterType="picklist"

Sequence="2" SourceQuery="ResellerQry" FilterType="picklist"

Query

After the filters are applied in the dashboard, the filters are passed to MAQueryDelegate as query
parameters. The query parameters are specified in a dictionary, where the key is the name of the Filter
element defined in the metadata, and the values are an array of the selected range/data. The code

below shows the handling of the filter as query parameters.

The class that adopts the MAQueryDelegate protocol can use the argument dictionary to obtain the filter

query parameters.

- (id<MAQueryDataTable>)executeQuery: (NSString*)queryName withArgument:(NSDictionary*)args

{
NSArray *products = [args objectForKey:@" "1;
NSArray *regions = [args objectForKey:@" "1;

}

The class that adopts the MAQueryDataTable protocol need not be concerned about the filter parameters,

and returns only data based on columns defined in the metadata.

- (id)getData: (NSString*)colName atIndex:(int)rowIndex

{
if ([colName isEqualToString:@"ProductCategory"]) {

}
else if ([colName isEqualToString:@"Region"]) {

}
else if ([colName isEqualToString:@"SalesAmount"]) {

}
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Predictive Modeling

Predictive modeling, which is available only for line charts, shows forecasted or projected data points
using a dashed-line pattern.

The maQueryTable protocol includes a property called predictiveStartCategory. Set the predictive starting
category value to this property. For example:

The MyQueryTable class implements the MAQueryTable protocol; synthesize the property in the class:

@synthesize predictiveStartCategory;
In the query class, set the property to the predictive starting category value:
myTable.predictiveStartCategory = [NSNumber numberWithInt:2000];

myTable is an instance of the MyQueryTable class. 2000 is the predictive starting category. The chart
shows the data points from 2000 in a dashed pattern:
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Reference Value and Threshold Values

You can assign a reference value to highlight some benchmark value. The reference value appears on
the chart on the y-axis.

Threshold values highlight values that fall outside of a specified range.
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The MAQueryTable protocol includes referenceValue, upperThreshold, and lowerThreshold properties. For
example:

The MyQueryTable class implements the MAQueryTable protocol; synthesize the properties in the class.

@synthesize referenceValue;
@synthesize upperThreshold;
@synthesize lowerThreshold;

In the query class, set the properties to desired values:

myTable.referenceValue = [[[NSNumber alloc]initWithDouble:350]autorelease];
myTable.upperThreshold [[[NSNumber alloc]initWithDouble:450]autorelease];
myTable.lowerThreshold [[[NSNumber alloc]initWithDouble:120]autorelease];

myTable is an instance of the MyQueryTable class.

The default color for a reference line is violet, and for threshold regions, gray; however, you can
customize these colors using MAChartTheme class properties: referencevValueColor, upperThresholdColor,
and lowerThresholdColor.

Year: 1988, Resell value :

= 17200

Multiselection

The multiselection feature is triggered by a long press (or “touch and hold”) gesture. After an initial long
press, the user can drag to select a rectangular region. When finished selecting, the user can click the
action button to perform the custom action for the selection. Cancel the selection by clicking anywhere
else.

49





MAKit Developer Guide: iOS 2012

Year Quarter Month

Month I North ' South

12 518 $38

2000

T 1 $36 526

2001

2 320 56

To receive and process a multiselection event notification, the user must implement the following
methods, either in MAChartViewDelegate or MAAnalyticChartViewDelegate:

MAChartViewDelegate MAAnalyticChartViewDelegate

(BOOL)willSelectltems:(MAChartView *)chartView (BOOL)willSelectltems:(MAAnalyticChartView
*)chartView;

(void)chartView:(MAChartView *)chartView (void)chartView:(MAAnalyticChartView *)chartView

didSelectltems:(MAChartSelection*)selection didSelectltems:(MAChartSelection*)selection;

This code snippet shows how the methods are implemented in a class that adopts the
MAAnalyticChartView delegate:

- (BOOL)willSelectItems:(MAAnalyticChartView *)chartView
{

return YES;

}

- (void)chartView: (MAAnalyticChartView *)view didSelectItems:(MAChartSelection*)selection
{

if (view == self.chartView)

{
NSMutableString *msg = [[NSMutableString alloc] init];
[msg appendFormat:@"%d categories - Indexes: ", [selection.selectedCategoryIndexes count]];
for (NSNumber *n in selection.selectedCategoryIndexes)

{
[msg appendFormat:@"%d ", [n unsignedIntValue]];

b
[msg appendFormat:@"\n %d items - Indexes: ", [selection.selectedDataltemIndexes count]];
for (NSNumber *n in selection.selectedDataltemIndexes)

{
[msg appendFormat:@"%d ", [n unsignedIntValue]];

¥

UIAlertView *alert = [[UIAlertView alloc] initWithTitle:@"Selected Items" message:msg
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delegate:nil cancelButtonTitle:@"OK"
otherButtonTitles: nil];
[alert show];
[alert release];
[msg release];

}

For this code snippet, the custom action is to display an alert showing the indexes of the selection, as
shown below:

With the category and data item indexes, the user can get other extra information of the selection using
the following APIs available in MAChartView and MAAnalyticChartView, which both adopt the MADataModel
protocol:

e (id)categoryAtindex:(NSUInteger)categorylndex;

e (id)valueAtDimension:(NSUInteger)valueDimensionindex
ofDataltem:(NSUInteger)dataltemindex;

For column charts, the entire column must be within the selection rectangle to be considered. In the
example below, only a single category (the middle one) is selected.
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Zooming Chart - Reveune
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The user can filter the series before performing the selection. As shown below, the user selects a single
category, and a single data item in that category belonging to the South region.
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Zooming Chart - Reveune
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Chart Layout
You can configure components of a chart shown to be shown or hidden. This functionality applies to
both MAChartview and MAAnalyticChartView.
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Component Chart Type Property Default
1 | Title All isTitleHidden Shown
2 | Selected data label All except bar chart | showsSelectedDatalabel Shown
3 | Horizontal axis title Cartesian chart | showsHorizontalAxisTitle Hidden

types, such as line,
column, and bubble

4 | Horizontal axis Cartesian chart | showsHorizontalAxis Shown
types, such as line,
column, and bubble

5 | Vertical axis title Cartesian chart | showsVerticalAxisTitle Hidden
types, such as line,
column, and bubble

6 | Vertical axis Cartesian chart | showsVerticalAxis Shown
types, such as line,
column, and bubble

7 | Content range selector Line charts, column | contentRangeSelectorBehaviour | Auto
charts, and bar
charts

8 | Legend Bar charts, pie | isLegendHidden Shown
charts, and bubble
charts

Generic Ul Functionalities

MAKit also includes some generic Ul functionalities that can be used for all views, instead of being
limited to charts. These extend the Ul and views available in UIKit, and can be used in an application to
enhance user interaction.

MAMailSharingController

MAMailSharingController adds annotation capabilities to the mail sharing functionality. Using the API,
any UIview can be sent as an image via an e-mail message. Before sharing, the user can add annotations
such as text, lines, and circles to highlight certain aspects of the image.
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Cancel Share by Email Send

AL O

Ca
%

This code snippet shows how you can use MAMailSharingController:

-(IBAction)onEmailChart: (id)sender
{
if ([MFMailComposeViewController canSendMail])
{
MAMailSharingController *sharingCtrl = [[MAMailSharingController alloc] init];
sharingCtrl.subject = self.chartView.title;
[sharingCtrl pushSharingControllerWithViewController:self andDelegate:self forView:self.chartView];
[sharingCtrl release];
}
else
{
// If email hasn't been configured, display a message (localization recommended)
UIAlertView *alert = [[UIAlertView alloc] initWithTitle:@"Mail not configured" message:@"Please
add a mail account in Settings"
delegate:nil cancelButtonTitle:@"OK"
otherButtonTitles: nil];
[alert show];
[alert release];

Runtime Error Handling

MAKit includes a runtime error-handling mechanism that enables an application to implement custom
runtime error handlers. To address runtime errors from MAKit, the application must implement an error
handler that conforms to the MAErrorHandlingDelegate protocol, and pass the error handler object to
MAKit.

MAKit classes, including MAViewController and MAView, expose an errorHandler property. The application
must pass its own error handler to the errorHandler property of either of these classes.
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MAErrorHandlingDelegate protocol is defined as:
@protocol MAErrorHandlingDelegate <NSObject>

/**

@brief The MAKit Error Handler delegate. MAKit will call the delegate when runtime error is
detected.

@param error the error object that contains error information
*/

-(void)handleError: (MAError*)error;

@end

This protocol defines one method—handleError, in which the application implements the custom error
handler. When a runtime error occurs in MAKit, handleError is called and an error object (MAError) is
passed as the argument:

@interface MAError : NSObject {

}

/*! The error code
*/
@property MAErrorCode errorCode;

/*! The error level
*/
@property MAErrorLevel errorlLevel;

/*! Detailed error information. Details can be accessed with predefined keys
*/
@property(nonatomic, retain) NSDictionary *errorDetails;
/*! Create an MAError object
*/
+(MAError*)errroWithCode: (uint)code andLevel:(uint)level andDetails:(NSDictionary*)details;
@end
MAError contains:
e errorCode — the predefined error number.
e errorLevel — Error or Warning.

e errorDetails — a dictionary containing details about this error. Different errors may contain
different error details.

Error Code Description

MAError_MetadataPathNotSpecified = Metadata file path is not specified

MAError_MetadataFileNotFound Metadata data file is not found with the give path

MAError_MetadatalnvalidXMLFormat Metadata is not in valid XML format
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MAError_MetaDataMissingNode

Required metadata node does not exist

MAError_MetaDataMissingAttr

Required metadata node attribute does not exist

MAError_MetadataAttrWrongValue

Metadata node attribute value is not valid

MAError_MetadataOutOfSequence

Metadata nodes are out of sequence

MAError_MetadataUnrecognizedltem

Metadata node is not recognizable

MAError_MetadataObjUndefined

One metadata node refers to an undefined node

MAError_DataMissingColumn

Required column is missing in the input data table

MAError_DataTableEmpty

Input data table is empty

MAError_LowMemory

Low memory warning is received

MAError_ExpressionEvalation

Expression evaluation failed

MAError_Other

Other unknown errors

When the application’s error handler receives any of these errors, it can refer to the errorDetails
property of the error object for more details. For example, MAError_MetadatalnvalidXMLFormat details
include the line number and column number where the error occured (the dictionary keys are

MAErrorKey_MetadataLlineNumber

and MAErrorKey_MetadataColumnNumber).

The details

for

MAError_MetadataAttrWrongValue include the metadata node name, attribute type, and attribute
value (the dictionary keys are MAErrorKey_MetadataNodeName, MAErrorKey_MetadataAttrName, and

MAErrorKey MetadataAttrValue).
Error Detail Key

MAErrorKey_MetadataFileName

Description

The metadata file name

MAErrorKey_MetadatalineNumber

The line number of the error in the metadata XML

MAErrorKey_MetadataColumnNumber

The column number of the error in the metadata XML

MAErrorKey_MetadataNodeName

The node name in the metadata that triggers the error

MAErrorKey_MetadataAttrName

The attribute name in the metadata that triggers the error

MAErrorKey_MetadataAttrValue

The attribute value in the metadata that triggers the error

MAErrorKey_MetadataSequence

The sequence number of metadata node

MAErrorKey_DataColumnName

The name of the column in the input data table
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MAErrorKey_DataRowNumber

The row number in the input data table

MAErrorKey_DataQueryName

The query name

MAErrorKey_Expression

The expression

MAErrorKey_ChartName

The chart name

MAErrorKey_ChartName

Other general information

Creating an Influence Diagram Using High-Level APIs

This task constructs an influence diagram similar to:

59






MAKit Developer Guide: iOS 2012

Step 1: Metadata
e Add anew XML file into the project.

e Construct the metadata file using this code snippet:

<?xml version="1.0" encoding="utf-8"?>
<Diagram Name="EVA-Value-Driver" Query="EVAQuery">
<Node Name="EVA" Text="EVA" Expression="OperatingProfitl-CostofCaptial” Default="true"
Charts="chartl,chart2" Format="Rounded2"/>
<Node Name="OperatingProfitl" Text="Operating Profit" ParentNode="EVA" Expression="RONA*NetAssetsl"
Charts="chart3,chart4" Format="Rounded2">
<NodeTo Name="EVA"/>
</Node>
<Node Name="CostofCaptial" Text="Cost of Captial" ParentNode="EVA" Expression="NetAssetsl*WACC"
Format="Rounded2">
<NodeTo Name="EVA"/>
</Node>
<Node Name="RONA" Text="RONA" ParentNode="OperatingProfitl" Expression="ProfitMargin*NetAssetTurnover"
Format="Percentage">
<NodeTo Name="OperatingProfit1"/>
</Node>
<Node Name="NetAssetsl" Text="Net Assets" ParentNode="OperatingProfitl,CostofCaptial"
Format="Rounded2">
<NodeTo Name="OperatingProfitl"/>
<NodeTo Name="CostofCaptial"/>
</Node>
<Node Name="WACC" Text="WACC" ParentNode="CostofCaptial" Format="Percentage">
<NodeTo Name="CostofCaptial"/>
</Node>
<Node Name="ProfitMargin" Text="Profit Margin" ParentNode="RONA" Expression="OperatingProfit2/Salesl1"
Format="Percentage" Charts="chartl,chart2">
<NodeTo Name="RONA"/>
</Node>
<Node Name="NetAssetTurnover" Text="Total Net Asset Turnover" ParentNode="RONA"
Expression="Salesl/NetAssets2" Charts="chartl,chart2" Format="Rounded2">
<NodeTo Name="RONA"/>
</Node>
<Node Name="OperatingProfit2" Text="Operating Profit" ParentNode="ProfitMargin" Expression="EBIT*(1-
IncomeTax)" Format="Rounded2">
<NodeTo Name="ProfitMargin"/>
</Node>
<Node Name="Salesl" Text="Sales" ParentNode="ProfitMargin,NetAssetTurnover" Format="Rounded2">
<NodeTo Name="ProfitMargin"/>
<NodeTo Name="NetAssetTurnover"/>
</Node>
<Node Name="NetAssets2" Text="Net Assets" ParentNode="NetAssetTurnover" Expression="Assets-
Liabilities" Format="Rounded2">
<NodeTo Name="NetAssetTurnover"/>
</Node>
<Node Name="EBIT" Text="EBIT" ParentNode="OperatingProfit2" Expression="Contribution-Overhead"
Format="Rounded2">
<NodeTo Name="OperatingProfit2"/>
</Node>
<Node Name="IncomeTax" Text="(1-Rate of Income Tax)" ParentNode="OperatingProfit2" Format="Rounded2">
<NodeTo Name="OperatingProfit2"/>
</Node>
<Node Name="Assets" Text="Assets" ParentNode="NetAssets2" Expression="FixedAssets+CurrentAssets"
Format="Rounded2">
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<NodeTo Name="NetAssets2"/>
</Node>

<Node Name="Liabilities" Text="Interest Free Liabilities" ParentNode="NetAssets2" Format="Rounded2">

<NodeTo Name="NetAssets2"/>

</Node>

<Node Name="Contribution" Text="Contribution" ParentNode="EBIT" Expression="Sales2-GoodsSold"

Format="Rounded2">

<NodeTo Name="EBIT"/>

</Node>

<Node Name="Overhead" Text="Overhead" ParentNode="EBIT">
<NodeTo Name="EBIT"/>

</Node>

<Node Name="FixedAssets" Text="Fixed Assets" ParentNode="Assets" Format="Rounded2">
<NodeTo Name="Assets"/>

</Node>

<Node Name="CurrentAssets" Text="Current Assets" ParentNode="Assets" Format="Rounded2">
<NodeTo Name="Assets"/>

</Node>

<Node Name="Sales2" Text="Sales" ParentNode="Contribution" Format="Rounded2">
<NodeTo Name="Contribution"/>

</Node>

<Node Name="GoodsSold" Text="Variable Cost of Goods Sold" ParentNode="Contribution" Format="Rounded2">

<NodeTo Name="Contribution"/>
</Node>
</Diagram>

You can also use the code snippet below to construct the metadata specification objects.

MAInfluenceDiagramSpec *spec = [[MAInfluenceDiagramSpec alloc] init];
spec.name = @"EVA-Value-Driver";
spec.query = @"EVAQuery";

MAInfluenceDiagramNode *node = [[MAInfluenceDiagramNode alloc] init];
node.name = @"EVA";

node.text = @"EVA";

node.expression = @"OperatingProfitl-CostofCaptial”;

node.charts = @"chartl,chart2";

node.root = YES;

node.format = @"Rounded2";

[spec.nodes addObject:node];

[node release];

node = [[MAInfluenceDiagramNode alloc] init];
node.name = @"OperatingProfitl";

node.text = @"Operating Profit";
node.parentNode = @"EVA";

node.expression = @"RONA*NetAssetsl";
node.charts = @"chart3,chart4";

node.format = @"Rounded2";
MAInfluenceDiagramNodeTo *nodeTo = [[MAInfluenceDiagramNodeTo alloc] init];
nodeTo.name = @"EVA";

[node.nodeTos addObject:nodeTo];

[nodeTo release];

[spec.nodes addObject:node];

[node release];

node = [[MAInfluenceDiagramNode alloc] init];
node.name = @"CostofCaptial";

node.text = @"Cost of Captial";
node.parentNode = @"EVA";

61





MAKit Developer Guide: iOS 2012

node.format = @"Rounded2";

nodeTo = [[MAInfluenceDiagramNodeTo alloc] init];
nodeTo.name = @"EVA";

[node.nodeTos addObject:nodeTo];

[nodeTo release];

[spec.nodes addObject:node];

[node release];

node = [[MAInfluenceDiagramNode alloc] init];
node.name = @"RONA";

node.text = @"RONA";

node.parentNode = @"OperatingProfitl";
node.format = @"Percentage";

nodeTo = [[MAInfluenceDiagramNodeTo alloc] init];
nodeTo.name = @"OperatingProfitl";
[node.nodeTos addObject:nodeTo];

[nodeTo release];

[spec.nodes addObject:node];

[node release];

node = [[MAInfluenceDiagramNode alloc] init];
node.name = @"NetAssetsl";

node.text = @"Net Assets";

node.parentNode = @"OperatingProfitl,CostofCaptial”;
node.format = @"Rounded2";

nodeTo = [[MAInfluenceDiagramNodeTo alloc] init];
nodeTo.name = @"OperatingProfitl";

[node.nodeTos addObject:nodeTo];

[nodeTo release];

nodeTo = [[MAInfluenceDiagramNodeTo alloc] init];
nodeTo.name = @"CostofCaptial”;

[node.nodeTos addObject:nodeTo];

[nodeTo release];

[spec.nodes addObject:node];

[node release];

Step 2: Query
e Add a new Objective-C class, InfluenceDiagramQuery, into the project .

e Ensure that InfluenceDiagramQuery adopts the MAQueryDelegate protocol, as in this code snippet:

-(id<MAQueryDataTable>)executeQuery: (NSString*)queryName withArgument:(NSDictionary*)args

{
MyDataTable* myTable = [[[MyDataTable alloc] init] autorelease];
[MALog trace:@"query name%@",queryName,nil];
if([queryName isEqualToString:@"EVAQuery"])
{
myTable.dataTable = [self GetEVAInfluenceDiagramQueryData];
}
return myTable;
}

- (NSArray*)GetEVAInfluenceDiagramQueryData

{
NSMutableArray* table = [[[NSMutableArray alloc] init] autorelease];

NSMutableDictionary* row = [[NSMutableDictionary alloc] init];

[row setObject:[NSNumber numberWithDouble:42.24] forKey:@"EVA"];
[row setObject:[NSNumber numberWithDouble:120] forKey:@"OperatingProfitl"];
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[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row

setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:

[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber

[table addObject:row];

[row

row =
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row

release];

numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:

[[NSMutableDictionary alloc] init];

setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:

[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber

[table addObject:row];

[row

retur

release];

n table;

numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:

Step 3: MAInfluenceDiagramView

77.76] forKey:@"CostofCaptial”];
0.15] forKey:@"RONA"];

800] forKey:@"NetAssetsl"];
0.097] forKey:@"WACC"];

0.12] forKey:@"ProfitMargin"];
1.25] forKey:@"NetAssetTurnover"];
120] forKey:@"OperationProfit2"];
1000] forKey:@"Salesl1"];

800] forKey:@"NetAssets2"];

200] forKey:@"EBIT"];

0.4] forKey:@"IncomeTax"];

1000] forKey:@"Assets"];

200] forKey:@"Liabilities"];

600] forKey:@"Contribution"];
400] forKey:@"Overhead"];

600] forKey:@"FixedAssets"];

400] forKey:@"CurrentAssets"];
1000] forKey:@"Sales2"];

400] forKey:@"GoodsSold"];

46.464] forKey:@"EVA"];

132] forKey:@"OperatingProfit1"];
85.536] forKey:@"CostofCaptial”];
0.165] forKey:@"RONA"];

880] forKey:@"NetAssetsl"];
0.097] forKey:@"WACC"];

0.132] forKey:@"ProfitMargin"];
1.25] forKey:@"NetAssetTurnover"];
132] forKey:@"OperationProfit2"];
1100] forKey:@"Sales1"];

880] forKey:@"NetAssets2"];

220] forKey:@"EBIT"];

0.44] forKey:@"IncomeTax"];

1100] forKey:@"Assets"];

220] forKey:@"Liabilities"];

660] forKey:@"Contribution"];
440] forKey:@"Overhead"];

660] forKey:@"FixedAssets"];

4490] forKey:@"CurrentAssets"];
1100] forKey:@"Sales2"];

440] forKey:@"GoodsSold"];

Add a new view controller, InfluenceDiagramController, into the project .

Import MAKIt . h, the header file which includes all public headers of the MAKit library.

Create MAInfluenceDiagramView in viewDidLoad.

Set the theme. Included in the library is default theme MAKitDiagramTheme_Vallina.
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e Associate the created datasource, MAInfluenceDiagramQuery, with the view component
MAInfluenceDiagramView.

e Set the influence diagram’s frame and refresh the view in viewlWillAppear.
This code snippet assumes that Automatic Reference Counting (ARC) is not enabled:

#import “MAKit.h”

@interface InfluenceDiagramController ()
@property(nonatomic,retain) MAInfuenceDiagramView* influenceDiagramView;
@end

@implmentation InfluenceDiagramController
@synthesize influenceDiagramView;

- (void)dealloc

{
self.influenceDiagramView = nil;
[super dealloc];

- (void)viewDidLoad

{

[super viewDidLoad];

MAInfluenceDiagramView *aInlfuenceDiagramView = [[MAInfluenceDiagramView alloc] initWithFrame:aFrame,
ViewMode :MAInflLuenceDiagramGoalSeeR];

self.influenceDiagramView = aInlfuenceDiagramView;

[aInlfuenceDiagramView release];

[self.view addSubView:self.influenceDiagramView];

MAKitDiagramTheme_Vallina *aTheme = [[MAKitDiagramTheme_Vallina alloc] init];
self.influenceDiagramView.theme = aTheme;
[aTheme release];

self.influenceDiagramView.metaDataPath = [[NSBundle mainBundle]
pathForResource:@"InfluencediagramMetadata" ofType:@"xml"];

/* without using the metadata file, you can also use the metadata with the influnence diagram spec object
created above
self.influenceDiagramView.metaDataSpec = spec;
[spec release];
*/
InfluenceDiagramQuery *dataSource = [[InfluenceDiagramQuery alloc] init];
self.influenceDiagramView.dataSource = dataSource;
[dataSource release];
self.influenceDiagramView.delegate = self;

}

- (void)viewWillAppear

{
self.influenceDiagramView.frame = aFrame;
[self.influenceDiagramView reloadData];

}

@end
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After the metadata and datasource have been set as MAInfluenceDiagramView's properties, invoke
reloadData to load the data. The developer must refresh at least once after the view is initialized.
Developers may also refresh the data again in applications as required, such as when the data on the
back-end server has been updated.

Expressions

Expressions compute chart data or perform goal-seeking analysis in an influence diagram.

A chart has three axes (x, y, and z), which are called category, series, and values, respectively. For values,
you can specify an expression that lets you select which data should appear, and how it should look. For
category and series, you can specify only a column name. In earlier versions of MAKit, both category and
series could also be expressions that allowed for aggregation on the device; in this version, category and
series should already be in aggregate form.

In an influence diagram, you can specify a node name in an expression.

This is the syntax for an expression:

expr = operand (operator operand)?

operand = column_name | node_name | function_name(arg [,arg[,arg.]]) | constant
operator = ( + | / | - | * ) | logical_operator

logical_operator: ( < | > | <= | >= | I= | ==)

arg = column_name | node_name | constant | expr

constant = string | numerical_value

e Always enclose string constants in single quotes; using double quotes in the same capacity
generates an error.

e Column names and node names are case-sensitive; however, function names are case-
insensitive.

e Certain operators, such as > and <, must use HTML syntax (for example, &lt; &gt;) when entered
manually in the metafile.

Examples of Expressions

ValueExpr = Coll+Col2*Col3+2.2 ( ColX == e.g. column name from a database table )

ValueExpr = ‘Foo’ + Coll ( will convert whatever is in Coll to string and concatenate )
ValueExpr = sqrt(Col2) ( Square root of each value on each row )
NodeExpr = Nodel+Node2*Node3+2.2 (NodeX == e.g. node name from a influence model)

When combining operands of different types, implicit conversion is not performed except in some very
special cases.

This example is invalid because “a” and “hello” are of different datatypes, which could potentially create
a column of mixed types:

ValueExpr = if(a==1,a,’hello’)
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This is the correct way to write the expression:
ValueExpr = if(a=1,string(a),’hello’)

Implicit conversions are performed only when columns or constants are concatenated.

There is a special function for specifying dates as constants:

ValueExpr = if( SomeColOfDateType > date(2010,9,1), a, b )

However, if you specify a date as a string according to the mask YYYY-MM-DD, it is converted to a date
object (for example, “2009-09-01"). Sybase recommends that you use the date() method as described
here.

You can nest if-statements; however, too many nesting levels may be difficult to read:

ValueExpr = if( a>b, if( a>c, a, c), b )
ValueExpr = if (a >b, if (a>c, a, if(a>d, e, f), g ), h ) // you get the picture

Expression Types

In a chart, the only valid values for category and series are column names; this is further emphasized in
the metafile, where the attribute for category and series that maps to the values is called column, whereas
the attribute for values is Expression.

Each chart uses this syntax:
<Category Column="> ../>
<Serie Column="” .. />

<Values><Value Expression="* ./></Values>

For example, an application has a table you want to include in a column chart. You must map the values
from the table to the chart. To do this, use XML as described above.

The values you want to show in a chart are shown below—three columns of different height.

Project_Group Members
Alpha 20
Beta 30
Gamma 55

To show these values in the chart, you must specify the category, in this case, “Project Group.” The
category becomes the x-axis. The series is set to empty (“”) and the value in the y-axis is “Members”.

The XML snippet looks like this:
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<Category Column="Project_Group” ../>
<Series Column-“* ../>
<Values>
<Value Expression="Members” .. />
</Values>

There is no value expression per se—the column name is used as a value expression. To specify a real
expression, for example, to add 10% more members, use Expression="Members*1.10”.

Note: There are a number of runtime functions you can use in expressions; these functions are
described later in this document.

Internally, expressions work with columns, so using “Members*1.10” means that every row in the table
gets 10% more members. If you have two columns—Column1 and Column2—and you write “Column1 +
Column2”, the two columns are added together row by row.

This example takes each row from the Age column and adds 10% to each value, creating a new value
array that has the same number of rows:

ValueExpr= Age*1.1
This example calculates the sales revenue of a company:
ValueExpr=Amout*(UnitPrice-UnitCost)

Under normal circumstances, developers do not interact directly with the parser and lexer. Instead, they
specify the three expressions in a middle layer. This is a short summary of the internal processing:
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-(void)testParseAndEvalFunction

71
[MALog setTracelewvel:Z];
NsMutableDictionary *columns = [[NSMutableDictionary alloc] initWithCapacity:a];
[columns setObject:[NSArray arrayWithObjects:[NSNumber numberWithFloat:

[M5Number numberWithFloat: 1s
[M5Number numberWithFloat: 1, nil] forkKey:@"a"];

MAParse* parser = [[MA&Parse alleoc] init];
MAExpression® parsedExpression = [[parser parse:@"avg(a)”] retain];
parsedExpression.columnDictionary = columns;
MAExprEval® eval = [[MAExprEval alloc] init];
id result = [[eval evaluate:parsedExpression] retain];
[eval release];
NsLog( @"evaluated to: ¥1f",; [[result objectfAtIndex:2] floatValue] );
[result release];
[parsedExpression release];
[parser release];
[columns release];
[MALog setTracelevel:a];

"}

In the columns dictionary, the key is the column name “a”, which has an array associated with the row
values in NsArray. MAParse parses the expression and creates an object—MaExpression—which contains the
information for evaluating the expression. By using different column value dictionaries, expressions can

be reused.

In an influence diagram, each node can also specify a similar concept of expression; the difference is the

expression in an influence diagram is made up of node names instead of column names.

The XML snippet looks like this:

<Node Name="OperatingProfit” Expression="RONA*NetAsset”>
</Node>

Runtime Functions

You can use runtime functions in expressions; however, make sure you use the correct type of function

on the correct datatype. For example, do not use abs (Name) if Name is a column containing strings.

Note: Column names and node names are case-sensitive, but function names are not.
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Numeric Functions
//

// argument is a constant/column/node

//
Function Name Description
Abs (column|node) Abs(-1) -> 1

Ceiling(column|node)

Ceiling(1.01)->2.0

Cos(column|node)

Cos(1)->0.9998477

Exp(column|node)

Log( Exp(2) ) == 2

Fact(column|node)

51->120, be careful with overflow.

Floor(column|node)

10.1 -> 10.0

Int(column|node)

12.2 -> 12, use round for rounding values.

Log(column|node)

Log(Exp(1))=1

LogTen(column|node)

LogTen(10*10)==2

Mod(column|node, dividend)

10%5 == 0, 3%2 == 1

Neg(column|node)

Neg(-1)->1,Neg(1)->-1

Note: Neg differs from Abs. Use Neg when a
negative value is needed, since unary minus is not
supported. For example, 2*-1 is not allowed;
instead write 2*Neg(1l).

Round(column|node,decimals)

Rounds off a value to decimals. The second argument
‘decimals’ can only be a constant and cannot be a
column name.

Sign(column|node)

Sign(1.0)->1,Sign(-121)->-1

Sin(column|node)

Sin(1)->0.01745241

Sqrt(column|node)

Sqrt(3)->1.7320508..

Tan(column|node)

Tan(1)->0.01745506

Truncate(column|node)

12.32123->12.
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DateTime Functions

Note: DateTime functions can be used only in chart expressions.

//

// date time functions only work on columns(vectors) of type date, in general it is

// not possible to use them on constant values since there is no date type recognized

// in the parser.

// e.g. not allowed: Day( "2010-05-10" ) allowed: Day( MyDateCol )

// (you can however use the date function for date constants, see below)

Function Name

Description

Date(y,m,d[,hh,m,s] | column)

This versatile function can create a constant by
using constant values for year, month, and so on,
or converting a datetime column to date datatype.
For example, date(2010,9,1) creates a constant date
that can be used in expressions, and
date(mydatecol) removes hh:mm:ss from the datetime
in the column. This may be when comparing datetimes
when the time of day does not matter.

Day(column) Returns the day number 1 - 31/30/28.
DayNumber (column) 1=Sunday, 2=Monday, ...

Hour(column) Returns hour of day.

Minute(column) Returns minute of hour.
Month(column) Returns month of date.

RelativeDate(column, days)

Adds days to date, days== constant value, cannot be
a column name.

RelativeTime(column, seconds)

Adds seconds to date timestamp== constant value,
cannot be a column name.

Second(column) Returns seconds, column is assumed to contain date
objects.
Year(column) Returns year of date; column is assumed to contain

date objects.
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String Functions

Note: String functions can be used only in chart expressions.

//

// functions operate on columns if not stated otherwise

//

Function Name

Description

Left(column, numberOfChars)

left(‘abcdef’,3)->’abc’, left(Columnl,1)

LeftTrim(column) ¢ abc ° -> ‘abc ¢
Len(column) Returns number of characters.
Lower(column) ‘MYSTRING’ -> ’mystring’

Match(column, string)

Returns 1 for match, @ for no match.

Mid(column, start [, length ])

mid( ‘abcdef’,3,2)->"cd’

Pos(column, string [, startPos ])

pos( ‘abcdef’,’c’)->3

Replace(column, startPos, numberOfChars, string)

“1234” -> “1XX4”. startPos =1,..

Right(column, numberOfChars)

right(‘abcdef’,3)->’def’

RightTrim(column) ¢ abc € -> ¢ abce
String(column) Converts the column to strings.
Trim(column) ‘ hello ¢ -> ‘hello’

Upper(column) ‘mystring’ -> ‘MYSTRING’
WordCap(column) ‘bob alice eve’ -> ‘Bob Alice Eve’

Miscellaneous Functions

Function Name

Description

if(condition,expri,expr2)

If ‘condition’ is nonzero,
zero, expr2 is evaluated.

exprl is evaluated; if

and(exprl,expr2[,..])

This can, for example, be used in an if statement
in this way: if(and(expril,expr2),resl,res2).

or(exprl,expr2[,..])

As above.

not(exprl==expr2)

Unary not(exprl==expr2) is the same as

exprll=expr2.
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Metadata File

The metadata file, or metafile, is a configuration file for MAKit that contains information about where to
place charts and influence diagrams, and about the interdependencies between charts and influence
diagrams. The metafile also connects charts and influence diagrams to queries.

Note: All node names and attribute names have a capitalized first letter.

Metadata Formats Other Than XML

Most metadata examples given in this document are written with XML format. Alternatively, you can
use a plist file as metadata.

A developer can transform an XML metadata file to a plist metadata file by applying these rules:

e For each XML element, there must be a corresponding dictionary entry in the plist definition.
The key of thefirst entry in the dictionary is “MetaName”, and the value of the first entry is the
name of the XML element.

e For each XML attribute, there must be a corresponding string entry in the plist definition. The
key of the string entry is the attribute name, and the value is the attribute value.

e The parent-children and sibling relationships among XML elements/attributes must be the same
as those among entries in the corresponding plist definition.

o If there are sibling dictionary entries in the plist definition, the keys for the sibling dictionaries
must be incrementally indexed.

This is an XML format metadata file:

<MobileAnalytic><Dashboard>
<Chart Name="Sales" Title="Bike Sales Summary" ChartType="Line" Query="SalesSummary">
<Category Format="Rounded®" Column="Year" DisplayName="Sales Year" />
<Series Column="Product" DisplayName="Sales Year" />
<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName="Sales Amount in US
Dollars" />
</Values>
</Chart></Dashboard>
</MobileAnalytic>
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While this figure shows the equivalent plist definition:

Key Type Value
MetaName String MobileAnalytic
0 Diction. .. (2 items)
MetaName String Dashbeoard
0 Diction. .. (8 itemns)
MetaName String Chart
Name String Sales
Title String Bike 5ales Summary
ChartType String Line
Query String SalesSummary
0 Diction. .. (4 items)
MetaName String Category
Format String Rounded(
Column String Year
DisplayName String Sales Year
1 Diction. .. (3 itemns)
MetaName String Series
Column String Product
DisplayName String Sales Year
2 Diction... (2 items)
MetaMName String Values
0 Diction. .. (5 itemns)
MetaName String Value
Farmat String Currency
Expression String SalesAmount
ValueSequence String 1
DisplayName String Sales Amount in US Dollars

To use a plist file as metadata, a developer must parse the plist file to an intermediate metadata
NSDictionary, for example:

NSDictionary *metaDictionary = [NSMutableDictionary dictionaryWithContentsOfFile:
[[NSBundle mainBundle] pathForResource:@"example" ofType:@"plist"”]];

Next, pass the dictionary to a MAKit view controller or MAKit view, for example:
controller.metaDict = metaDictionary;

or:

chartView.metaDict = metaDictionary;

The metadata NSDictionary is not necessarily to be parsed from a plist file, the developer could create
the NSDictionary from scratch without a plist file.

Chart Metadata File

This figure shows the root as well as the two branches in the XML file. It is incompatible with any older
metafiles. The first branch, bashboard, contains the metadata related to the charts, for example, which
query to use with which chart. The second branch, bashboardLayout, contains information about where
to place charts on the device screen in relation to each other. Both sections are required structures.
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=3 MobileRnalytic

& xmlns:xsi

& xs5i:noNamespaceSchemalocation
=2 Dashboard

#--2) DashboardLayout

Dashboard

This figure shows an expanded pashboard. The variables section contains all variables used for dynamic
analytics. If the same variable is used in several value expressions, making any changes to that variable
affects all charts that use that variable. The papanel section contains a list of variables that appear
together on the device using controls appropriate to the variable type.

B = Dashboard

.......... & #comment
A3 Variables
-0 Filters

g Chart

H--I) Chart

72 DrillDownGroup
-2 DataGrid

H-- ) DRPanel

H-- ) DRPanel

-3 DashboardLayout
#--2 Landscape
B3 Portrait

E
E
E
E
E
E
E
E

For example, if you include variable Spercentdiscount in this expression:
<Value Expression="Amount*(1.0-$percentdiscount/100)” .. >

Any changes to $percentdiscount changes the Amount.

Variables
The variable section contains a name, an optional DisplayName, a variable type and, depending on the
type, an optional value.

---3 Variables
& #comment
-3 Variable
& Name
¢ DisplayNaie |
& VariableType
& Value

R e Lo e

Here is another example of variable usage (for clarity, some XML has been omitted):

<Dashboard>

<Variables

<Variable Name="$prob” VariableType="integer” Min="0" Max="100” Value="50" DisplayName="Count items
with probability over” />
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<Chart Table="pipeline" Type="Column" Title="Pipeline Summary" >
<Values><Value Expression="if(Probability&lt;$prob, Amount, ©)" ValueSequence="1">

The chart node shows the amount of sales opportunities in each stage. The chart uses a variable
($prob), which allows the user to show opportunities that have a probability larger than a threshold
only. The chart allows the user to adjust this threshold, by means of a slider control.

A variable has a collection of attributes:

Name - the identity of a variable. The variable name must start with $, be defined, and be unique
in a chart.

variableType — the value type of the variable. Variable types can be: integer, float, boolean, date,
enum. variableType is @ required attribute.

min — the minimal value of the variable; applicable to integer and date variables.
Max —the maximum value of the variable; applicable to float, integer, and date variables.

value — the default value of the variable, before the user makes any changes. Every variable
except enum must have a default value. enum has an attribute called selection, which is a list of
values that can be selected from.

Boolean variable values — these values indicate “true”: true, True, TRUE, yes, Yes, YES, 1. These
values indicate “false”: false, False, FALSE, no, No, NO, 0.

Date variable values must be specified with a date statement using the form “date(yyyy, mm,
dd)”; for example, “date(2000,12,30)".

DisplayName — a text string that describes the variable. This string appears along with the control.
Every variable must have a pisplayName.

= Variable

& Name

« isplayNane]|
& VariableType
& Selection

& Choices

=2 Choice
=2 Choice
-2 Choice
-2 Choice
<3 Cholce
=3 Cholce

The pisplay attribute contains a text string that is shown to the user, and value is the value used in the

value expression.

<Variable Name="$shown_region” Type="enum” Selection="0” DisplayName="Show data in region”>
<Choices>

<Choice Value="North America”/>
<Choice Value="APC”/>

<Choice Value=”"Europe”/>
<Choice Value=”Africa/”>
<Choice Value=”"South America”/>
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</Choices>
</Variable>
An enum variable allows the user to pick one string value from a collection of strings, which are stored in
the choices section. Each choice has value attribute and a pisplay attribute. If the pisplay attribute is
defined, it is used; otherwise, the value is used directly.

There can be an arbitrary number of variables. Each variable type has its own set of attributes as shown
below:

B D Vvar iables
- de #comment
B3 Variable

.......... e Dj_sp]_ayName
---------- & VariableType

.......... & Di splayName
---------- & VariableType

-3 Variable

& Name

& DisplayName
& VariableType
& Value

.......... & DisplayName
.......... & VariableType

.......... & Di splayName
---------- & VariableType
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Filters

Declare filters globally for the dashboard, to create subsets of data sets.

El--Z) Dashhoard

.......... & #comment
-y Variables

B J Filters
-y #Comment
=3 Filter
bl Mame

- SourceQuery
.......... ‘. FilterType

-------- ) Filter
B b Chart

Filter SourceQuery retrieves the filter choices and returns, for example, a list of years from which the end
user can select a subset. The charts are then refreshed, based on the filter. There are two FilterType
controls: range, which lets the end user specify a range of data; and picklist, which shows a list box from
which the user can select individual choices.

In each chart, Filtername tracks the filter to apply. You can apply multiple filters to a Query.

B3 Chart
.......... & HName

.......... & ChartType
.......... & Cuery
.......... & #comment
[]@ Category
[]@ Serie
[]@ Values
B-CJ Filters
El ........ @. FilterName
v il Hame

— Seguence
-------- ) FilterName

Chart

The chart node contains the description of a chart. If there is only one chart node, it is treated as if there
Was No Dashboard.
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=@ Chart
oy Name
-l Title
&% ChartType
ol QUETY
- Category
- Format
- Column
4 DisplayName
=3 Series
- Format
- COlumn
-~ DisplayName
=3 Values
;o I
-4 Format
& Expression
- # ValueSequence
-4 DisplayName
B0 Filters

The chart node contains a Name, an optional Title for the chart, and a chartType , for example, BAR. The
name is used to find the chart node from the pashBoardLayout. The name must be unique; if it is not, the
layout may affect only the first chart that uses that name; all other charts will use the default layout.

Supported chart types include: BAR, COLUMN, LINE, PIE, STACKEDCOLUMN, and BUBBLE.

Query is @ named query, for example, “RevenueByYear,” that resides in the application and is called by
MAKit to retrieve chart data. The application uses the query to retrieve data from the appropriate
datasource.

There are a number of nodes under chart.

Category

=@ Category
R - & Format

The category column contains the category; typically the x-axis in a xy-chart. The Format attribute lets you
modify the data format; for example, Format=""WeekDay’” converts the date to a weekday name in the
chart. column is the actual unique name of the column to use.

Supported Format Strings

Name Type Req Description
Month NSDate For example, “January”
ShortMonth NSDate For example, “Jan”
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WeekDay NSDate / For example, “Monday”
Numeric values
1-7
ShortWeekDay NSDate For example, “Mon”
ShortDate NSDate Depends on locale
LongDate NSDate Depends on locale
Currency Numeric Depends on locale, for example, $10.20
Percent Numeric Displays as percent, for example, 10 -> 10%
Rounded{n}(n=0,1,2,..9} Numeric Rounds number to n decimals
Series
-3 Series
& Format
& Column

& DisplayName

series specifies the z-axis. However, since the charts are two-dimensional, series are drawn next to each
other. An example is a table that shows the number of employees year for year (category) where gender
is the series, and the number of employees is the value.

Values
-3 Values
-0 e
& Format

& Expression
& ValueSequence
& DisplayName

The value expression shows the values in the chart. Values can optionally use an expression instead of a
column name, for example Expression=""Amount*1.1” Labe1="’Added 10% to price”.

Typically, a chart uses only one value expression; however, certain chart types, such as bubble charts,
may use more than one value expression. Use the values collection to group such variables. For example,
this is an XML snippet for a bubble chart that has two values; the first indicates the y-value, and the
second indicates the bubble size:

<Chart Table="pipeline" Type="Bubble" Title="Pipeline Summary" ..>

<Values>
<Value Expression="Amount" ValueSequence="1" .. />
<Value Expression="UnitPrice " ValueSequence="2" .. />
</Values>
</Chart>

The valuesequence number is important for charts that have multiple values.
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The valuesequence maps additional values to special charts that have additional requirements for input
data.

Semantic Zooming

Semantic zooming allows the chart to display data in several zooming levels, for example, by year,
quarter, and month. The user may view data at any predefined level. Chart metadata must include a

definition for each zooming level.

-3 Chart
& Name
& Title
& ChartType
=3 Category
10 Series
43 Values
=3 ZoomingLevels
=3 ZoomingLevel
& Query
& Title
& CategoryColumn
7 ZoomingLevel
73 ZoomingLevel

Each zooming level definition includes:
e query —the query name for retrieving data of this level.

e Title — optional title for this level.

® categoryColumn — category column for this level.

Unlike non-zooming charts, semantic zooming charts have different query and category columns in each
level. Therefore, the query attribute for the chart node and the column attribute for the category node

should be removed.

What-If Analysis
What-if analysis allows the user to dynamically change input data and see instant update in the chart. To
enable this feature, the user must define what-if columns in the chart.
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=3 Chart
& Name ROIDuPontAnalysis
& Title ROI DuPont Analysis
& ChartType Column
& Query duPontDataQuery
#--3 Category
-3 Values
=3 Value
& Format Rounded
& Expression ((Revenue - Costs) / Assets) * 100
& ValueSegquence 1
& Description ROT
=3 WhatIfColumns
=3 Column
& Name Costs
& VariableType float
& Value 0.0
& Description Costs
& Min 0.0
& Max 1000
- - Colmmn]
+---2) Column

The metadata of this chart is:

<Chart Name="ROIDuPontAnalysis" Title= "ROI Analysis" ChartType="Column" Query="ROIQuery" >
<Category Format="" Column="Year" DisplayName ="Year" />
<Values>
<Value Format="Rounded" Expression="((Revenue - Costs) / Assets) * 100" ValueSequence="1" DisplayName
="ROI" />

</Values>
<WhatIfColumns>
<Column Name="Costs" VariableType="float" DisplayName ="Costs" Min="0.0" Max = "1000"/>
<Column Name="Revenue" VariableType="integer" DisplayName ="Revenue" Min="0.0" Max = "1500"/>
</WhatIfColumns>
</Chart>

The Values expression is "((Revenue - Costs) / Assets) * 100", which means that the calculation involves
three columns from the input table: Revenue, Costs, and Assets. The user can select any of these
columns for what-if analysis.

For each what-if column, provide these attributes:

e  Name — the column name.

e variableType — the datatype of that column. Different datatypes are presented as different
controls in the Ul. MAKit supports float and integer types.

e DisplayName — a text description of the variable. This text is shown to the end user in the UL.
e Min—the minimum value of the data range.

e Max —the maximum value of the data range.
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DAPanel

DAPanel contains variableName nodes, which let you create a panel with sliders and other controls
(depending on the variable type). For example, you can add a slider for indicating the Min and Max
integer values. Remember, changes to the variables affect all charts that use the variable, since variables
are global for the metafile. You can use the optional title to group DA variables in logical groups. sequence
determines the order in which variables are shown in the panel.

- DAPanel
& Name
& Title
- VYariableName
& Hame Stestbool
& Sequence
i) VYariableName
& Hame Stestfloat
& variable 2

DrillDownGroup

Use prillbownGroup to create a link between charts, for example, when something like a category is
picked in the first chart, and it affects the contents of the next chart. The selected category is passed as
a parameter to the query of the next chart.

The name of the drilldown group is used for the layout, which is then applied on all charts in the group.
This rule applies to all collections (groups).

A drilldown group contains multiple chart nodes. Each chart node defines the chart of a drilldown level.

=3 DrillDownGroup
& Name
& Title
=3 Chart
& Name
& Title
& ChartType
& ChartSequence
& Query
-0
+--2) Series
=2 Values
-3 Chart
+--2 Chart

RFTable

The rich format table (RFTable) shows Chart, Data (text), and Variance in a table form. The Chart is a line
chart that shows the data trend (upward or downward), Data shows values, and Variance shows any
difference between target and actual values. Users can double-tap an RFTable, to open it in full-screen

mode.
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-2 DataGrid
-l Name RFTable
& Title Table Chart
-l QIery TableQuery
-0 Columns
B Column

— Type Data
el Talue kpi name
il Header EPI Name
- IsHeaderColumn 1
=3 Column
— Type Chart
- Value char data
- ChartName Trendline
& Header Past Trend
- ColumnSequence 1
R0 ] umn
B3 Column
&3 Column
B3 Column
&3 Column
B3 Column
&3 Column
B3 Column
&3 Column
=@ Charts
=
Trendline
Month Trend
Line

-2 Values

The metadata of this chart is:

<DataGrid Name="RFTable" Title="Table Chart" Query="TableQuery">
<Columns>
<Column Type="Data" Value="kpi_name" Header="KPI Name" IsHeaderColumn="1"/>
<Column Type="Chart" Value="char_data" ChartName="Trendline" Header="Past Trend"
ColumnSequence="1"/>
<Column Type="Data" Value="actual" Format="Currency" Header="Actual" ColumnSequence="2"/>
<Column Type="Data" Value="op" ColumnSequence="3" />
<Column Type="Data" Value="target" Format="Currency" Header="Target" ColumnSequence="4"/>
<Column Type="Variance" Value="actual-target" Color="if(actual > target, 'green', 'red')"
Format="Currency" Header="Variance Target" ColumnSequence="5"/>
<Column Type="Data" Value="col@" Header="col@" ColumnSequence="6"/>
<Column Type="Data" Value="coll" Header="coll" ColumnSequence="7"/>
<Column Type="Data" Value="col2" Header="col2" ColumnSequence="8"/>
<Column Type="Data" Value="col3" Header="col3" ColumnSequence="9"/>
<Column Type="Data" Value="col4" Header="col4" ColumnSequence="10"/>
</Columns>
<Charts>
<Chart Name="Trendline" Title="Month Trend" ChartType="Line">
<Category Column="Month" Description="Month" />
<Values>
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<Value Format="Rounded2" Expression="Amount" ValueSequence="1" Description="Trend
Value" />
</Values>
</Chart>
</Charts>
</DataGrid>

DashboardLayout

DashboardLayout determines where to place charts on the device screen. The iPad is either in landscape
mode or portrait mode, and this affects the layout of the charts, depending on how the user holds the
iPad.

B2 DashboardLayout

. .......... & sScale
H--2 Landscape
-~ & ContentWidth
- ContentHeight
=@ Layout

- &~ H_e]_g'ht

-~ & ContentWidth
- @ ContentHeight
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Landscape and Portrait Layout

- Width
- Height

\

~-# ContentWidth
-# ContentHeight

=0 Portrait

é ........ E} Layout

- Width
---------- & Height

There are two scales for the dashboard, percentage and points. The default scale is percentage, which
does not support scrolling. Specify layout dimensions in percentage form (0 — 100).

Landscape and Portrait both contain Layout nodes, which contain information about positioning Ul

& ContentWidth
-# ContentHeight

elements from the Dashboard subtree. Name indicates the Ul element (for example, Chart) to position.

Top, Left, Width, and Height are percentage values that indicate the position and size of the chart.

If you require a scrollable dashboard, specify the scale property of DashboardLayout in points, rather
than as a percentage. Also specify the Contentwidth and ContentHeight properties of Landscape and
portrait modes, and the Top, Left, Width, and Height properties of Layout. Specify all of these values

using points.
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Influence Diagram Metadata File

& =ml version="1.0" encoding="utf-g"
-0
& Name EVE-Value-Driver
& Cuery EVAQuery
=) Hode
& Mame EVA
& Text EVA
& Expression |OperatingProfitl-CostofCaptial
& Default true
& Charts chartl, chart?
& Format Eounded2
=) Node
& MName OperatingProfitl
& Textc Operating Profit
& ParentNode |EVA
& Exprezszion |BONA*Nethsazetsl
& Charts chart3, chartd
& Format Rounded2
=) HodeTo
& Name EVA
+--IJ) Hode
- Hode
+ I Hode
Diagram

The Diagram node contains the description of an influence diagram; Name is the identifier of an influence
diagram in the application. Query is a named query, for example, “EVAQuery,” that resides in the
application and is called by MAKit to retrieve influence diagram data. The application uses the Query to
retrieve data from the appropriate datasource.

Name Description Mandatory/Optional
Name Name of node M
Query Name of query that retrieves data M

Node

Node contains the description of an influence diagram metric node. The Name attribute is the identifier of
a metric node in an influence diagram. The Text attribute gives the measure text that appears on the
node. The ParentNode attribute specifies which nodes are the parent nodes of a metric node. In an
influence diagram, one node may have multiple parent nodes. The Expression attribute allows you to
specify an expression to perform goal-seeking analysis. The Format attribute lets you modify the data
format; for example, Format=""Percent’ converts the value to a percentage form.
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Supported Format Strings

Name Type Req Description
Month NSDate For example, “January”
ShortMonth NSDate For example, “Jan”
WeekDay NSDate / For example, “Monday”
Numeric values
1-7
ShortWeekDay NSDate For example, “Mon”
ShortDate NSDate Depends on locale
LongDate NSDate Depends on locale
Currency Numeric Depends on locale, for example, $10.20
Percent Numeric Displays as percent, for example, 10 -> 10%
Rounded{n}(n=0,1,2,..9} Numeric Rounds number to n decimals

The Default attribute specifies whether a node is the root node. The chart attribute allows you to
provide a list of chart names that are specified in a MAKit chart metadata file, so that you can associate
the behavior of double-tapping a node in an influence diagram with the MAKit chart that appears.

Name Description Mandatory/Optional
Name Name of node M
Text Measure text of node M
ParentNode Name of the parent node of a node 0]
Expression Expression of node 0]
Format Format of node o]
Default Whether a node is root node or not o
Charts A list of chart names associated with a | O
node
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NodeTo

NodeTo contains the description of a metric node pointing to which nodes; one node can point to
multiple nodes.

Name Description Mandatory/Optional

Name Name of the node that a node pointsto | M

The metadata of this influence diagram is:

<?xml version="1.0" encoding="utf-8"?>
<Diagram Name="EVA-Value-Driver" Query="EVAQuery">
<Node Name="EVA" Text="EVA" Expression="OperatingProfitl-CostofCaptial” Default="true"
Charts="chartl,chart2" Format="Rounded2"/>
<Node Name="OperatingProfitl" Text="Operating Profit" ParentNode="EVA" Expression="RONA*NetAssetsl"
Charts="chart3,chart4” Format="Rounded2">
<NodeTo Name="EVA"/>
</Node>
<Node Name="CostofCaptial" Text="Cost of Captial" ParentNode="EVA" Expression="NetAssetsl*WACC"
Format="Rounded2">
<NodeTo Name="EVA"/>
</Node>
<Node Name="RONA" Text="RONA" ParentNode="OperatingProfitl" Expression="ProfitMargin*NetAssetTurnover"
Format="Percentage">
<NodeTo Name="OperatingProfitl"/>
</Node>
<Node Name="NetAssetsl" Text="Net Assets" ParentNode="OperatingProfitl,CostofCaptial™
Format="Rounded2">
<NodeTo Name="OperatingProfitl"/>
<NodeTo Name="CostofCaptial"/>
</Node>
<Node Name="WACC" Text="WACC" ParentNode="CostofCaptial" Format="Percentage">
<NodeTo Name="CostofCaptial"/>
</Node>
<Node Name="ProfitMargin" Text="Profit Margin" ParentNode="RONA" Expression="OperatingProfit2/Sales1"
Format="Percentage" Charts="chartl,chart2">
<NodeTo Name="RONA"/>
</Node>

</Diagram>

Best Practices

Performance
o Improve performance by sorting data before feeding it to a chart.

e Performance may be affected by overusing expressions.

Usability

e Limit the number of series to for column charts, line charts, and horizontal bar charts to 16; no
limitation for the number of series for pie charts.

e Limit the number of categories for column charts, line charts, and horizontal bar charts to 2000.
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e Limit the number of categories for bubble charts to 300.

Troubleshooting/Tips

Data Does Not Appear in the Chart

The Application log generally includes one or more error messages indicating what has gone wrong. A
typical case is when the wrong formatter is specified for a datatype; for example, a numeric value of
2008 uses the formatter Format="ShortDate”.

Note: The MAKit debug library includes many assert statements, which may also help in troubleshooting.

Logging
MAKit includes built-in logging functionality that is, by default, off (0). However, you can turn this on by
importing the header “MALog.h”, which has a static method called setTraceLevel that accepts an integer

with the value 0 (default), 1 (trace), 2 (verbose), or 3 (performance). Setting the trace level to 2 logs all
activity that occurs in MAKit, and may be helpful when you are trying to track down issues. However, a
trace level setting of 2 somewhat degrades performance.

Note: A setting of O displays only error messages in the log.

Localization/Formatting
MAKit formatting behaves according to the region (locale) set for the device. For example, if the region

is set to Germany on the device, any currency numbers are, by default, written with the € sign. Numbers

using the format specifier “Currency” follow the pattern of the specifier. MAKit allows application
developers to create a custom formatter to override the normal formatter.

Special Characters in Metadata File

In a metafile, you must encode characters with special meaning. For example, “&” is sometimes used as

a prefix for special characters. To include an “&” sign in Title="Sybase & Son” use the appropriate

encoding (Title=“Sybase &amp; Son”); otherwise, you receive a parsing error from the XML parser
(XMLParseErrorDomain = 68). For a complete list of special characters, see:
http://www.degraeve.com/reference/specialcharacters.php.

Sample Application

You can find the full implementation of the code snippets in this document in MAKitCodeExamples,
which is a sample application included with MAKit.

Appendix: API Reference

Class List

Here are the classes, structs, unions, and interfaces with brief descriptions:
MAAnalyticChartView Class of an analytic chart view
MAAnalyticChartViewController View controller class that contains an analytic chart view
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<MAAnalyticChartViewDelegate>
<MAChartDataModel>
<MAChartLayerModel>
<MAChartTheme>
MAChartView
<MAChartViewDataSource>
<MAChartViewDelegate>
MADashboardltemView
<MADashboardTheme>
MADashboardView
<MADashboardViewDataSource>
<MADashboardViewDelegate>
MADiagramSpec
<MADiagramTheme>
MADiagramTheme_Vallina
MAError
<MAErrorHandlingDelegate>
<MAInfluenceDiagramDelegate>
MAInfluenceDiagramNode
MAInfluenceDiagramNodeTo
MAInfluenceDiagramSpec
MAInfluenceDiagramView
MAKIitTheme_WelterWeight
MAKIitTheme_WelterWeightDark
MALog
MAMailSharingController
<MAQueryDataTable>
<MAQueryDelegate>

MAView

MAViewController

<MAViewDelegate>

Class Hierarchy

Protocol of analytic chart view delegate

Protocol of chart data model

Protocol of chart layer model

Protocol of chart theme

Class of a chart view

Protocol of chart view datasource

Protocol of chart view delegate

Class of an dashboard item view

Protocol that defines the dashboard theme
Class of an dashboard view

Protocol of dashboard datasource delegate
Protocol of dashboard view delegate

Class of diagram specification

Protocol of diagram theme

Class of MAKIit influence diagram theme: Vallina
Class of error

Protocol of error handling

Protocol of influence diagram delegate

Class of influence diagram node specification
Class of influence diagram node To specification
Class of influence diagram specification

Class of Influence diagram view

Class of MAKIit theme: WelterWeight

Class of MAKIit theme: WelterWeightDark

Class for logging

View controller class for mail sharing

Protocol that retrieves data for chart rendering
Protocol of query used to retrieve chart data
View class that contains main chart functions of MAKit
View controller class that contains main chart functions of MAKit

Protocol for MAView

This inheritance list is sorted roughly, but not completely, alphabetically:

e  <MAAnalyticChartViewDelegate>
O  MAAnalyticChartViewController

e <MAChartDataModel>
O MAChartView

e  <MAChartLayerModel>
O MAChartView
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< MAChartSelection>
<MAChartTheme>
O MAKIitTheme_WelterWeight
"  MAKiIitTheme_WelterWeightDark
e  <MAChartViewDataSource>
O MAAnalyticChartView
e  <MAChartViewDelegate>
O MAAnalyticChartView
O MAView

MADashboardltemView
<MADashboardTheme>
O MAKIitTheme_WelterWeight
(] MADashboardView
(] <MADashboardViewDataSource>

O MAView
®  <MADashboardViewDelegate>
O MAView

e  MADiagramSpec
O MAlnfluenceDiagramSpec

e  <MADiagramTheme>

O MADiagramTheme_Vallina
MAETrror
<MAErrorHandlingDelegate>
<MAlInfluenceDiagramDelegate>
MAInfluenceDiagramNode
MAInfluenceDiagramNodeTo
MALog
MAMailSharingController
<MAMetricNodeViewDelegate>

O  MAlnfluenceDiagramView
<MAQueryDataTable>
<MAQueryDelegate>
MAViewController
<MAViewDelegate>

MAAnalyticChartView Class Reference

Inheritance diagram for MAAnalyticChartView:

<A ChartViewDelegate= <MaChatViewDataSources

t | |

rASnalytic Chart'yiew

List of all members.

Public Member Functions

(void)  -drillUpToLevel —drills up to the specified level in chart.

(void) - changeHierarchyLevel — changes hierarchy level in chart (zoom in/zoom out)

(void)  -toggleTable —toggles between chart itself and data table, if applicable.

91





MAKit Developer Guide: iOS 2012

(void) - shareByEmail — show email panel with the chart image.

(BOOL) - toggleWhatlfPanel — toggles what-if panel between show and hidden states, if
applicable.

(void) -reloadData — Refreshes the chart view.
(void) -reloadDataSync — Refreshes the chart view synchronously.

(void) -setNeedsDisplay — Redraws the chart view.

Properties

NSString *  metaDataPath
id< MAQueryDelegate >  dataSource
id< MAAnalyticChartViewDelegate >  delegate

id< MAChartTheme,
MADashboardTheme > Theme

id< MAErrorHandlingDelegate >  errorHandler
NSString *  identifier
MARangeSelectorBehavior ~ contentRangeSelectorBehavior
BOOL showsVerticalAxisTitle
BOOL showsHorizontalAxisTitle
BOOL showsVerticalAxis
BOOL showsHorizontalAxis
BOOL showsSelectedDatalabel
BOOL isThumbnailMode
BOOL isTitleHidden
UlEdgelnsets  chartViewEdgelnsets
NSUinteger  drillDownPathLevelCount
NSUlinteger  currentLevellnDrillDownPath
NSArray *  drillDownPathTitles
NSUInteger  categoryHierarchyCount
NSUlinteger  currentLevellnCategoryHierarchy
NSArray *  categoryHierarchyTitles
BOOL isDataGridChart

BOOL hasWhatlfScenario

Member Function Documentation

- (void) changeHierarchyLevel: (NSUlinteger) level
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Changes hierarchy level in chart (zoom in/zoom out)

Call this method to change hierarchy level, if applicable. If level is invalid, it is ignored.

Parameters:
level The number specifying the hierarchy level.
- (void) drillUpToLevel: (NSUlnteger) level

Drills up to the specified level in chart.

Call this method to drill up one level (return to the previous level) in the drilldown path, if applicable.

Parameters:
level The number specifying the level to drill up to.
- (void) reloadData: (BOOL) animated

Refreshes the chart view.

Call this method to reload data from the datasource and reconstruct the chart view, including subviews and sublayers.

Parameters:

: Flag to show chart animation.

- (void) reloadDataSync: (BOOL) animated

Refreshes the chart view synchronously.

Call this method to reload data from the datasource and reconstruct the chart view, including subviews and sublayers synchronously.

Parameters:

animated Flag to show chart animation.

- (void) setNeedsDisplay (BOOL) animated

Redraws the chart view.

Call this method to redraw the chart view.

Parameters:

animated Flag to show chart animation.
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- (BOOL) toggleWhatlfPanel

Toggles what-if panel between show and hidden states, if applicable.

No panel is shown if there is no what-if scenario defined in the metadata file.

Returns:

A Boolean value indicating the visibility of the what-if panel after the toggle is done.

- (void) shareByEmail: (UlViewCntroller*) controller

Show email panel with the chart image.

Parameters:

controller The controller that is doing e-mail sharing.

- (void) toggleTable

Toggles between the chart itself and the data table, if applicable.

Property Documentation

- (NSUInteger) categoryHierarchyCount [read , assi gn]

Count of category hierarchies (for example, semantic zooming, treemap category grouping) of the chart view in the current drilldown

level; if no semantic zooming defined, returns 1.

- (NSArray*) categoryHierarchyTitles [read, assign]

Category titles for all category hierarchy levels of the current chart view. An array of string instances.

- (UIEdgelnsets) chartviewEdgelnsets [read, write, assign]

Edge insets (padding) around chart view.

- (MARangeSelectorBehavior) contentRangeSelectorBehavior [read , write, assi gn]

A value that determines whether the analytic chart view supports content range selection. The default is

MARangeSelectorBehaviourAuto.

- (NSUlInteger) currentLevelInCategoryHierarchy [read, assign]

Current level index in the category hierarchy of the chart view. Bottom level (most detailed level) == 0.

- (NSUlInteger) currentLevelInDrillDownPath [read, assign]

Current level index in the drilldown path. Top level == 0.
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- (id<MAQueryDelegate>) dataSource [read, write, retain]

The object that acts as the datasource of the receiving analytic chart view.

- (id<MAAnalyticChartViewDelegate>) delegate [read, write, assign]

The object that acts as the delegate of the receiving analytic chart view.

- (NSUlInteger) drillDownPathLevelCount [read, assign]

Total level counts in the drilldown path, including the top-level chart. If no drilldown defined, returns 1.

- (NSArray*) drillDownPathTitles [read, assign]

Drilldown path titles of the current chart view. An array of string instances.

- (id<MAErrorHandlingDelegate>) errorHandler [read, write, retain]

The object that acts as the error handler of the receiving analytic chart view.

- (BOOL) hasWhatlfScenario [read, assign]

Returns a Boolean value that determines whether chart view uses what-if scenarios.

- (BOOL) isDataGridChart [read, assign]

Returns a Boolean value that determines whether chart is a datagrid type.

- (Nsstring®) identifier [read, write, copy]

A string serving as the identifier to the chart view if necessary.

- (BOOL) isThumbnailMode [read, write, assign]

A Boolean value that determines whether chart view is in thumbnail mode. The default is NO.

- (BOOL) isTitleHidden [read, write, assign]

A Boolean value that determines whether chart view title is hidden. The default is NO.

- (NSString*) metaDataPath [read, write, copy]

Metadata content string.
- (BOOL)showsHorizontalAxis [read, write, assign]

A Boolean value that controls whether the horizontal axis with labels and tick mark shoud be shown. The default is YES. The axis is
only shown if it's applicable for the specified chart type. A layout event is triggered after setting this property.
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- (BOOL)showsHorizontalAxisTitle [read, write, assign]

A Boolean value that controls whether the horizontal axis title shoud be shown. The default is NO. The axis title is only shown if it's
applicable for the specified chart type, and the dataSource implents the related title retrieval method. A layout event is triggered after
setting this property.

- (BOOL)showsSelectedDatalabel [read, write, assign]

A Boolean value that controls whether the the label of the selected data shoud be shown. The default is YES. The data label is only
shown if it's applicable for the specified chart type. A layout event is triggered after setting this property.

- (BOOL)showsVerticalAxis [read, write, assign]

A Boolean value that controls whether the vertical axis with labels and tick mark shoud be shown. The default is YES. The axis is
only shown if it's applicable for the specified chart type. A layout event is triggered after setting this property.

- (BOOL)showsVerticalAxisTitle [read, write, assign]

A Boolean value that controls whether the vertical axis title shoud be shown. The default is NO. The axis title is only shown if it's
applicable for the specified chart type, and the dataSource implents the related title retrieval method. A layout event is triggered after
setting this property.

- (id<MAChartTheme, MADashboardTheme>) theme [read, write, retain]

The object that provides the theme of the receiving analytic chart view

MAAnalyticChartViewController Class Reference

Inheritance diagram for MAAnalyticChartViewController:

=tAAnalyticChantViewDelegate=

b s SnalyticChatiewController

List of all members.

Public Member Functions

(id) - initWithAnalyticChartView Initializes an analytic chart view controller to manage an
analytic chart view.

(IBAction)  -reloadData Refreshes the analytic chart view.

(IBAction) - openDataTable Animates in the data table.

(IBAction) - openWhatlfPanel Animates in the what-if panel.

(IBAction) . shareByMail Captures the current chart as an image and opens a modal view to

96





MAKit Developer Guide: iOS

2012

Properties

MAAnalyticChartView *
UlToolbar *

id< MAErrorHandlingDelegate >

perform annotations and e-mail sharing.

chartView
toolbar

errorHandler

Member Function Documentation

- (id) initWithAnalyticChartView: (MAAnalyticChartView *) chartView

Initializes an analytic chart view controller to manage an analytic chart view.

Parameters:

chartView The analytic chart view that the controller is to manage.

Returns:

An initialized controller object, or nil if the object cannot be created.

Property Documentation

- (MAAnalyticChartview*) chartview [read, write, retain]

Returns the analytic chart view managed by the controller object.

- (id<MAErrorHandlingDelegate>) errorHandler [read, write, retain]

The object that acts as the error handler of the receiving analytic chart view.

- (UIToolbar*) toolbar [read, write, retain]

Returns the toolbar managed by the controller object.

<MAAnalyticChartViewDelegate> Protocol Reference

Inheritance diagram for <MAAnalyticChartViewDelegate>:

List of all members.

Public Member Functions

=tdaanalyticChantViewDelegate=

b & snalyticChatiewController

(void) - didRefreshinChartView:

Notifies the delegate that the chart view has been refreshed.

97





MAKit Developer Guide: iOS 2012

(void) - didChangeDrillDownLevellnChartView:toLevel:

Notifies the delegate that the drilldown level has been changed (drilldown/drillup) in the chart view.
(void) - didClickEmbeddedChart:miniChartController:

Notifies the delegate to show embedded chart in the MAChartViewController.
(void) - chartView:

Informs the receiver that multiple items have been selected.

Member Function Documentation
- (void) didChangeDrillDownLevellnChartView: (MAAnalyticChartView *) chartView
toLevel: (NSUlnteger) level
[optional]
Notifies the delegate that the drilldown level has been changed (drilldown/drillup) in the chart view.

Parameters:
chartView The analytic chart view object informing the delegate of this event.

level A number indicating the new drilling level.

- (void) didRefreshinChartView: (MAAnalyticChartView *) chartview [optional]

Notifies the delegate that the chart view has been refreshed.
Parameters:

chartView The analytic chart view object informing the delegate of this event.

- (void) didClickEmbeddedChart: (MAChartViewController *) miniChartController [optional]

Notifies the delegate to show embedded chart in the MAChartViewController.
Parameters:

miniChartController Contains the slected embedded chart.

- (void) chartView: (MAAnalyticChartView *) chartView

didSelectltems: (MAChartSelection *) selection

[optional]
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Informs the receiver that multiple items have been selected.
Parameters:
chartView An object representing the chart view requesting this information..

didSelectltems An object representing the selected item

<MAChartDataModel> Protocol Reference

Inheritance diagram for <MAChartDataModel>:

<hdAChanDatabdodel=

kA & Charth iew

List of all members.

Public Member Functions

(NSUinteger) - categorylLevelCount

Gets the number of category levels.

(NSUiInteger) - categoryCount

Gets the number of categories for category level O.

(NSUinteger) - categoryCountinLevel:

Gets the number of categories for a specified category level.

(id) - categoryAtindex:

Gets the category at a specified index in category level 0.

(id) - categoryAtindex:inCategoryLevel:

Gets the category at a specified index in a specified category level.

(NSString *) - categoryTitle

Gets the title of category for category level 0, which could be used for axis labelling and table headers.

(NSString *) - categoryTitleForCategoryLevel:

Gets the title of category for a specified category level, which could be used for axis labelling and table

headers.

(BOOL) -isCategorylinterpretedAsValue

Queries whether category can be interpreted as a value dimension.

(NSUinteger) - indexOfFirstSubCategoryForCategory:inCategoryLevel:

Gets the index of the first subcategory of a specified category in a specified category level.

(NSUinteger) - indexOfLastSubCategoryForCategory:inCategorylLevel:
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(NSUinteger)

(NSUinteger)

(NSUInteger)

(NSUinteger)

(id)

(NSString *)

(NSString *)

(NSFormatter *)

(NSUInteger)

(id)

(id)

(id)

(NSString *)

(NSFormatter *)

(NSString *)

(NSString *)
(float)

(float)

Gets the index of the last subcategory of a specified category in a specified category level.

- indexOfFirstLevelZeroSubCategoryForCategory:inCategoryLevel:

Gets the index of the first subcategory in category level 0 of a specified category in a specified category
level.

- indexOfLastLevelZeroSubCategoryForCategory:inCategoryLevel:

Gets the index of the last subcategory in category level 0 of a specified category in a specified category
level.

- seriesCount

Gets the total number of series for all layers.

- dataltemCountForSeries:

Gets the number of data items at a specified series.

- seriesAtindex:

Gets the series at a specified index within all chart layers.

- seriesTitle

Gets the title of series for category level 0, which could be used for axis labelling and table headers.
- seriesTitleForCategoryLevel:

Gets the title of series for a specified category level, which could be used for axis labelling and table
headers.

- seriesFormatter

Gets the formatter object for series.

- numberOfValueDimensions

Gets the number of dimensions of the values in the chart view.

- valueOfCategory:andSeries:

Gets the value of a specified category-series pair.

- valueAtDimension:ofCategory:inCategoryLevel:andSeries:

Gets the value at a specified dimension of a specified category-series pair.

- valueAtDimension:ofDataltem:andSeries:

Gets the value of the specified data item.

- formattedStringFromValueAtDimension:ofCategory:inCategoryLevel:andSeries:

Gets the formatted string of the value at a specified dimension of a specified category-series pair.
- formatterForValueAtDimension:

- valueTitleAtDimension:

Gets the title of value at the specified dimension, which could be used for axis labelling and table headers.
- valueTitleAtDimension:inCategoryLevelIndex:

- maxValueOfLayer:andValueDimension:

Gets the maximum value.

- minValueOfLayer:andValueDimension:

Gets the minimum value.
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(float)

(float)
(void)

(void)

(void)
(void)

(void)

(void)

(BOOL)

(BOOL)

(BOOL)

(BOOL)

(NSUinteger)

(NSUinteger)

(void)

(void)

(void)

(BOOL)

(NSUinteger)

(NSinteger)

- maxSumValueOfLayer:andValueDimension:

Gets the maximum sum of all the values corresponding to the same category.
- minSumValueOfLayer:andValueDimension:

- selectCategoryAtindex:

Adds the specified category to the selection pool.

- deselectCategoryAtindex:

Removes the specified category from the selection pool.
- selectSeriesAtIndex:

- deselectSeriesAtIndex:

Removes the specified series from the selection pool.

- selectDataltemAtindex:ofGlobalSeriesindex:

Adds the specified data item to the selection pool.

- deselectDataltemAtIndex:ofGlobalSeriesIndex:
Removes the specified data item from the selection pool.
- isCategorySelectedAtindex:

Queries whether a specified category is selected.

- isSeriesSelectedAtGloballndexForAllChartLayers:
Queries whether a specified series is selected.

- isDataltemSelectedAtIndex:ofGlobalSeriesIndex:
Queries whether the data is selected.

- isDataltemInFocusAtindex:ofGlobalSeriesindex:
Queries whether the data is in focus.

- numberOfSelectedCategories

Gets the number of categories in selection.

- numberOfSelectedSeries

Gets the number of series in selection.

- clearAllCategorySelections

Clears all the selections on categories.

- clearAllSeriesSelections

Clears all the selections on series.

- clearAllSelections

Clears all the selection of the chart.

- isInFocusAtCategoryIndex:ofGlobalSeriesIndex:

Queries whether the data is in focus.

- highlightCategoryIndex
Gets the index of the highlight category.

- indexOfFirstSelectedSeries

101





MAKit Developer Guide: iOS

2012

Gets the index of the first selected series.

(void) - setHighlightCategoryIndex:
Sets the index of the highlighted category.

(UIColor *) - contentColorForSeries:

Gets the content color for a series.

(UlColor *) - borderColorForSeries:

Gets the border color for a series.

(void) - setContentColor:forSeries:

Sets the content color for a series.

(void) - setBorderColor:forSeries:

Sets the border color for a series.

(UIColor *) - contentColorForCategory:andSeries:

Gets the content color for a category-series combination.

(UlColor *) - borderColorForCategory:andSeries:

Gets the border color for a category-series combination.

(void) - setContentColor:forCategory:andSeries:

Sets the content color for a category-series combination.

(void) - setBorderColor:forCategory:andSeries:

Sets the border color for a category-series combination.

(void) - resetAllColors

Resets all content and border colors back to default values.

(void) - sortValues:

Sorts the assigned series values.

Properties

NSFormatter *  categoryFormatter

Gets the formatter object for categories.

Member Function Documentation

- (UIColor *) borderColorForCategory: (NSUInteger) categorylndex

andSeries: (NSUlnteger) globalSeriesindex

Gets the border color for a category-series combination.

Parameters:
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categorylndex An index corresponding to a category.
globalSeriesindex An index corresponding to a series based on all chart layers.

Returns:

The color object.

- (UIColor *) borderColorForSeries: (NSUInteger) globalSeriesindex

Gets the border color for a series.
Parameters:
globalSeriesIndex An index corresponding to a series based on all chart layers.

Returns:

The color object.

- (id) categoryAtindex: (NSUlnteger) categorylndex [required]

Gets the category at a specified index in category level 0.
Parameters:
categorylndex An index corresponding to a category

Returns:

The category object
- (id) categoryAtindex: (NSUlnteger) categorylndex
inCategoryLevel: (NSUinteger) categorylLevellndex
[required]
Gets the category at a specified index in a specified category level.
Parameters:
categorylndex An index corresponding to a category
categoryLevellndex An index corresponding to a category level

Returns:

The category object.
- (NSUInteger) categoryCount  [required]
Gets the number of categories for category level 0.

Returns:

The category count.
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- (NSUInteger) categoryCountinLevel: (NSUlInteger) categorylLevellndex [required]

Gets the number of categories for a specified category level.

Returns:

The category count.
- (NSUInteger) categorylndexOfDataltem: (NSUlInteger) dataltemindex
andSeries: (NSUlinteger) globalSeriesindex
[required]

Gets the category index of the specified data item.

Parameters:
dataltemIndex An index corresponding to a data item within the series.
globalSeriesindex An index corresponding to a series based on all chart layers.

Returns:

The category index
- (NSUInteger) categoryLevelCount [required]
Gets the number of category levels.

Returns:

The category level count

- (NSString*) categoryTitle  [required]
Gets the title of category for category level 0, which could be used for axis labelling and table headers.

Returns:

The label.

- (NSString*) categoryTitleForCategorylLevel: (NSUInteger) categoryLevelindex [required]

Gets the title of category for a specified category level, which may be used for axis labelling and table headers.

Parameters:

categoryLevellndex An index corresponding to a category level.

Returns:

The label.

- (UIColor *) contentColorForCategory: (NSUlnteger) categorylndex

104





MAKit Developer Guide: iOS 2012

andSeries: (NSUlnteger) globalSeriesindex

Gets the content color for a category-series combination.

Parameters:

categorylndex An index corresponding to a category.

globalSeriesindex An index corresponding to a series based on all chart layers.

Returns:

The color object.

- (UIColor *) contentColorForSeries: (NSUlInteger) globalSeriesindex

Gets the content color for a series.

Parameters:

globalSeriesindex An index corresponding to a series based on all chart layers.

Returns:

The color object.

- (NSUInteger) dataltemCountForSeries: (NSUInteger) globalSeriesindex

Gets the number of data items at a specified series.

Parameters:

globalSeriesindex An index corresponding to a series based on all chart layers.

Returns:

The data item count in the series.

- (void) deselectCategoryAtindex: (NSUlInteger) categorylndex

Removes the specified category from the selection pool.
Parameters:

categorylndex An index corresponding to a category in category level 0.

- (void) deselectDataltemAtindex: (NSUlInteger) dataltemIndex

ofGlobalSeriesindex: (NSUlInteger) globalSeriesindex

Removes the specified data item from the selection pool.
Parameters:

dataltemIndex An index corresponding to a data item within the series.
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globalSeriesIndex An index corresponding to a series based on all chart layers.

- (void) deselectSeriesAtindex: (NSUInteger) globalSeriesindex

Removes the specified series from the selection pool.
Parameters:

globalSeriesIndex An index corresponding to a series based on all chart layers.

- (NSString*) formattedStringFromValueAtDimension: (NSUlInteger) valueDimensionindex
ofCategory: (NSUlinteger) categorylndex
inCategoryLevel: (NSUlInteger) categoryLevellndex

andSeries: (NSUlnteger) globalSeriesindex

Gets the formatted string of the value at a specified dimension of a specified category-series pair.
Parameters:

valueDimensionindex An index corresponding to a value dimension.

categorylndex An index corresponding to a category.

categoryLevellndex Anindex corresponding to a category level.

globalSeriesindex An index corresponding to a series. The index is based on all chart layers.

Returns:

The formatted string of the value

- (NSFormatter*) formatterForValueAtDimension: (NSUInteger) valueDimensionindex

Gets the formatter object for values at a specified dimension.
Parameters:
valueDimensionindex An index corresponding to a value dimension.

Returns:

The formatter object

- (NSUInteger) highlightCategoryIndex

Gets the index of the highlight category.

Returns:

The index of the category.
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- (NSUInteger) indexOfFirstLevelZeroSubCategoryForCategory: (NSUInteger) categorylndex

inCategoryLevel: (NSUlInteger) categorylLevellndex

Gets the index of the first subcategory in category level O of a specified category in a specified category level.
Parameters:

categorylndex An index corresponding to a category.

categorylLevellndex An index corresponding to a category level.

Returns:

The index of the first subcategory in category level 0.

- (NSInteger) indexOfFirstSelectedSeries

Gets the index of the first selected series.

Returns:

The index of the series.
- (NSUiInteger) indexOfFirstSubCategoryForCategory: (NSUlInteger) categorylndex

inCategoryLevel: (NSUlnteger) categorylLevellndex

Gets the index of the first subcategory of a specified category in a specified category level.
Parameters:
categorylndex An index corresponding to a category.
categorylLevellndex An index corresponding to a category level.

Returns:

The index of the first subcategory in the subcategory's own level.
- (NSUiInteger) indexOfLastLevelZeroSubCategoryForCategory: (NSUlInteger) categorylndex

inCategoryLevel: (NSUinteger) categoryLevellndex

Gets the index of the last subcategory in category level O of a specified category in a specified category level.
Parameters:

categorylndex An index corresponding to a category.

categoryLevellndex An index corresponding to a category level.

Returns:

The index of the last subcategory in category level 0.

- (NSUInteger) indexOfLastSubCategoryForCategory: (NSUlnteger) categorylndex
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inCategoryLevel: (NSUlinteger) categorylLevellndex

Gets the index of the last subcategory of a specified category in a specified category level.

Parameters:

categorylndex An index corresponding to a category.

categoryLevellndex An index corresponding to a category level.

Returns:

The index of the last subcategory in the subcategory's own level.

- (BOOL) isCategoryInterpretedAsValue

Queries whether category can be interpreted as a value dimension. This is the case whereby there are multiple data items
corresponding to each category-series pair.

- (BOOL) isCategorySelectedAtindex: (NSUInteger) categorylndex

Queries whether a specified category is selected.

Parameters:

categorylndex An index corresponding to a category in category level 0.

Returns:

A Boolean value indicating if the category is selected.

- (BOOL) isDataltemInFocusAtindex: (NSUInteger) dataltemIndex

ofGlobalSeriesindex: (NSUlInteger) globalSeriesindex

Queries whether the data is in focus. The data item is focused if it is selected. If there is no selection, all data points are in focus.

Parameters:

dataltemIndex An index corresponding to a data item within the series.

globalSeriesIndex An index corresponding to a series based on all chart layers.

See also:
isDataltemSelectedAtIndex
Returns:

A Boolean value indicating if the data item is in focus.

- (BOOL) isDataltemSelectedAtindex: (NSUlnteger) dataltemIndex

ofGlobalSeriesindex: (NSUlInteger) globalSeriesindex

Queries whether the data is selected.

Parameters:
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dataltemIndex An index corresponding to a data item within the series.

globalSeriesindex An index corresponding to a series based on all chart layers.

Returns:

A Boolean value indicating if the data item is selected.
- (BOOL) isInFocusAtCategoryIndex: (NSUInteger) categorylndex

ofGlobalSeriesindex: (NSUlInteger) globalSeriesindex

Queries whether the data is in focus. The data item is focused if it is selected. If there is no selection, all data points are in focus.
Parameters:

categorylndex An index corresponding to a category.

globalSeriesindex An index corresponding to a series based on all chart layers.

Returns:
A Boolean value indicating if the data is in focus.
See also:

isCategorySelectedAtindex and isSeriesSelectedAtindex.

- (BOOL) isSeriesSelectedAtGloballndexForAllChartLayers: (NSUInteger) globalSeriesindex

Queries whether a specified series is selected.
Parameters:
globalSeriesIndex An index corresponding to a series based on all chart layers.

Returns:

A Boolean value indicating if the series is selected.
- (float) maxSumValueOfLayer: (NSUlInteger) layerindex

andValueDimension: (NSUlnteger) valueDimensionIndex

Gets the maximum sum of all the values corresponding to the same category.
Parameters:
layerindex An index corresponding to a chart layer
valueDimensionindex An index corresponding to the value dimension.

Returns:

The numeric value.

- (float) maxValueOfLayer: (NSUlInteger) layerindex
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andValueDimension: (NSUInteger) valueDimensionindex

Gets the maximum value.

Parameters:

layerindex An index corresponding to a chart layer

valueDimensionindex An index corresponding to the value dimension.

Returns:

The numeric value.

- (float) minSumValueOfLayer: (NSUlnteger) layerindex

andValueDimension: (NSUlnteger) valueDimensionindex

Gets the minimum sum of all the values corresponding to the same category.
Parameters:

layerindex An index corresponding to a chart layer

valueDimensionindex An index corresponding to the value dimension.

Returns:

The numeric value.

- (float) minValueOfLayer: (NSUlnteger) layerindex

andValueDimension: (NSUlnteger) valueDimensionindex

Gets the minimum value.

Parameters:

layerIindex An index corresponding to a chart layer

valueDimensionindex An index corresponding to the value dimension.

Returns:

The numeric value.

- (NSUInteger) numberOfSelectedCategories

Gets the number of categories in selection.

Returns:

The number of categories in selection.

- (NSUInteger) numberOfSelectedSeries

Gets the number of series in selection.
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Returns:

The number of series in selection.

- (NSUInteger) numberOfValueDimensions

Gets the number of dimensions of the values in the chart view.

Returns:

The number of value dimensions

- (void) selectCategoryAtindex: (NSUlinteger) categorylndex

Adds the specified category to the selection pool.
Parameters:

categorylndex An index corresponding to a category in category level 0.

- (void) selectDataltemAtindex: (NSUinteger) dataltemIndex

ofGlobalSeriesindex: (NSUlInteger) globalSeriesindex

Adds the specified data item to the selection pool.
Parameters:

dataltemIndex An index corresponding to a data item within the series.

globalSeriesIndex An index corresponding to a series based on all chart layers.

- (void) selectSeriesAtindex: (NSUInteger) globalSeriesindex

Adds the specified series to the selection pool.

Parameters:

globalSeriesIndex An index corresponding to a series based on all chart layers.

- (id) seriesAtindex: (NSUlnteger) globalSeriesindex

Gets the series at a specified index within all chart layers.

Parameters:

globalSeriesIndex An index corresponding to a series. The index is based on all chart layers.

Returns:

The series object
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- (NSUiInteger) seriesCount

Gets the total number of series for all layers.

Returns:

The series count

- (NSFormatter*) seriesFormatter

Gets the formatter object for series.

Returns:

The formatter object.

- (NSString*) seriesTitle

Gets the title of series for category level 0, which may be used for axis labelling and table headers.

Returns:

The label.

- (NSString*) seriesTitleForCategoryLevel: (NSUInteger) categoryLevellndex

Gets the title of series for a specified category level, which may be used for axis labelling and table headers.
Parameters:
categorylLevellndex An index corresponding to a category level.

Returns:

The label.

- (void) setBorderColor: (UlColor *)  color

forCategory: (NSUlinteger) categorylndex

andSeries: (NSUlinteger) globalSeriesindex

Sets the border color for a category-series combination.
Parameters:

color The color object.

categorylndex An index corresponding to a category.

globalSeriesindex An index corresponding to a series based on all chart layers.

- (void) setBorderColor: (UlColor *) color

forSeries: (NSUlInteger) globalSeriesindex
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Sets the border color for a series.

Parameters:

color The color object.

globalSeriesIndex An index corresponding to a series based on all chart layers.

- (void) setContentColor: (UlColor *) color

forCategory: (NSUlinteger) categorylndex

andSeries: (NSUlinteger) globalSeriesindex

Sets the content color for a category-series combination.

Parameters:

color The color object.

categorylndex An index corresponding to a category.

globalSeriesIndex An index corresponding to a series based on all chart layers.

- (void) setContentColor: (UlColor *) color

forSeries: (NSUinteger) globalSeriesindex

Sets the content color for a series.

Parameters:
color The color object.
globalSeriesindex An index corresponding to a series based on all chart layers.
- (void) setHighlightCategoryIndex: (NSUInteger) categorylndex

Sets the index of the highlighted category.
Parameters:

categorylndex the index of the category.

- (id) valueAtDimension: (NSUlInteger) valueDimensionindex

ofCategory: (NSUinteger) categorylndex
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inCategoryLevel: (NSUInteger) categoryLevellndex

andSeries: (NSUlInteger) globalSeriesindex

Gets the value at a specified dimension of a specified category-series pair.

Parameters:

valueDimensionindex An index corresponding to a value dimension.

categorylndex An index corresponding to a category.

categorylLevellndex An index corresponding to a category level.

globalSeriesindex An index corresponding to a series. The index is based on all chart layers.

Returns:

The value object

- (id) valueAtDimension: (NSUlnteger) valueDimensionlndex

ofDataltem: (NSUlnteger) dataltemIndex

andSeries: (NSUlinteger) globalSeriesindex

Gets the value of the specified data item.

Parameters:

valueDimensionindex An index corresponding to the value dimension.

dataltemIndex An index corresponding to a data item within the series.

globalSeriesindex An index corresponding to a series based on all chart layers.

Returns:

The value object

- (id) valueOfCategory: (NSUlinteger) categorylndex

andSeries: (NSUlinteger) globalSeriesindex

Gets the value of a specified category-series pair.

Parameters:

categorylndex An index corresponding to a category in category level 0.

globalSeriesIndex An index corresponding to a series. The index is based on all chart layers.

Returns:

The value object
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- (NSString*) valueTitleAtDimension: (NSUlInteger) valueDimensionindex

Gets the title of value at the specified dimension, which may be used for axis labelling and table headers.
Parameters:
valueDimensionindex An index corresponding to the value dimension.

Returns:

The label.
- (NSString*) valueTitleAtDimension: (NSUlInteger) valueDimensionindex

inCategoryLevellndex: (NSUlInteger) categorylLevellndex

Gets the title of value at the specified dimension and category level index, which may be used for axis labelling and table headers.
Parameters:

valueDimensionindex An index corresponding to the value dimension.

categoryLevellndex Anindex corresponding to a category level.

Returns:

The label.

- (void)sortValues: (NSUInteger) globalSeriesindex

Sorts the assigned series values.
Parameters:

globalSeriesindex An index corresponding to a series based on all chart layers..

Property Documentation

- (NSFormatter*) categoryFormatter [read, required, assign]

Gets the formatter object for categories.

Returns:

The formatter object.
<MAChartLayerModel> Protocol Reference
#import <MAChartLayerModel .h>

Inheritance diagram for <MAChartLayerModel>:
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List of all members.

=t&Chalaye rtodel=

rAG Cha Y iew

Public Member Functions

(NSUInteger)

(NSUiInteger)

(MAChartRenderType

(NSUiInteger)

(id)

(id)

(id)

(NSUiInteger)

(NSString *)

- chartLayerCount

Gets the number of layers.

- chartTypeForChartLayer:

Gets the chart type for a chart layer at a specified index.

- chartRenderTypeForChartLayer:

Gets the chart render type for a chart layer at a specified index.

- seriesCountForChartLayer:

Gets the number of series at a specified layer.

- seriesAtIindex:forChartLayer:

Gets the series at a specified index within a specified chart layer.

- valueOfCategory:andLayerSeries:forChartLayer:

Gets the value of a specified category-series pair. The series is located in the chart layer it belongs to.

- valueAtDimension:ofCategory:inCategoryLevel:andLayerSeries:forChartLayer:

Gets the value at a specified dimension of a specified category-series pair. The series is located in the
chart layer it belongs to.

- convertToGlobalSeriesindexFromLayerSeriesIndex:forChartLayer:

Converts an index corresponding to a series in a specified layer to a global series index based on all
chart layers.

formattedStringFromValueAtDimension:ofCategory:inCategoryLevel:andLayerSeries:forChartLa
yer:

Gets the formatted string of the value at a specified dimension of a specified category-series pair. The
series is located in the chart layer it belongs to.

Detailed Description

Chart layer protocol.

Member Function Documentation

- (NSUInteger) chartLayerCount  [required]

Gets the number of layers.

Returns:
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The layer count

- (MAChartRenderType) chartRenderTypeForChartLayer: (NSUInteger) layerindex [required]

Gets the chart render type for a chart layer at a specified index.
Parameters:
layerindex An index corresponding to a chart layer

Returns:

The chart render type for the layer

- (NSUInteger) chartTypeForChartLayer: (NSUInteger) layerindex [required]

Gets the chart type for a chart layer at a specified index.
Parameters:
layerindex An index corresponding to a chart layer

Returns:

The chart type for the layer
- (NSUinteger) convertToGlobalSeriesIndexFromLayerSeriesindex: (NSUInteger) layerSeriesindex

forChartLayer: (NSUlnteger) layerindex

[required]

Converts an index corresponding to a series in a specified layer to a global series index based on all chart layers.

Parameters:
layerSeriesindex An index corresponding to a series in the chart layer it belongs to.
layerindex An index corresponding to a chart layer.

Returns:

globalSeriesindex An index corresponding to a series based on all chart layers
- (NSString*) formattedStringFromValueAtDimension: (NSUlnteger) valueDimensionindex
ofCategory: (NSUlnteger) categorylndex
inCategoryLevel: (NSUlnteger) categoryLevellndex
andLayerSeries: (NSUInteger) layerSeriesindex

forChartLayer: (NSUlInteger) layerindex

[required]
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Gets the formatted string of the value at a specified dimension of a specified category-series pair. The series is located in the chart
layer it belongs to.

Parameters:
valueDimensionindex An index corresponding to a value dimension.
categorylndex An index corresponding to a category.
categorylLevellndex An index corresponding to a category level.
layerSeriesIndex An index corresponding to a series in the chart layer it belongs to.
layerIindex An index corresponding to a chart layer.

Returns:

The formatted string of the value
- (id) seriesAtindex: (NSUlInteger) seriesindex
forChartLayer: (NSUlnteger) layerindex
[required]
Gets the series at a specified index within a specified chart layer.
Parameters:
seriesIndex An index corresponding to a series. The index is based on the chart layer the series belongs to.
layerindex An index corresponding to a chart layer.

Returns:

The series object.

- (NSUInteger) seriesCountForChartLayer: (NSUInteger) layerindex [required]

Gets the number of series at a specified layer.
Parameters:
layerindex An index corresponding to a chart layer

Returns:

The series count in the layer.
- (id) valueAtDimension: (NSUinteger) valueDimensionindex
ofCategory: (NSUlInteger) categorylndex
inCategoryLevel: (NSUinteger) categorylLevellndex

andLayerSeries: (NSUlinteger) layerSeriesindex
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forChartLayer: (NSUlInteger) layerindex
[required]

Gets the value at a specified dimension of a specified category-series pair. The series is located in the chart layer it belongs to.
Parameters:

valueDimensionindex An index corresponding to a value dimension.

categorylndex An index corresponding to a category.

categorylLevellndex An index corresponding to a category level.

layerSeriesindex An index corresponding to a series in the chart layer it belongs to.

layerindex An index corresponding to a chart layer.

Returns:

The value object.
- (id) valueOfCategory: (NSUlInteger) categorylndex
andLayerSeries: (NSUlinteger) layerSeriesindex
forChartLayer: (NSUlinteger) layerindex
[required]
Gets the value of a specified category-series pair. The series is located in the chart layer it belongs to.
Parameters:
categorylndex  An index corresponding to a category in category level 0.
layerSeriesindex An index corresponding to a series in the chart layer it belongs to.
layerIindex An index corresponding to a chart layer.

Returns:

The value object.

<MAChartTheme> Protocol Reference
Chart

Protocol of chart theme provides properties and methods to modify the look and feel of a char, like color and font.
#import <MAChartTheme.h>

Inheritance diagram for <MAChartTheme>:
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List of all members.

Public Member Functions

(id< MAChartBasePainter >)

(id< MAChartSeriesPainter >)

(UIFont *)

(UIFont *)

(UlFont *)

(UlFont *)
(UlIColor *)

(UIColor *)

(UIColor *)

(UIColor *)

(UlIColor *)

(UlIColor *)

(UIColor *)

(UIColor *)

(UIColor *)

(UlIColor *)

=MACharThemes

rMaKitTheme_Welte rdeight

rMakitTheme_Welte r¥ eightCrark

- getChartBasePainterByChartType:

To get the chart base painter based on a chart type for the current chart theme.

- getChartSeriesPainterByChartType:

To get the chart series painter based on a chart type for the current chart theme.

- getChartTitleFont

- getChartLegendFont

- getCategoryLabelFont

- getValueLabelFont

- chartBackgroundColor

To get the background color of chart.

- chartBorderColor

To get the border color of chart.

- chartTitleTextColor

To get the color of chart title text.

- chartLegendBackgroundColor

To get the background color of chart legend.
- chartLegendBorderColor

To get the border color of chart legend.

- chartLegendTextColor

To get the color of chart legend text.

- cartesianChartValueAxisColor

To get the color of value axis of a Cartesian chart.

- cartesianChartValueAxisMarkerTextColor

To get the color of value axis marker text of a Cartesian chart.

- cartesianChartValueLabelTextColor

To get the color of value axis label text of a Cartesian chart.

- cartesianChartCategoryAxisColor
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(UlIColor *)

(UIColor *)

(UIColor *)
(UIColor *)

(UIColor *)

(UIColor *)
(UIColor *)

(UIColor *)

(UIColor *)

(UlIColor *)

(UlIColor *)

(UlIColor *)

(UIColor *)

(UIColor *)

(UIColor *)

(UIFont *)

(UlIColor *)

(UIColor *)

(UIColor *)

(UlColor *)

To get the color of category axis of a Cartesian chart.

- cartesianChartCategoryAxisMarkerTextColor

To get the color of category axis marker text of a Cartesian chart.
- cartesianChartCategoryLabelTextColor

To get the color of category axis label text of a Cartesian chart.

- cartesianChartGuidelineColor

- cartesianChartEvenCategoryBackgroundColor

To get the background color of category with even index value. Return different color from
the cartesianChartOddCategoryBackgroundColor to achieve alternate background colors.

- cartesianChartOddCategoryBackgroundColor

To get the background color of category with odd index value. Return different color from
the cartesianChartEvenCategoryBackgroundColor to achieve alternate background colors.

- chartHighlightColor
- dynamicAnalyticsVariableDescriptionColor

To get the color of dynamic analytics variable description label.

- dynamicAnalyticsVariableValueColor

To get the color of dynamic analytics variable value label.

- chartDetailBackgroundColor

To get the background color of a chart detail view.
- getChartSeriesContentColorForindex:

- getChartSeriesBorderColorForindex:

- dataGridLinesColor

To get the color of datagrid lines.

- dataGridCatgeoryTextColor

To get the color of datagrid categeory text color.

- dataGridHeaderBackgroundColor

To get the color of datagrid header background color.

- dataGridBackgroundColor

To get the color of datagrid background color.

- dataGridFont
To get the font of datagrid.

- dataGridHorizontalLinelColor

To get the datagrid horizontal linel color.

- dataGridHorizontalLine2Color

To get the datagrid horizontal line2 color.

- upperThresholdColor

Color of upper threshold region.

- lowerThresholdColor
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Color of lower threshold region.

(UIColor *) - referenceValueColor

Color of reference value line.

Detailed Description

Protocol of chart theme.

Member Function Documentation

- (UIColor*) cartesianChartGuidelineColor [required]

To get the color of guidelines of a Cartesian chart.

- (UIColor*) chartHighlightColor [ required]

To get the color of highlighted area of a chart.

- (UIFont*) getCategoryLabelFont [required]

Returns:

The font for category labels.
- (id<MAChartBasePainter>) getChartBasePainterByChartType: (NSUInteger) chartType [required]
To get the chart base painter based on a chart type for the current chart theme.
Parameters:
chartType chart type

Returns:

The base painter for that chart type
- (UIFont*) getChartLegendFont  [required]

Returns:

The font for legend

- (UIColor*) getChartSeriesBorderColorForindex: (NSUInteger) seriesindex [required]

To get the border color of a chart series with index.
Parameters:
seriesindex The index of series.

Returns:
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Border color of the specified series.

- (UIColor*) getChartSeriesContentColorForindex: (NSUInteger) seriesindex [required]

To get the content color of a chart series with index.
Parameters:
seriesindex The index of series.

Returns:

content color of the specified series.

- (id<MAChartSeriesPainter>) getChartSeriesPainterByChartType: (NSUInteger) chartType [required]

To get the chart series painter based on a chart type for the current chart theme.
Parameters:
chartType Chart type.

Returns:

The series painter for that chart type.
- (UIFont*) getChartTitleFont  [required]

Returns:

The font for title.
- (UIFont*) getValueLabelFont  [required]

Returns:

The font for value labels.

MAChartView Class Reference
Chart

Class of a chart view and displays chart. Configure and modify chart type, datasource, properties, and theme using the properties
and methods provided.

#import <MAChartView.h>

Inheritance diagram for MAChartView:

=M ACharDatabModel= <haCharlayeriodel=

1 | 1

hBChartiew

List of all members.
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Public Member Functions

(void)  -refresh

Refreshes chart.

(void)  -refreshSync:

Refreshes chart in synchronous mode.

(void) - reloadData:

Reloads data model of the chart in the main thread.

(void) - reloadDataAsync:

Reloads data model of the chart in an asynchronous thread.

(void)  -redraw:

Redraws chart.

(void) - quickRedraw:

Quickly redraws chart.

(void) - selectDataltemAtindex:

Selects a data item in the receiver identified by the data item index, optionally scrolling the
row to a location in the receiver

Properties

NSString *  identifier
id< MAChartViewDataSource >  dataSource
id< MAChartViewDelegate >  delegate
id< MAChartDataModel >  dataModel
id< MAChartLayerModel >  layerModel
id< MAChartTheme >  theme
BOOL showsVerticalAxisTitle
BOOL showsHorizontalAxisTitle
BOOL showsVerticalAxis
BOOL showsHorizontalAxis
BOOL showsSelectedDatal abel
BOOL isThumbnailMode
BOOL isTitleHidden
BOOL isLegendHidden
BOOL zoomByPinchEnabled
MARangeSelectorBehavior  contentRangeSelectorBehavior
NSString *  title
NSString*  name

CGFloat textScale
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BOOL refreshing

Detailed Description
Class of a chart view.

This class represents a chart view in the UL. It is derived from UlView.

Member Function Documentation

- (void) quickRedraw: (BOOL) animated

Quickly redraws chart. Call this method to quickly redraw chart based on the current data and specifications
Parameters:

animated Flag to show chart animation.

- (void) redraw: (BOOL) animated

Redraws chart. Call this method to redraw chart with all chart specification changes (data is not reloaded).
Parameters:

animated Flag to show chart animation.

- (void) refresh

Refreshes chart.

Call this method to reload data and refresh all chart specifications in an asynchronous thread.
- (void)reloadData: (BOOL) animated

Reloads data model of the chart in the main thread.

Parameters:

animated Flag to show chart
animation.

- (void)reloadDataAsync: (BOOL) gnlmate

Reloads data model of the chart in the asynchronous thread.
Parameters:

animated Flag to show chart
animation.
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- (void) refreshSync: (BOOL) animated

Refreshes chart in synchronous mode. Call this method to reload data and refresh all chart specifications.

Parameters:
animated Fla}g _to show chart
animation.
- (void) selectDataltemAtIindex: (NSUlnteger) dataltemIndex
forChartLayer: (MAChartViewScrollPosition) scrollPosition

[required]

Selects a data item in the receiver identified by the data item index, optionally scrolling the row to a location in the receiverGets the
series.

Parameters:
dataltemIndex An index identifying a data item in the receiver.

scrollPosition A constant that identifies a relative position in the receiving chart view for the data item when scrolling
concludes.

Property Documentation

- (MARangeSelectorBehavior) contentRangeSelectorBehavior [read, write, assign]

A value that determines the content range selection behavior. Default is MARangeSelectorBehaviorAuto.

- (id<MAChartDataModel>) dataModel [read, write, retain]

The chart model of the receiving chart view.

- (id<MAChartViewDataSource>) dataSource [read, write, assign]

The object that acts as the datasource of the receiving chart view.

- (id<MAChartViewDelegate>) delegate [read, write, assign]

The object that acts as the delegate of the receiving chart view.

- (Nsstring®) identifier [read, write, copy]

A string that serves as the identifier to the chart view if necessary.

- (BOOL) isLegendHidden [read, write, assign]

A Boolean value that determines whether chart legend view is hidden. The legend is shown if it is applicable for the specified chart
type. Default is NO.
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- (BOOL) isThumbnailMode [read, write, assign]

A Boolean value that determines whether chart view is in thumbnail mode. Default is NO.

- (BOOL) isTitleHidden [read, write, assign]

A Boolean value that determines whether chart view title is hidden. Default is NO.

- (id<MAChartLayerModel>) layerModel [read, write, retain]

The chart layer model of the receiving chart view.

- (Nsstring®) name [read, write, copy]

Name of the chart.

- (BOOL) refreshing [read, write, assign]

A Boolean value that indicates whether the chart is in the midst of refreshing its data.

- (BOOL)showsHorizontalAxis [read, write, assign]

A Boolean value that controls whether the horizontal axis with labels and tick mark shoud be shown. The default is YES. The axis is
only shown if it's applicable for the specified chart type. A layout event is triggered after setting this property.

- (BOOL)showsHorizontalAxisTitle [read, write, assign]

A Boolean value that controls whether the horizontal axis title shoud be shown. The default is NO. The axis title is only shown if it's
applicable for the specified chart type, and the dataSource implents the related title retrieval method. A layout event is triggered after
setting this property.

- (BOOL)showsSelectedDatalabel [read, write, assign]

A Boolean value that controls whether the the label of the selected data shoud be shown. The default is YES. The data label is only
shown if it's applicable for the specified chart type. A layout event is triggered after setting this property.

- (BOOL)showsVerticalAxis [read, write, assign]

A Boolean value that controls whether the vertical axis with labels and tick mark shoud be shown. The default is YES. The axis is
only shown if it's applicable for the specified chart type. A layout event is triggered after setting this property.

- (BOOL)showsVerticalAxisTitle [read, write, assign]

A Boolean value that controls whether the vertical axis title shoud be shown. The default is NO. The axis title is only shown if it's
applicable for the specified chart type, and the dataSource implents the related title retrieval method. A layout event is triggered after
setting this property.

- (CGFloat) textScale [read, assign]

Gets the current scale for text rendering in the chart view.
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- (id<MAChartTheme>) theme [read, write, retain]

The object that acts as the theme of the receiving chart view.

- (Nsstring®) titte [read, write, copy]

Title of the chart.

- (BOOL) zoomByPinchEnabled [read, write, assign]

A Boolean value that determines whether zoom by pinch gesture is enabled. Default is YES.

<MAChartViewDataSource> Protocol Reference
Chart

Protocol of chart view datasource. This protocol is adopted by an object that mediates the data model for a chart view object. The
datasource provides the chart view with the information it needs to construct and modify a chart view.

#import <MAChartViewDataSource.h>

Inheritance diagram for <MAChartViewDataSource>:

<pA8 ChaiewDataSource=

rABnalytic Charthiew

List of all members.

Public Member Functions

(NSstring *) - titleForChartView:

Asks the datasource to return the title of the chart view.

(NSUinteger) - chartView:chartTypeForChartLayer:

Asks the datasource to return the chart type of the series at a specific index.

(NSUinteger) - chartView:numberOfCategoriesinLevel:

Asks the datasource to return the number of categories in the chart view.

(id)  -chartView:categoryAtindex:inCategorylLevel:

Asks the datasource to return the category at a specific index.

(NSUInteger) - numberOfSeriesInChartView:

Asks the datasource to return the number of series in the chart view.

(id) - chartView:seriesAtindex:

Asks the datasource to return the series at a specific index.

(id)  -chartView:valueAtDimension:forCategory:inCategoryLevel:andSeries:
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(NSUinteger)

(NSFormatter *)

(NSFormatter *)

(NSFormatter *)

(NSString *)

(NSString *)

(NSString *)

(NSUInteger)

(NSUlInteger)

(BOOL)

(NSUinteger)

(NSUInteger)

(NSUInteger)

(id)

(NSUiInteger)

(NSUinteger)

(NSUinteger)

Ask the datasource to return the value of the category and the series at their specific indices.

- numberOfValueDimensionsInChartView:

Asks the datasource to return the number of dimensions of values in the chart view.

- chartView:formatterForValueAtDimension:

Asks the datasource to return the formatter for value at a specific dimension in the chart view.

- categoryFormatterForChartView:

Asks the datasource to return the formatter for categories in the chart view.

- seriesFormatterForChartView:

Asks the datasource to return the formatter for series in the chart view.

- chartView:categoryTitleForCategoryLevel:

Asks the datasource to return the label for category in the chart view.

- chartView:seriesTitleForCategoryLevel:

Asks the datasource to return the label for series in the chart view.

- chartView:valueTitleAtDimension:inCategoryLevellndex:

Asks the datasource to return the title for value at a specific dimension in the chart view.

- numberOfLayersInChartView:

Asks the datasource to return the number of layers of the chart view.

- chartView:indexOfLayerForSeries:

Asks the datasource to return the index of the layer that the specific series belongs to.

- getDataByDataltemsInChartView:

Asks the datasource to whether it provides data in the form of data items.

- numberOfDataltemsInChartView:

Asks the datasource to return the number of data items in the chart view.

- chartView:indexOfCategoryForDataltem:

Asks the datasource to return the category index of a data item in the chart view.

- chartView:indexOfSeriesForDataltem:

Asks the datasource to return the series index of a data item in the chart view.

- chartView:valueAtDimension:forDataltem:

Ask the datasource to return the value of a data item at its specific index.

- numberOfCategoryLevelsinChartView:

Asks the datasource to return the number of category levels in the category hierarchy of the chart view.

- chartView:indexOfFirstSubCategoryForCategory:inCategoryLevel:

Asks the datasource to return the index of the first category that belongs to the super category in a specific
location in a super category level of the chart view.

- chartView:indexOfLastSubCategoryForCategory:inCategoryLevel:

Asks the datasource to return the index of the last category that belongs to the super category in a specific
location in a super category level of the chart view.
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(NSDictionary*) - getExtraChartProperties:chartView

Gets chart extra properties.

Detailed Description
Protocol of chart view datasource.

This protocol defines metods and properties that needs to be implemented by a chart view datasource.

Member Function Documentation

- (NSFormatter*) categoryFormatterForChartView: (MAChartView *) chartView [Opt iona |]

Asks the datasource to return the formatter for categories in the chart view. This method is optional. If it is not implemented, there
will be no formatting on the category object.

Parameters:
chartView An object representing the chart view requesting this information.

Returns:

The NSFormatter object.
- (id) chartView: (MAChartView *) chartView
categoryAtindex: (NSUlinteger) categorylndex
inCategoryLevel: (NSUlinteger) categorylLevellndex

[required]

Asks the datasource to return the category at a specific index. In chart rendering, the description of the category object is used as
the display string for that category.

Parameters:
chartView An object representing the chart view requesting this information.
categorylndex An index corresponding to a category in the chartView.

categoryLevellndex An index corresponding to a category level in the chartView.

Returns:

The category object.

- (NSString*) chartView: (MAChartView *) chartView
categoryTitleForCategoryLevel: (NSUlnteger) categorylLevellndex
[optional]

130





MAKit Developer Guide: iOS 2012

Asks the datasource to return the label for category in the chart view. This method is optional. If it is not implemented, there will be
no title.

Parameters:
chartView An object representing the chart view requesting this information.
categoryLevellndex An index corresponding to a category level.

Returns:

The label.
- (NSUiInteger) chartView: (MAChartView *) chartView
chartTypeForChartLayer: (NSUInteger) layerindex
[required]
Asks the datasource to return the chart type of the series at a specific index.
Parameters:
chartView An object representing the chart view requesting this information.
layerindex An index corresponding to a chart layer in the chartView.

Returns:

The chart type.

- (NSFormatter*) chartView: (MAChartView *) chartView
formatterForValueAtDimension: (NSUinteger) valueDimensionIndex
[optional]

Asks the datasource to return the formatter for value at a specific dimension in the chart view. This method is optional. If it is not
implemented, there will be no formatting on the value object. The string representation is that of [NSObject description].

Parameters:
chartView An object representing the chart view requesting this information.

valueDimensionindex An index corresponding to a value in the value dimension in the chartView. In normal single-
value-dimensional charts, valuelndex is usually equal to 0.

Returns:

The NSFormatter object.
- (NSUInteger) chartView: (MAChartView *) chartView

indexOfCategoryForDataltem: (NSUlnteger) dataltemIndex

[optional]
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Asks the datasource to return the category index of a data item in the chart view. In some charts, such as scatter charts, it is more
efficient to get data by data items instead of traversing through all the category and series combinations.

Parameters:
chartView An object representing the chart view requesting this information.
dataltemIndex An index corresponding to a data item in the chartView.

Returns:

The index corresponding to a category in the chartView.
- (NSUinteger) chartView: (MAChartView *) chartView
indexOfFirstSubCategoryForCategory: (NSUlInteger) categorylndex

inCategoryLevel: (NSUinteger) categorylLevellndex

[optional]

Asks the datasource to return the index of the first category that belongs to the supercategory in a specific location in a super
category level of the chart view.

In some charts, categories may be grouped in hierarchy, that is, with supercategories. For example, in a chart with 6 categories—
Jan, Feb, Mar, Apr, May, Jun—we can define supercategories Q1 and Q2 by grouping "Jan, Feb, Mar" and "Apr, May, Jun" together
respectively. In this example, the number of category level is 2. The number of categories for level at index 0 is 6. The number of
categories for level at index 1 is 2. The category at index 0 in level at index 0 is "Jan". The category at index 0 in level at index 1 is
"Q1". The index of the first subcategory for the category at index 0 in level at index 1 is 0. The index of the last subcategory for the
category at index 0 in level at index 1 is 2. The index of the first subcategory for the category at index 1 in level at index 1 is 3. The
index of the last subcategory for the category at index 1 in level at index 1 is 5.

Parameters:
chartView An object representing the chart view requesting this information.
categorylndex An index corresponding to a category.

categoryLevellndex An index corresponding to a category level.

Returns:

The index of a category in chartView.
- (NSUInteger) chartView: (MAChartView *) chartView
indexOfLastSubCategoryForCategory: (NSUInteger) categorylndex
inCategoryLevel: (NSUlnteger) categoryLevellndex

[optional]

Asks the datasource to return the index of the last category that belongs to the super category in a specific location in a
supercategory level of the chart view.

In some charts, categories may be grouped in hierarchy, that is, with supercategories. For example, in a chart with 6 categories—
Jan, Feb, Mar, Apr, May, Jun—we can define supercategories Q1 and Q2 by grouping "Jan, Feb, Mar" and "Apr, May, Jun" together
respectively. In this example, the number of category level is 2. The number of categories for level at index 0 is 6. The number of
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categories for level at index 1 is 2. The category at index 0 in level at index 0 is "Jan". The category at index 0 in level at index 1 is
"Q1". The index of the first subcategory for the category at index 0 in level at index 1 is 0. The index of the last subcategory for the
category at index 0 in level at index 1 is 2. The index of the first subcategory for the category at index 1 in level at index 1 is 3. The
index of the last subcategory for the category at index 1 in level at index 1 is 5.

Parameters:
chartView An object representing the chart view requesting this information.
categorylndex An index corresponding to a category.

categoryLevellndex An index corresponding to a category level.

Returns:

The index of a category in chartView.
- (NSUInteger) chartView: (MAChartView *) chartView
indexOfLayerForSeries: (NSUInteger) seriesIindex
[optional]

Asks the datasource to return the index of the layer that the specific series belongs to.

Parameters:
chartView An object representing the chart view requesting this information.
seriesindex An index corresponding to a series in the chartView.

Returns:

The index of the layer.
- (NSUInteger) chartView: (MAChartView *) chartView
indexOfSeriesForDataltem: (NSUInteger) dataltemIndex

[optional]

Asks the datasource to return the series index of a data item in the chart view. In some charts, such as scatter charts, it is more
efficient to get data by data items instead of traversing through all the category and series combinations.

Parameters:
chartView An object representing the chart view requesting this information.
dataltemIndex An index corresponding to a data item in the chartView.

Returns:

The index corresponding to a series in the chartView.

- (NSUInteger) chartView: (MAChartView *) chartView
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numberOfCategoriesinLevel: (NSUinteger) categorylLevellndex
[required]
Asks the datasource to return the number of categories in the chart view.
Parameters:
chartView An object representing the chart view requesting this information.
categoryLevellndex An index corresponding to a category level

Returns:

The number of categories in chartView.
- (id) chartView: (MAChartView *) chartView
seriesAtindex: (NSUinteger) seriesIindex

[required]

Asks the datasource to return the series at a specific index. In chart rendering, the description of the series object is used as the
display string for that series.

Parameters:
chartView An object representing the chart view requesting this information.
seriesIndex An index corresponding to a series in the chartView.

Returns:

The series object.

- (NSString*) chartView: (MAChartView *) chartView
seriesTitleForCategoryLevel: (NSUInteger) categoryLevellndex
[optional]

Asks the datasource to return the label for series in the chart view. This method is optional. If it is not implemented, there will be no
title.

Parameters:
chartView An object representing the chart view requesting this information.

categoryLevellndex An index corresponding to a category level.

Returns:

The label.

- (id) chartView: (MAChartView *) chartView
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valueAtDimension: (NSUInteger) valueDimensionIndex
forCategory: (NSUInteger) categorylndex
inCategoryLevel: (NSUinteger) categorylLevellndex
andSeries: (NSUlinteger) seriesindex

[required]

Ask the datasource to return the value of the category and the series at their specific indexes. Some charts may require more than
one value for each category-series pair. The valuelndex indicates the index of the value.

Parameters:
chartView An object representing the chart view requesting this information.

valueDimensionindex An index corresponding to a value in the value dimension in the chartView. In normal single-
value-dimensional charts, valuelndex is usually equal to 0.

categorylndex An index corresponding to a category in the chartView.
categoryLevellndex Anindex corresponding to a category level in the chartView.
seriesindex An index corresponding to a series in the chartView.

Returns:

The value object.
- (id) chartView: (MAChartView *) chartView
valueAtDimension: (NSUinteger) valueDimensionIndex
forDataltem: (NSUlnteger) dataltemIndex

[optional]

Ask the datasource to return the value of a data item at its specific index. Some charts may require more than one value for each
data item. The valuelndex indicates the index of the value.

Parameters:
chartView An object representing the chart view requesting this information.

valueDimensionindex An index corresponding to a value in the value dimension in the chartView. In normal single-
value-dimensional charts, valuelndex is usually equal to 0.

dataltemIndex An index corresponding to a data item in the chartView.

Returns:

The value object.

- (NSString*) chartView: (MAChartView *) chartView
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valueTitleAtDimension: (NSUInteger) valueDimensionIndex
inCategoryLevellndex: (NSUinteger) categorylLevellndex
[optional]

Asks the datasource to return the title for value at a specific dimension in the chart view. This method is optional. If it is not
implemented, there will be no title.

Parameters:
chartView An object representing the chart view requesting this information.

valueDimensionindex An index corresponding to a value in the value dimension in the chartView. In normal single-
value-dimensional charts, valuelndex is usually equal to 0.

categorylLevellndex An index corresponding to a category level.

Returns:
The label.
- (BOOL) getDataByDataltemsInChartView: (MAChartView *) chartview [optional]

Asks the datasource to whether it provides data in the form of data items.

In some charts, such as scatter charts, it is more efficient to get data by data items instead of traversing through all the category and
series combinations. In this case, an optional set of datasource APIs are provided to get data in this way. If
getDataByDataltemsInChartView: is not implemented or returns NO, the default
chartView:valueAtDimension:forCategoryAtindex:andSeries: will be used to fetch data.

Parameters:
chartView An object representing the chart view requesting this information.

Returns:

Boolean value to indicate if chart should fetch data by data items. Default is NO.

- (NSUInteger) numberOfCategoryLevelsinChartView: (MAChartView *) chartview [optional]

Asks the datasource to return the number of category levels in the category hierarchy of the chart view.

In some charts, categories may be grouped in hierarchy, that is, with supercategories. For example, in a chart with 6 categories—
Jan, Feb, Mar, Apr, May, Jun—we can define supercategories Q1 and Q2 by grouping "Jan, Feb, Mar" and "Apr, May, Jun"
together respectively. In this example, the number of category level is 2. The number of categories for level at index O is 6. The
number of categories for level at index 1 is 2. The category at index 0 in level at index 0 is "Jan". The category at index 0 in level at
index 1 is "Q1". The index of the first subcategory for the category at index O in level at index 1 is 0. The index of the last
subcategory for the category at index 0 in level at index 1 is 2. The index of the first subcategory for the category at index 1 in level
at index 1 is 3. The index of the last subcategory for the category at index 1 in level at index 1 is 5.

Parameters:
chartView An object representing the chart view requesting this information.

Returns:

The number of category levels in chartView.
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- (NSUInteger) numberOfDataltemsInChartView: (MAChartView *) chartview [optional]

Asks the datasource to return the number of data items in the chart view. In some charts, such as scatter charts, it is more efficient
to get data by data items instead of traversing through all the category and series combinations.

Parameters:
chartView An object representing the chart view requesting this information.

Returns:

The number of data items in chartView.

- (NSUInteger) numberOfLayersinChartView: (MAChartView *) chartView [Opt iona |]
Asks the datasource to return the number of layers of the chart view. Chart layers enable chart overlay.
Parameters:

chartView An object representing the chart view requesting this information.

Returns:

The number of layers in chartView.
- (NSUInteger) numberOfSeriesinChartView: (MAChartView *) chartvView [required]
Asks the datasource to return the number of series in the chart view.
Parameters:
chartView An object representing the chart view requesting this information.

Returns:

The number of series in chartView. The default value is 1.

- (NSUInteger) numberOfValueDimensionsInChartView: (MAChartView *) chartview [optional]

Asks the datasource to return the number of dimensions of values in the chart view. Some charts may require more than one value
for each category-series pair, use this method to specify the dimensions. This method is optional. If it is not implemented, a return
value of 1 is assumed.

Parameters:
chartView An object representing the chart view requesting this information.

Returns:

The number of value dimensions in chartView. Default value is 1.

- (NSFormatter*) seriesFormatterForChartView: (MAChartView *) chartview [optional]

Asks the datasource to return the formatter for series in the chart view. This method is optional. If it is not implemented, there will be
no formatting on the series object.

Parameters:
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chartView An object representing the chart view requesting this information.

Returns:

The NSFormatter object.

- (NSString*) titleForChartView: (MAChartView *) chartView [requi red]
Asks the datasource to return the title of the chart view.
Parameters:
chartView An object representing the chart view requesting this information.

Returns:

The title of the chartView.

- (NSDictionary*) getExtraChartProperties: (MAChartView *) chartView

Asks the datasource to return the category index of a data item in the chart view. Currently supports upperThreshold,
lowerThreshold, referenceValue, and predictiveStartCategory properties for line chart.

Parameters:
chartView An object representing the chart view requesting this information.

Returns:

Extra properties for the specified chart.

<MAChartViewDelegate> Protocol Reference
Chart

The protocol is adopted by an object that wishes to act as the delegate of a chart view object. The delegate is notified of events
such as selection.

#import <MAChartViewDelegate._h>

Inheritance diagram for <MAChartViewDelegate>:

<M AChatviewDelegate:

t
| |

r& & nalyticChatyiew hA S e

List of all members.

Public Member Functions

(BOOL) - willRefreshDatalnChartView:
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(void)

(void)

(void)

(void)

(void)

(void)

(void)

(void)

(void)

(void)

(void)

(BOOL)

(void)

Tells the delegate that data in the chart view is about to be refreshed.

- didRefreshDatalnChartView:

Tells the delegate that data in the chart view has been refreshed.

- chartView:didUpdateHorizontalRangeWithLowerBound:andUpperBound:

Tells the receiver when the horizontal range has been updated.

- chartView:didUpdateVerticalRangeWithLowerBound:andUpperBound:

Tells the receiver when the vertical range has been updated.

- chartView:didSelectCategory:

Tells the delegate that the specified category is now selected.

- chartView:didSelectSeries:

Tells the delegate that the specified series is now selected.

- chartView:didDeselectSeries:

Tells the delegate that the specified series is now deselected.
- chartView:didSelectDataltem:ofSeries:

Informs the receiver that the data item is selected.

- categorylLevelChanged:

Tells the delegate that treemap Level is changed.

- chartView:didDoubleTapOnCategory:

Tells the delegate that the specified category has been double-tapped.

- chartView:didDoubleTapOnSeries:

Tells the delegate that the specified series has been double-tapped.

- chartView:didDoubleTapOnCategory:andSeries:

Tells the delegate that the specified category has been double-tapped.
- chartView :willSelectltems:

Queries the receiver whether multiple items selection shuld be enabled.
- chartView:didSelectltems:

Informs the receiver that items have been selected.

Detailed Description

Protocol of chart view delegate.

This protocol defines methods and properties that needs to be implemented by a chart view delegate.

Member Function Documentation

- (void) categoryLevelChanged: (MAChartView *) chartview [optional]

Tells the delegate that the treemap level has changed.

Parameters:
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chartView An object representing the chart view requesting this information.

- (void) chartView: (MAChartView *) chartView
didDeselectSeries: (NSUlnteger) seriesIindex
[optional]
Tells the delegate that the specified series is now deselected.
Parameters:
chartView An object representing the chart view requesting this information.

seriesIndex An index corresponding to a series in chartView.

- (void) chartView: (MAChartView *) chartView
didDoubleTapOnCategory: (NSUInteger) categorylndex
[optional]
Tells the delegate that the specified category has been double-tapped.

Parameters:

chartView An object representing the chart view requesting this information.

categorylndex An index corresponding to a category in chartView.

- (void) chartView: (MAChartView *) chartView
didDoubleTapOnCategory: (NSUinteger) categorylndex
andSeries: (NSUlinteger) seriesindex
[optional]
Tells the delegate that the specified category has been double-tapped.

Parameters:

chartView An object representing the chart view requesting this information.

categorylndex An index corresponding to a category in chartView.

seriesindex  Anindex corresponding to a series in chartView.
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- (void) chartView: (MAChartView *) chartView

didDoubleTapOnSeries: (NSUInteger) seriesIindex

[optional]

Tells the delegate that the specified series has been double-tapped.

Parameters:
chartView An object representing the chart view requesting this information.
seriesindex An index corresponding to a series in chartView.

- (void) chartView: (MAChartView *) chartView
didSelectCategory: (NSUInteger) categorylndex

[optional]

Tells the delegate that the specified category is how selected.

Parameters:
chartView An object representing the chart view requesting this information.
categorylndex An index corresponding to a category in chartView.
- (void) chartView: (MAChartView *) chartView
didSelectDataltem: (NSUinteger) dataltemIndex
ofSeries: (NSUinteger) seriesindex
[optional]
Informs the receiver that the data item is selected.
Parameters:
chartView An object representing the chart view requesting this information.

dataltemIndex An index corresponding to a data item within the series.

seriesindex  Anindex corresponding to a series based on all chart layers

Returns:

YES to select. NO otherwise

- (void) chartView: (MAChartView *) chartView
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didSelectSeries: (NSUlInteger) seriesIindex

[optional]

Tells the delegate that the specified series is now selected.

Parameters:
chartView An object representing the chart view requesting this information.
seriesindex An index corresponding to a series in chartView.
- (void) chartView: (MAChartView *) chartView
didUpdateHorizontalRangeWithLowerBound: (float) lowerBound
andUpperBound: (float) upperBound
[optional]
Tells the receiver when the horizontal range has been updated.
Parameters:
chartView An object representing the chart view requesting this information.
lowerBound Lower bound of the range (0 ~ 1)
upperBound Upper bound of the range (0 ~ 1)
- (void) chartView: (MAChartView *) chartView
didUpdateVerticalRangeWithLowerBound: (float) lowerBound
andUpperBound: (float) upperBound
[optional]
Tells the receiver when the vertical range has been updated.
Parameters:
chartView

An object representing the chart view requesting this information.

lowerBound lower bound of the range (0 ~ 1)

upperBound upper bound of the range (0 ~ 1)

- (void) didRefreshDatalnChartView: (MAChartView *) chartView [Opt i onal]

Tells the delegate that data in the chart view has been refreshed.
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Parameters:

chartView An object representing the chart view requesting this information.

- (BOOL) willRefreshDatalnChartView: (MAChartView *) chartview [optional]

Tells the delegate that data in the chart view is about to be refreshed.
Parameters:

chartView An object representing the chart view requesting this information.

Returns:

Return YES if you want the data refreshed; NO if you do not.

- (BOOL) willSelectitems: (MAChartView *) chartview [optional]

Queries the receiver whether multiple items selection shuld be enabled.

Parameters:

chartView An object representing the chart view requesting this information.

Returns:

Return YES if data itmes can be selected, otherwise NO.

- (void) chartView: (MAChartView *) chartView

didSelectltmes: (MAChartSelection*) selection

[optional]

Informs the receiver that items have been selected.

Parameters:
chartView An object representing the chart view requesting this information.
selection An object representing the selected items.
- (void) chartView: (MAChartView *) chartView
(MAChartSelection*) selection
[optional]

Tells the receiver when the horizontal range has been updated.
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MADashboardItemView Class Reference

List of all members.

Public Member Functions

(void) - setSelected:animated:

Selects the dashboard item.

Properties
NSIndexPath *  indexPath
MADashboardView *  dashboard
id< MADashboardTheme >  theme
UIButton *  selectButton
UlLabel * titleLabel
UlView * contentView
BOOL selected
Member Function Documentation
- (void) setSelected: (BOOL) selected
animated: (BOOL) animated
Selects the dashboard item.

Parameters:

animated If YES, animates the transition; otherwise, does not.

Property Documentation

- (UIview®) contentview [read, write, retain]

The content view.

- (MADashboardView*) dashboard [read, write, assign]

The dashboard of which the dashboard item should be displayed within.

- (NSIndexPath*) indexPath [read, write, retain]

The index path locating the dashboard item in the dashboard.

- (UIButton*) selectButton [read, write, retain]

The select button.
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-(BOOL) selected [read, write, assign]

A Boolean value indicating the selection state.

- (id<MADashboardTheme>) theme [read, write, retain]

The object acting as the theme of the dashboard.

- (UlLabel*) titleLabel [read, write, retain]

The title label.

<MADashboardTheme> Protocol Reference

Dashboard

Protocol that defines the dashboard theme, including look and feel.

#import <MADashboardTheme.h>

Inheritance diagram for <MADashboardTheme>:

List of all members.

<hEDashhoardTheme=

bMalkitTheme_Welter¥eight

hMakitThemea_Welte r¥eightDark

Public Member Functions

(void)

(UlColor *)

(UIColor *)

(UlColor *)

(UIColor *)

(UlColor *)

- drawSkinForDashboardltemView:context:rect:

Asks the theme object to draw skin for the dashboard item view.

- dashboardBackgroundColor

Returns the background color of dashboard.

- dashboardBorderColor

Returns the border color of dashboard.

- dashboardltemTitleTextColor

Returns the border color of dashboard.

- dashboardltemBackgroundColor

Returns the background color of dashboard item.

- dashboardltemBorderColor
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Returns the border color of dashboard item.

(CGRect) - selectButtonFrameForDashboardltemView:itemBounds:

Asks the theme object for the region whereby the dashboard item view will be selected.

(CGRect) - titleLabelFrameForDashboardltemView:itemBounds:

Asks the theme object for the region whereby the title label should be drawn.

(CGRect) - contentFrameForDashboardltemView:itemBounds:

Asks the theme object for the region whereby the content view should be drawn.

Properties

NSMutableDictionary * sliderControlMinimumTrackThemes
NSMutableDictionary *  sliderControlMaximumTrackThemes
NSMutableDictionary * sliderControlThumbThemes
Detailed Description
Protocol that defines the dashboard theme.
Member Function Documentation
- (CGRect) contentFrameForDashboardltemView: (MADashboardltemView *) itemView
itemBounds: (CGRect) bounds

[optional]

Asks the theme object for the region whereby the content view should be drawn.

Parameters:
itemView An object representing the dashboard item view requesting the skin.
rect The bounds of the drawing area.
- (void) drawSkinForDashboardltemView: (MADashboardltemView *) itemView
context: (CGContextRef) context
rect: (CGRect) rect
[required]

Asks the theme object to draw skin for the dashboard item view.

Parameters:

itemView An object representing the dashboard item view requesting the skin.
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context A CGContextRef for the graphic context.
rect The bounds of the drawing area.
- (CGRect) selectButtonFrameForDashboardltemView: (MADashboardltemView *) itemView
itemBounds: (CGRect) bounds
[optional]
Asks the theme object for the region whereby the dashboard item view will be selected.
Parameters:
itemView An object representing the dashboard item view requesting the
skin.
rect The bounds of the drawing area.
- (CGRect) titleLabelFrameForDashboardltemView: (MADashboardltemView *) itemView
itemBounds: (CGRect) bounds
[optional]

Asks the theme object for the region whereby the title label should be drawn.
Parameters:
itemView An object representing the dashboard item view requesting the skin.

rect The bounds of the drawing area.

Property Documentation

- (NSMutableDictionary*) sliderControlMaximumTrackThemes [read, write, retain]

Slider control maximum track image for different states.

- (NSMutableDictionary*) sliderControlMinimumTrackThemes [read, write, optional, retain]

Slider control minimum track image for different states.

- (NSMutableDictionary*) sliderControlThumbThemes [read, write, retain]

Slider control thumb image for different states.

MADashboardView Class Reference

List of all members.
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Public Member Functions

(void)  -reloadData

Reloads data from the datasource and reconstructs the dashboard view.

(UlLabel *) - titleLabel AtiIndexPath:

Returns the title label at the specified index path.

(UlView *) - contentViewAtIndexPath:

Returns the title label at the specified index path.

(void) - selectltemAtindexPath:animated:

Selects an item in the dashboard identified by index path.

(void) - deselecltemAtindexPath:animated:

Deselects an item in the dashboard identified by index path.

Properties

id< MADashboardViewDelegate >  delegate
id< MADashboardViewDataSource >  dataSource

NSArray *  contentViews

Member Function Documentation

- (UIView*) contentViewAtindexPath: (NSIndexPath *) indexPath

Returns the title label at the specified index path.
Parameters:
indexPath The index path locating the content view.

Returns:

A view representing the content of the specified dashboard item.
- (void) deselecltemAtindexPath: (NSIndexPath *) indexPath

animated: (BOOL) animated

Deselects an item in the dashboard identified by index path.
Parameters:
indexPath The index path locating the dashboard item.

animated If YES, animates the transition; otherwise, does not.

- (void) selectltemAtindexPath: (NSIndexPath *) indexPath
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animated: (BOOL) animated

Selects an item in the dashboard identified by index path.
Parameters:
indexPath The index path locating the dashboard item.

animated If YES, animates the transition; otherwise, does not.

- (UlLabel*) titleLabel AtindexPath: (NSIndexPath *) indexPath

Returns the title label at the specified index path.
Parameters:
indexPath The index path locating the title label.

Returns:

A label displaying the title of the specified dashboard item.

Property Documentation

- (NSArray*) contentviews [read, assign]

The dashboard items

- (id<MADashboardViewDataSource>) dataSource [read, write, assign]

The object acting as the datasource of the dashboard view.

- (id<MADashboardViewDelegate>) delegate [read, write, assign]

The object acting as the delegate of the dashboard view.

<MADashboardViewDataSource> Protocol Reference
Dashboard

Protocol of dashboard datasource delegate. This protocol defines methods and properties that must be implemented by a
dashboard datasource delegate. The datasource provides the dashboard-view object with the information necessary to construct
and modify a dashboard view.

#import <MADashboardViewDataSource.h>

Inheritance diagram for <MADashboardViewDataSource>:
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<tAaDashhoardYiewDatasource=

A S W ey
List of all members.
Public Member Functions
(UlView *) - dashboardView:contentForltemAtindexPath:

Asks the datasource for an item content at a particular location of the dashboard view.

(NSinteger) - numberOfitemsIinDashboardView:

Asks the datasource to return the number of items in the dashboard view.

(NSString *) - dashboardView:titleForltemAtIndexPath:

Asks the datasource for an item title at a particular location of the dashboard view.

Member Function Documentation
- (UlView *) dashboardView: (MADashboardView *) dashboardView
contentForltemAtindexPath: (NSIndexPath *) indexPath

[required]

Asks the datasource for an item content at a particular location of the dashboard view.
Parameters:
dashboardView A dashboard-view object requesting the item content.
indexPath An index path locating an item in dashboardView.

Returns:

An object inheriting from UlView that the dashboard view can use for the specified item content. An assertion is raised if
you return nil.

- (NSString *) dashboardView: (MADashboardView *) dashboardView
titleForltemAtindexPath: (NSIndexPath *) indexPath
[optional]
Asks the datasource for an item title at a particular location of the dashboard view.
Parameters:

dashboardView A dashboard-view object requesting the item content.
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indexPath An index path locating an item in dashboardView.

Returns:

The title string

- (NSInteger) numberOfitemsinDashboardView: (MADashboardView *) dashboardView [required]

Asks the datasource to return the number of items in the dashboard view.
Parameters:
dashboardView A dashboard-view object requesting the item content.

Returns:

The number of items in dashboardView.

<MADashboardViewDelegate> Protocol Reference
Dashboard

Protocol of dashboard view delegate. This protocol defines methods and properties that must be implemented by a dashboard view
delegate. The delegate of a MADashboardView object must adopt the MADashboardViewDelegate protocol.

#import <MADashboardViewDelegate.h>

Inheritance diagram for <MADashboardViewDelegate>:

=tAaDashboardviewDelegate=

P &0 Ty

List of all members.

Public Member Functions

(id< MADashboardTheme >) - themeForDashboardView:

Asks the delegate for the theme to use for the dashboard view.

(CGSize) - dashboardView:contentSizeWithFrameSize:

Asks the delegate to return the content size of the dashboard view.

(CGRect) - dashboardView:frameForltemAtindexPath:withContentSize:

Asks the delegate for the frame for a item in a specified location.

(BOOL) - dashboardView:isTitleVisibleAtindexPath:

Asks the delegate whether the title label for an item in a specified location is visible.

(BOOL) - dashboardView:isSelectButtonEnabledAtindexPath:

Asks the delegate whether the select button for an item in a specified location is visible.

(BOOL) - dashboardView:willSelectltemAtindexPath:
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Tells the delegate that a specified item is about to be selected.

(void) - dashboardView:didSelectltemAtindexPath:

Tells the delegate that the specified item is now selected.

(BOOL) - dashboardView:willDeselectltemAtindexPath:

Tells the delegate that a specified item is about to be deselected.

(void) - dashboardView:didDeselectltemAtindexPath:
Tells the delegate that the specified item is now deselected.
Member Function Documentation
- (CGSize) dashboardView: (MADashboardView *) dashboardView
contentSizeWithFrameSize: (CGSize) frameSize

[optional]

Asks the delegate to return the content size of the dashboard view. If not implemented, frameSize is used as the default content size.
If content size is bigger than the frameSize, scrolling is implemented.

Parameters:

dashboardView A dashboard-view object.

frameSize Size of the current dashboard content area in the dashboardView.
Returns:
Size of the content.
- (void) dashboardView: (MADashboardView *) dashboardView
didDeselectltemAtindexPath: (NSIndexPath *) indexPath

[optional]
Tells the delegate that the specified item is now deselected.

Parameters:
dashboardView A dashboard-view object.

indexPath An index path that locates an item in dashboardView.

- (void) dashboardView: = (MADashboardView *) dashboardView
didSelectltemAtindexPath: (NSIndexPath *) indexPath
[optional]
Tells the delegate that the specified item is now selected.
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Parameters:

dashboardView A dashboard-view object.

indexPath An index path that locates an item in dashboardView.

- (CGRect) dashboardView: (MADashboardView *) dashboardView

frameForltemAtindexPath: (NSIndexPath *) indexPath
withContentSize: (CGSize) contentSize
[optional]

Asks the delegate for the frame for a item in a specified location.

Parameters:

dashboardView A dashboard-view object.

indexPath An index path that locates an item in dashboardView.

contentSize The dashboard content size

Returns:
A rect representing a frame for the specified item.
- (BOOL) dashboardView: (MADashboardView *) dashboardView
isSelectButtonEnabledAtindexPath: (NSIndexPath *) indexPath

[optional]

Asks the delegate whether the select button for an item in a specified location is visible.

Parameters:
dashboardView A dashboard-view object.
indexPath An index path that locates an item in dashboardView.

Returns:

A BOOL value;
- (BOOL) dashboardView: (MADashboardView *) dashboardView
isTitleVisibleAtindexPath: (NSIndexPath *) indexPath

[optional]

Asks the delegate whether the title label for an item in a specified location is visible.
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Parameters:
dashboardView A dashboard-view object.
indexPath An index path that locates an item in dashboardView.

Returns:

A BOOL value;
- (BOOL) dashboardView: (MADashboardView *) dashboardView
willDeselectltemAtindexPath: (NSIndexPath *) indexPath
[optional]
Tells the delegate that a specified item is about to be deselected.
Parameters:
dashboardView A dashboard-view object.
indexPath An index path that locates an item in dashboardView.

Returns:

A BOOL value that confirms the deselected item. Return YES if you want the item to be deselected. Return NO if you do
not want the item deselected.

- (BOOL) dashboardView: (MADashboardView *) dashboardView
willSelectltemAtindexPath: (NSIndexPath *) indexPath
[optional]
Tells the delegate that a specified item is about to be selected.
Parameters:
dashboardView A dashboard-view object.
indexPath An index path that locates an item in dashboardView.

Returns:

A BOOL value that confirms the selected item. Return YES if you want the item to be selected. Return NO if you do not
want the item selected.

- (id<MADashboardTheme>) themeForDashboardView: (MADashboardView *) dashboardview [required]

Asks the delegate for the theme to use for the dashboard view.
Parameters:
dashboardView A dashboard-view object.

Returns:
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An object implementing MADashboardTheme that the dashboard view can use for the specified theme.

MADiagramSpec Class Reference
Inheritance diagram for MADiagramSpec:

kaDiagramSpec

hMalnfluenceDiagramspec

List of all members.

Properties

NSString*  Name

MADiagramType  diagramType
MADiagramDrawType  drawType
MADiagramLineType  lineType
uint  diameter
uint  lineWidth

NSString *  query

Property Documentation

- (MADiagramType) diagramType [read , write, assi gn]

Type of diagram.

- (uint) diameter [read, write, assign]

Diameter of node in diagram.

- (MADiagramDrawType) drawType [read , write, assi gn]

Draw type of diagram.

- (MADiagramLineType) lineType [read , write, assi gn]

Line type of diagram.

- (uint) linewidth [read, write, assign]

Width of line in diagram.

- (Nsstring®) name [read, write, copy]
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Name of diagram.

- (Nsstring®) query [read, write, copy]

Name of query.

<MADiagramTheme> Protocol Reference

Inheritance diagram for <MADiagramTheme>:

List of all members.

Public Member Functions

(Ulimage *)
(Ulimage *)
(Ulimage *)
(Ullmage *)
(Ulimage *)
(Ullmage *)
(Ullmage *)
(Ulimage *)
(Ullmage *)
(Ulimage *)
(Ullmage *)
(Ullmage *)
(Ulimage *)
(Ulimage *)
(Ulimage *)
(Ulimage *)
(Ulimage *)
(Ulimage *)
(UIColor *)
(UIColor *)
(UIColor *)

(UIFont *)
(UIColor *)

(UIFont *)

- alertlcon

- largeNodelLayer0

- largeNodelLayerl

- largeNodelLayer2

- largeNodelLabellmage

- largeNodeLabelLeftimage
- largeNodeLabelRightimage
- largeAxisimage

- largeScroller

- smallNodeLayer0

- smallNodeLayer1

- smallNodeLayer2

- smallNodeLabellmage

- smallNodeLabelLeftimage
- smallNodelLabelRightimage
- smallAxislmage

- miniNodeLayer0

- miniAxislmage

- linkColor

- backgroundColor

- labelTextColor

- labelTextFont

- valueTextColor

- valueTextFont

<tAaDIagramTheme:

tMaDiagramTheme_Wallina
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(UlColor *) - pieFillingColor

Member Function Documentation

- (Ulimage*) alerticon  [required]

Image of alert icon.

- (UIColor*) backgroundColor  [required]

Color of background.

- (UIColor*) labelTextColor  [required]

Color of label text.

- (UIFont*) labelTextFont  [required]

Font of label text.

- (Ullmage*) largeAxisimage [requi red]

Image of large axis.

- (Ullmage*) largeNodeL abellmage [requi red]

Image of label of large node.

- (Ullmage*) largeNodeL abelLeftimage [requi red]

Image of left label of large node.

- (Ullmage*) largeNodelL abelRightimage [requi red]

Image of right label of large node.

- (Ullmage*) largeNodelL ayerO [requi red]

Image of large node layer0.

- (Ullmage*) largeNodelL ayer1 [requi red]

Image of large node layer1.

- (Ullmage*) largeNodelL ayer2 [requi red]

Image of large node layer2.

- (Ullmage*) largeScroller [requi red]
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Image of large scroller.

- (UIColor*) linkColor  [required]

Color of link.

- (Ullmage*) miniAxisimage [requi red]

Image of mini axis.

- (Ullmage*) miniNodeLayer0 [requi red]

Image of mini node layer0.

- (UIColor*) pieFillingColor [requi red]

Color of filling pie.

- (Ullmage*) smallAxisimage [requi red]

Image of small axis.

- (Ullmage*) smallNodeLabellmage [required]

Image of label of small node.

- (Ullmage*) smallNodeLabelLeftimage [required]

Image of left label of small node.

- (Ullmage*) smallNodeLabelRightimage [required]

Image of right label of small node.

- (Ullmage*) smallNodeLayer0 [ required]

Image of small node layerO.

- (Ullmage*) smallNodeLayerl [required]

Image of small node layerl.

- (Ullmage*) smallNodeLayer2 [required]

Image of small node layer2.

- (UIColor*) valueTextColor [required]

Color of value text.
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- (UIFont*) valueTextFont  [required]
Font of value text.
MADiagramTheme_Vallina Class Reference
Class of MAKit default prebuilt influence diagram theme: Vallina.
#import <MADiagramTheme_Vallina.h>

Inheritance diagram for MADiagramTheme_Vallina:

=tAaDiagramTheme:=

raDiag ramTheme_Wallina

List of all members.

Detailed Description
Class of MAK:it influence diagram theme: Vallina.

This class contains Vallina theme. It is the stock influence diagram theme provided by MAKit.

MAError Class Reference

List of all members.

Static Public Member Functions

(MAError *)  + errroWithCode:andLevel:andDetails:

Properties

MAErrorCode errorCode
MAErrorLevel errorLevel

NSDictionary *  errorDetails

Member Function Documentation

+ (MAError*) errrowWithCode: (uint) code
andLevel: (uint) level

andDetails: (NSDictionary *) details
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Create an MAETrror object

Property Documentation

- (MAErrorCode) errorCode [read, write, assign]

The error code.

- (NSDictionary*) errorDetails [read, write, retain]

Detailed error information. Details can be accessed with predefined keys.

- (MAErrorLevel) errorLevel [read, write, assign]

The error level.

<MAErrorHandlingDelegate> Protocol Reference

List of all members.

Public Member Functions

(void) - handleError:

The MAKIt Error Handler delegate. MAKit will call the delegate when runtime error is detected.

Member Function Documentation

- (void) handleError: (MAError *) error

The MAKIt Error Handler delegate. MAKIit calls the delegate when runtime error is detected.
Parameters:

error The error object that contains error information.

<MAlInfluenceDiagramDelegate> Protocol Reference

Protocol of influence diagram delegate, this protocol defines methods that need to be implemented by an influence diagram view
delegate.

#import <MAlnfluenceDiagramDelegate.h>

List of all members.

Public Member Functions

(void) - didChangeValueOnMetricNode:actualValues:

A event is triggered when the values of nodes are changed during goal-seeking analysis.

(void) - didChangeValueOnMetricNodeDragEnd:actualValues:
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A event is triggered when the values of nodes are changed after goal-seeking analysis.

(void) - didPanOninfluenceDiagram:metricNodes:

A event is triggered when the influence diagram is panned around.

(void) - didSelectOnMetricNode:aMetricNode:

A event is triggered when a new node is selected.

(void) - didDoubleTapOnMetricNode:aMetricNode:associatedCharts:

A event is triggered when a node with associated charts is double-tapped.

(void) - didTapOnlinfluenceDiagramInSnapshotMode:

A event is triggered when tapping the influence diagram in snapshot mode.

(void) - didSingleTapOnMetricNode:aMetricNode:

A event is triggered when a node is single-tapped.

Detailed Description
Protocol of influence diagram delegate.
This protocol defines methods that need to be implemented by a influence diagram delegate.
Member Function Documentation
- (void) didChangeValueOnMetricNode: (MAInfluenceDiagramView *) influenceDiagram
actualValues: (NSDictionary *) values
[optional]
A event is triggered when the values of nodes are changed during goal-seeking analysis.
Parameters:
influenceDiagram The instance of influence diagram.

actualValues A dictionary with node name as key and changed actual value as value.

= (void) 3 | q
\geValueOnMetricNodeDragEnd: (MAInfluenceDiagramView *) influenceDiagram

actualValues: (NSDictionary *) values
[optional]
A event is triggered when the values of nodes are changed after goal-seeking analysis.
Parameters:

influenceDiagram The instance of influence diagram.
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actualValues A dictionary with node name as key and changed actual value as value.

- (void) didDoubleTapOnMetricNode: (MAInfluenceDiagramView *) influenceDiagram

aMetricNode: (NSString *) node
associatedCharts: (NSArray *) charts
[optional]

A eventis triggered when a node with associated charts is double-tapped.

Parameters:

influenceDiagram The instance of influence diagram

aMetricNode The name of the node double-tapped

associatedCharts A list of chart names associated with the node double-tapped

- (void) didPanOnlinfluenceDiagram: (MAInfluenceDiagramView *) influenceDiagram

metricNodes: (NSArray *) nodes

[optional]
A event is triggered when the influence diagram is panned around.

Parameters:

influenceDiagram The instance of influence diagram.

metricNodes A list of node names that are visible in the view after panning.

- (void) didSelectOnMetricNode: (MAInfluenceDiagramView *) influenceDiagram
aMetricNode: (NSString *) node
[optional]

A event is triggered when a new node is selected.

Parameters:
influenceDiagram The instance of influence diagram
aMetricNode The name of new selected node

- (void) didSingleTapOnMetricNode: (MAInfluenceDiagramView *) influenceDiagram

aMetricNode: (NSString *) node
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A event is triggered when a node is single-tapped.
Parameters:

influenceDiagram

aMetricNode

- (void) didTapOnInfluenceDiagramInSnapshotMode:

[optional]

The instance of influence
diagram

The name of the node
single-tapped

(MAInfluenceDiagramView *) influenceDiagram [optional]

A event is triggered when tapping the influence diagram in snapshot mode.

Parameters:

influenceDiagram The instance of influence diagram.

MAlInfluenceDiagramNode Class Reference

List of all members.

Properties

NSString*  name
NSString *  parentNode
NSString *  text
NSString *  expression
NSString *  format
BOOL root
NSString *  charts

NSMutableArray *  nodeTos

Property Documentation

- (NSstring®) charts [read, write, copy]

A list of chart names associated with node.

- (NSstring®) expression [read, write, copy]

Goal-seeking analysis expression of node.

- (NSstring®) format [read, write, copy]

Display format of node.
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- (Nsstring®) name [read, write, copy]

Name of node.

- (NSMutableArray*) nodeTos [read, write, retain]

An array of nodes that node points to.

- (NSString®) parentNode [read, write, copy]

Parent node of node.

-(BooL)root [read, write, assign]

Whether node is root node.

- (Nsstring®) text [read, write, copy]

Display text of node.

MAInfluenceDiagramNodeTo Class Reference

List of all members.

Properties

NSString*  name

Property Documentation

- (Nsstring®) name [read, write, copy]

Name of node.

MAInfluenceDiagramSpec Class Reference

Inheritance diagram for MAInfluenceDiagramSpec:

List of all members.

Properties

NSMutableArray *

nodes

kA ADIagramspec

raInfluenceDiagramsSpec
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Property Documentation

- (NSMutableArray*) nodes [read, write, retain]

An array of nodes in diagram.

MAInfluenceDiagramView Class Reference
Influence diagram view class. Configure and modify datasource, metadata, and theme using the properties and methods provided.
#import <MAInfluenceDiagramView.h>

Inheritance diagram for MAInfluenceDiagramView:

<tametricHode ViewDelegate

ralnfluenceDiag ramiyiew

List of all members.

Public Member Functions
(id) - initWithFrame:metaDataFile:viewMode:
A constructor of influence diagram with frame, metadata file path and view mode.

(id)  -initwithFrame:viewMode:

A constructor of influence diagram with frame and view mode.
(id)  -initwithFrame:

A constructor of influence diagram with frame.

(void)  -reloadData

Refreshes the diagram

(void) - setAlertForNodes:

Set number of alerts for nodes.

(void) - setSelectedNode:

Set new selected node.

(void) - resetActualValues

Reset all actual values to original after goal-seeking analysis.

(void) - setNeedsDisplay:

Redraws the diagram view..

Properties
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NSString *  metaDataPath
MAInfluenceDiagramMode  viewMode
MADiagramSpec * metaDataSpec
id< MAInfluenceDiagramDelegate >  delegate
id< MAQueryDelegate >  dataSource
id< MADiagramTheme >  theme
NSMutableDictionary*  metaDict

Detailed Description

Influence diagram view class.

Member Function Documentation

- (id) initWithFrame: (CGRect) frame

A constructor of influence diagram with frame.
Parameters:

frame The frame of influence diagram.

- (id) initWithFrame: (CGRect) frame
metaDataFile: (NSString *) filePath

viewMode: (MAInfluenceDiagramMode) mode

A constructor of influence diagram with frame, metadata file path, and view mode.

Parameters:
frame The frame of Influence Diagram
metaDataFile The metadata file path of influence diagram
viewMode The view mode of influence diagram

- (id) initWithFrame: (CGRect) frame

viewMode: (MAInfluenceDiagramMode) mode

A constructor of influence diagram with frame and view mode.

Parameters:
frame The frame of influence diagram.
viewMode The view mode of influence diagram.
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- (void) setAlertForNodes: (NSDictionary *)

Parameters:

alertNodes Set number of alerts for nodes.

Parameters:
alertforNodes A dictionary with node name as key and number of alerts as value
- (void) setSelectedNode:  (NSString *) node

Set new selected node.
Parameters:

node Name of the selected node

- (void) setNeedsDisplay (BOOL) animated

Redraws the chart view.
Call this method to redraw the chart view.
Parameters:

animated Flag to show chart animation.

Property Documentation

- (id<MAQueryDelegate>) dataSource [read, write, retain]

Datasource of diagram.

- (id<MAlInfluenceDiagramDelegate>) delegate [read, write, assign]

Delegate of diagram.

- (NSString*) metaDataPath [read, write, copy]

Metadata file path of diagram.
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- (MADiagramSpec*) metaDataSpec [read, write, retain]

Metadata spec of diagram.

- (id<MADiagramTheme>) theme [read, write, retain]

Theme of diagram.

- (MAInfluenceDiagramMode) viewMode [read, write, assign]

View mode of diagram.

MAKitTheme_WelterWeight Class Reference

Class of MAKit theme: WelterWeight is the name of the theme. The applies to elements dashboard, and charts elements.
#import <MAKitTheme_WelterWeight.h>

Inheritance diagram for MAKitTheme_WelterWeight:

<A CharTheme= <M aDashhoardTheme=

t | |
FMaKitTheme_Welte rdeight

rMakitTheme_Welte r¥ eightCrark

List of all members.

Detailed Description

Class of MAKIit theme: WelterWeight. This class contains WelterWeight theme. It is one of the stock chart themes provided by MAKit.

MAKitTheme_WelterWeightDark Class Reference

Inheritance diagram for MAKitTheme_WelterWeightDark:

<m& ChartTheme= =haDashhoardTheme:=

t | |
tMakitTheme_Welter®eight

rMakitTheme_Welte rdeightDark

List of all members.
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MALog Class Reference

Helps to log and trace the errors during the execution of the application. Can be configured to log the error information at different
detail levels

#import <MALog.h>

List of all members.

Static Public Member Functions

(void)  + performanceTrace:
(void)  +trace:
(void)  +verbose:
(void)  +forceTrace:
(void)  +error:
(void)  +warning:
(int)  +setTraceLevel:
(int)  +getTracelLevel

Detailed Description

Class for logging.

Member Function Documentation
+ (void) error: (NSString *) Format

: NS_REQUIRES_NIL_TERMINATION

Logged messages are prefixed with ###.

Note : You must end the argument list with nil, for example, [MALog error:"somestring", nil ].

+ (void) forceTrace: (NSString *) format

: NS_REQUIRES_NIL_TERMINATION

Use trace to log mandatory items without prefixed error ### label.

Note : You must end the argument list with nil e.g. [MALog trace:"somestring", nil ]

+ (int) getTracelLevel

This function gets the trace level.

+ (void) performanceTrace: (NSString *) format
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] NS_REQUIRES_NIL_TERMINATION

Use trace to log performance data.

Note : You must end the argument list with nil, for example, [MALog trace:"somestring", nil ]

+ (int) setTraceLevel: (int) newTracelLevel

This function sets the trace level, currently only 0 and 1 are supported where 1 == trace on.

+ (void) trace: (NSString *) format

, NS_REQUIRES_NIL_TERMINATION

Use trace to log items optionally.

Note : You must end the argument list with nil, for example, [MALog trace:"somestring", nil ].

+ (void) verbose: (NSString *) format

: NS_REQUIRES_NIL_TERMINATION

Use trace when you want log things if trace level is ==2.

Note: You must end the argument list with nil, for example, [MALog trace:"somestring", nil ].

+ (void) warning: (NSString *) format

: NS_REQUIRES_NIL_TERMINATION

Logged messages will be prefixed with ===.

Note: You must end the argument list with nil, for example, [MALog warning:"somestring", nil ].

MAMailSharingController Class Reference

List of all members.

Public Member Functions

(void) - pushSharingControllerWithViewController:andDelegate:forView:

Pushes a sharing controller onto the receiver’s stack and updates the display.

Properties

NSString *  subject

Member Function Documentation

- (void) pushSharingControllerWithViewController: (UIViewController *) controller
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andDelegate: (id< MFMailComposeViewControllerDelegate >) mailDelegate

forView: (UlView *) view

Pushes a sharing controller onto the receiver’s stack and updates the display.
Parameters:

controller The current view controller

mailDelegate The object that acts as the mail delegate

view The view of which its image should be used as mail attachment

Property Documentation

- (NSString®) subject [read, write, copy]

The string used as the subject of the mail.

<MAQueryDataTable> Protocol Reference

The protocol is adopted by an object that retrieves data for chart rendering. The data retrieved is organized in a tabular format. The
column parameters used for data retrieval correspond to that defined in the metadata file.

#import <MAQueryDataTable.h>

List of all members.

Public Member Functions
(int) - getColumnCount
Get column number in the data table.
(int) - getRows
Get row number in the data table.

(id) - getData:atindex:

get data by column name and row index

Properties
BOOL  sorted
NSNumber*  upperThreshold
NSNumber*  lowerThreshold
NSNumber*  referenceValue
id predictiveStartCategory
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Detailed Description

Protocol that retrieves data for chart rendering.

Member Function Documentation

- (int) getColumnCount [requ i red]

Gets column number in the data table.

Returns:

column count
- (id) getData: (NSString *) colName
atindex: (int) rowIndex
[required]
Gets data by column name and row index.
Parameters:
colName requested column name
rowlndex row index in the data table

Returns

Data of assigned column. If the column or rowIndex does not exist, nil is returned.
- (int) getRows [required]
Gets row number in the data table.

Returns:

row count
Property Documentation

-(BooL)sorted [read, write, optional, assign]

Whether data in this table is already sorted for the chart.

- (NSNumber*) upperThreshold [read, write, optional, assign]

The upper threshold.

- (NSNumber*) lowerThreshold [read, write, optional, assign

The lower threshold.
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- (NSNumber*) referencevalue [read, write, optional, assign]

The reference value.

- (id) predictiveStartCategory [read, write, optional, assign
Category from which predictive data starts.
<MAQueryDelegate> Protocol Reference
Protocol of query used to retrieve chart data. If implemented, the MAK:it library calls to query the data.
#import <MAQueryDelegate.h>

List of all members.

Public Member Functions

(id< MAQueryDataTable >) - executeQuery:withArgument:
Executes the query and returns the query result.
Detailed Description
Protocol of query used to retrieve chart data.
Member Function Documentation
- (id<MAQueryDataTable>) executeQuery: (NSString *) gueryName

withArgument: (NSDictionary *) args

Executes the query and returns the query result.
Parameters:

queryName Query to be asked.

args Arguments for the query.

Returns:

id<MAQueryDataTable> object. If queryName is not defined, nil is returned.
MAView Class Reference

View class that contains main functions of MAKit. MAViewClass configures the datasource, dashboard, charts, and analytic features
for display purposes.

#import <MAView.h>

Inheritance diagram for MAView:
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<taDashboardViewDelegate=

<tdaDashhoardYiewDatasource=

=tAaChatviewDelegate=

t

f

List of all members.

Public Member Functions

(void)

Properties

NSString *

id< MAChartTheme,
MADashboardTheme >

id< MAQueryDelegate >
UlViewController *

id< MAErrorHandlingDelegate >
id< MAViewDelegate >

NSMutableDictionary*

Detailed Description

View class that contains main functions of MAKit. MAView accepts MAKit metadata configurations and renders a dashboard or a

Pl Ty

- refresh

Refreshes the content.

metaDataPath

theme
dataSource
controller
errorHandler
delegate

metaData

single chart with analytic features based on the configurations.

Code Example

MAView *view = [[MAViewController alloc] initWithFrame:CGRectMake(©, ©, 500, 500)];
view.metaDataPath = [[NSBundle mainBundle] pathForResource:@"MAMeta" ofType:@"xml"];

view.theme = [[[MAKitTheme_Welt

[view refresh];

Property Documentation

erWeight alloc] init] autorelease];

- (UIviewController*) controller [read, write, assign]

View controller.

- (id<MAQueryDelegate>) dataSour

Datasource object.

- (id<MAViewDelegate>) delegate

ce [read, write, retain]

[read, write, assign]

The object that acts as the delegate of the receiving dashboard view. The delegate is not retained.
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- (id<MAErrorHandlingDelegate>) errorHandler [read, write, retain]

The error handler delegate.

- (NSString*) metaDataPath [read, write, retain]

Metadata file path.

- (id<MAChartTheme, MADashboardTheme>) theme [read, write, retain]

Theme of charts and dashboard in the view.

- (NSMutableDictionary*)metaData [read, write, retain]

A dictionary of meta data definition.

MAViewController Class Reference

View controller class that contains main functions of MAKit MAViewController takes data from the datasource and configures charts
according to the metadata It provides a fundamental view-management model for MAKit applications.

#import <MAViewController_h>

List of all members.

Public Member Functions

(void)  -refresh

Refreshes the content.

Properties

NSString *  metaDataPath

id< MAChartTheme,
MADashboardTheme > theme

id< MAQueryDelegate >  dataSource
id< MAErrorHandlingDelegate >  errorHandler
id< MAViewDelegate >  delegate

NSMutableDictionary*  metaData

Detailed Description

View controller class that contains main functions of MAKit. MAViewController accepts MAKit metadata configurations and renders a
dashboard or a single chart with analytic features based on the configurations.
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Code Example

MAViewController *viewController = [[MAViewController alloc] init];
viewController.metaDataPath = [[NSBundle mainBundle] pathForResource:@"MAMeta" ofType:@"xml"];
viewController.theme = [[[MAKitTheme_WelterWeight alloc] init] autorelease];

Property Documentation

- (id<MAQueryDelegate>) dataSource [read, write, retain]

Datasource object.

- (id<MAViewDelegate>) delegate [read, write, assign]

The object that acts as the delegate of the receiving dashboard view.

- (id<MAErrorHandlingDelegate>) errorHandler [read, write, retain]

The error handler delegate.

- (NSString*) metaDataPath [read, write, retain]

Metadata file path.

- (id<MAChartTheme, MADashboardTheme>) theme [read, write, retain]

Theme of charts and dashboard in the view controller.

- (NSMutableDictionary*)metaData [read, write, retain]

A dictionary of meta data definition.

<MAViewDelegate> Protocol Reference

List of all members.

Public Member Functions

(BOOL) - willRefreshDatalnView:

Tells the delegate that data in the dashboard view is about to be refreshed.

(void) - didRefreshDatalnView:

Tells the delegate that data in the dashboard view has been refreshed.

Member Function Documentation

- (void) didRefreshDatalnView: (MAView *) view [requi red]

Tells the delegate that data in the dashboard view has been refreshed.
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Parameters:

view An object representing the dashboard view requesting this information.

- (BOOL) willRefreshDatalnView: (MAView *) view [required]

Tells the delegate that data in the dashboard view is about to be refreshed. This event is invoked whenever the refresh button of
MAView is being pressed. The event is not invoked when MAView is first loaded or when the data refresh is due to drilldown or
filtering.

Parameters:
view An object representing the dashboard view requesting this information.

Returns:

Return YES if the data should be refreshed.

MAChartSelection Class Reference
This class represents items selected in a chart.
#import <MAChartSelection.h>

List of all members.

Properties

(NSArray*)  selectedCategorylndexes

(NSArray*)  selectedDataltemindexes
Detailed Description
This class represents items selected in a chart.

Property Documentation

- (NSArray*) selectedCategoryindexes [read, write, retain]

Indexes of selected categories.

- (NSArray*) selectedDataitemsindexes [read, write, retain]

Indexes of selected data items.
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